TOPSPIN

Installation Guide

for Red Hat

Enterprise Linux WS 3
Bruker software support is available via phone, fax, e-mail, Internet, or ISDN. Please contact your local office, or directly:

Address: Bruker BioSpin GmbH
Service & Support Department
Silberstreifen
76287 Rheinstetten
Germany
Phone: +49 (721) 5161 455
Fax: +49 (721) 5161 943
E-mail: nmr-software-support@bruker-biospin.de
FTP: ftp.bruker.de / ftp.bruker.com
WWW: www.bruker-biospin.de / www.bruker-biospin.com
ISDN: on request
Contents

Chapter 1  Introduction  .................................................. 9
1.1  About this manual  ................................................. 9
1.2  Conventions  .......................................................... 10
1.3  Hardware and software requirements for TopSpin  ......................... 11
   1.3.1  Operating system requirements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
   1.3.2  Special PC Hardware requirements  .................................. 11
   1.3.3  Spectrometer requirements  .......................................... 12
      1.3.3.1  Avance systems with AQS rack  ................................. 12
      1.3.3.2  Avance systems with AQUAQR rack  ........................... 14
   1.3.4  Software requirements  ............................................. 17
1.4  Important Red Hat Linux Enterprise WS 3 configurations  .................. 18
    1.4.1  KDE - desktop manager: recommended by Bruker BioSpin  ............. 18

Chapter 2  Express Installation and Configuration of TopSpin  ................. 19
2.1  About this chapter  .................................................. 19
2.2  Installing TopSpin  .................................................. 19
   2.2.1  Installation in parallel  ........................................... 20
   2.2.2  What do you want to do with TopSpin?  .................................. 24
2.3  Configuring TopSpin  ................................................ 24
   2.3.1  If you want to use a default configuration on a datastation .............. 25
   2.3.2  If your PC controls a spectrometer:  .................................. 25
   2.3.3  If you want to configure a processing-PC like your spectrometer-PC:  .... 28

Part I
  TopSpin Installation and Configuration

Chapter 3  General Installation Information  .................................. 31
3.1  Installation order  ................................................... 31

Chapter 4  Installing TopSpin  ............................................ 33
4.1  NMR SuperUser and NMR Administration Password  ............................ 33
   4.1.1  How to change the NMR ADMINISTRATION PASSWORD  ................. 34
   4.1.2  How to define a new NMR ADMINISTRATION PASSWORD  ................. 35
4.2  Packages on the TopSpin DVD  ........................................ 35
4.3  Installing TopSpin  .................................................... 36
   4.3.1  Installation in parallel  ............................................. 36
   4.3.2  What do you want to do with TopSpin?  .................................. 44
4.4  Perl and GCC  .......................................................... 44
4.5  Installing TopSpin patches  ............................................ 45
4.6  The usage of the NMR-GUIDE  ........................................ 46
Part II
RED-HAT Enterprise Linux WS 3 Installation-Tips and Configuration

Chapter 9 RED HAT Enterprise Linux WS 3 ........................................... 95
  9.1 Hints for installation of Red Hat.................................................. 95
  9.2 Scratch installation of Desktop computer ...................................... 95
    9.2.1 Necessary additional packages ............................................ 98
      9.2.1.1 Additional packages for spectrometer control - bootparamd .... 98
      9.2.1.2 Additional packages for documentation view - Acrobat Reader .. 99
    9.3 Installation of additional Red Hat packages on already installed systems . 100
      9.3.0.3 uucp, nfs-utils and redhat-config-nfs .................................. 101
      9.3.1 Additional packages for the compilation of AU programs .............. 102
        9.3.1.1 glibc-kernheaders .................................................. 102
        9.3.1.2 glibc-devel ..................................................... 103
    9.4 Check if all necessary components are installed and active ................ 104
    9.5 Dual Boot computer .......................................................... 105

Chapter 10 Network configuration .................................................. 107
  10.1 Configuring the laboratory network ......................................... 107
  10.2 Some useful commands ....................................................... 108
    10.2.1 Configuring the laboratory network by DHCP .......................... 108
    10.2.2 Configuring the laboratory network by using a fixed TCP/IP address . 111
    10.2.3 Spectrometer PC that should not be connected to the laboratory network . 115
    10.3 Configuring the spectrometer network .................................... 118
    10.3.1 Configuration of the spectrometer network ............................ 118
    10.3.2 Changing the hostname .................................................. 121
    10.4 Email client ............................................................... 121
    10.5 Network diagnostic commands ............................................. 122
    10.6 Accessing remote files and directories ................................... 122
      10.6.1 Sharing directories from a Linux host using Samba .................. 122
      10.6.2 Mounting Windows 2000/XP partitions on a Linux host using Samba . 123
      10.6.3 Mounting Windows 2000/XP partitions from a Linux host using NFS ... 125
      10.6.4 FTP and Telnet ....................................................... 125

Chapter 11 Installing a Printer ..................................................... 127
  11.1 Introduction ............................................................................. 127
  11.2 Print system „CUPS“ ............................................................... 128
    11.2.1 Installation of a Local printer .......................................... 128
    11.2.2 Installation of a Unix network printer .................................. 133
    11.2.3 Installation of a Windows network printer ............................ 138
    11.2.4 Installation of a Jet Direct printer .................................... 143
Part III
Tips, Tricks and Troubleshooting

Chapter 12 Troubleshooting TopSpin ........................................ 151
  12.1 TopSpin does not start ........................................ 151
  12.2 TopSpin troubleshooting ...................................... 152
    12.2.1 Troubleshooting while no acquisition is running ............ 152
    12.2.2 Troubleshooting while an acquisition is running .......... 153
  12.3 Communication problems between PC and CCU .................... 155
    12.3.1 Communication problems but telnet spect works ............ 155
    12.3.2 Communication problems and telnet spect does not work ... 157
    12.3.3 Files which are needed for the spectrometer network ....... 162
    12.3.4.1 View/change the prom parameters ....................... 166
    12.3.4.2 Viewing the boot process ................................ 166
    12.3.4.3 Running CCU diagnostic tests .......................... 170
    12.3.4.4 Rebooting the PC and the CCU with ‘reviveccu’ .......... 172
    12.3.4.5 Rebooting the PC  .................................... 172
    12.3.5.1 The entire screen is frozen ............................ 172
    12.3.5.2 Programs like shrm, reviveccu and touser are not found ... 173
    12.3.5.3 Xserver does not start after reboot / not enough disk space available .............................. 173
    12.4 General steps that you can try to locate or solve problems .... 170
      12.4.1 Check the WWW for FAQ’s, known bugs or known problems .. 170
      12.4.2 RED HAT help ........................................ 171
      12.4.3 Checking the history of TopSpin .......................... 171
      12.4.4 Rebooting the PC ...................................... 171
      12.4.5 Rebooting the PC and the CCU with ‘reviveccu’ ............ 172
      12.5 Various problems in Linux .................................. 172
        12.5.1 The entire screen is frozen ............................ 172
      12.6 Trouble under Linux ....................................... 174
        12.6.1 You cannot log in as normal user ....................... 174
      12.7 Useful configuration hints .................................. 174
      12.8 Spectrometer hardware tests ................................ 176
    12.8.1 Spectrometer internal boards ............................... 176

Chapter 13 Important Linux features ...................................... 177
  13.1 The Boot Floppy ............................................... 177
    13.1.1 Creating a boot floppy .................................. 177
  13.2 Important Commands ............................................ 178
    13.2.1 rpm .................................................. 178
    13.2.2 cd .................................................. 178
    13.2.3 ls .................................................. 179
    13.2.4 chmod .............................................. 179
    13.2.5 chown / chgrp ........................................ 180
    13.2.6 grep ................................................. 181
    13.2.7 find ............................................... 182
    13.2.8 ps .................................................. 183
13.2.9 kill ............................................................ 184
13.2.10 compress, gzip ........................................ 184
13.2.11 tar ......................................................... 186
13.3 Important Files ............................................. 187
13.3.1 /etc/shadow .............................................. 187
13.3.2 /etc/passwd .............................................. 188
13.3.3 /etc/group ............................................... 190
13.3.4 bashrc .................................................... 191
13.3.5 umask ..................................................... 192
13.4 Linux shells .................................................. 193
13.4.1 How to use the bash .................................... 194
13.5 Useful tips for Linux ....................................... 196
13.5.1 Configure the screen resolution with Xconfigurator 196
13.6 How to avoid much typing in Linux .......................... 197
13.6.1 General .................................................... 197
13.6.2 Linux shell scripts ....................................... 198
13.6.3 cron - crontab .......................................... 200
13.7 Red Hat Network: Hotfixes to keep the system secure . . 217
13.7.1 Activate your Linux license at Red Hat Network . . . . 217
13.7.2 Register the PC to the Red Hat Network ............... 219
13.7.3 Activate the Red Hat Alert Notification Tool .......... 224
13.8 The Emergency Recovery CD / Image CD .................. 226
13.8.1 Creating a boot floppy .................................. 227
13.8.2 Creating the Rescue Disk ............................... 227
13.8.3 Creating the Emergency Recovery CD ................. 227
13.8.4 Using the Emergency Recovery CD ................. 228
13.9 Using the CD-Writer ........................................ 229
13.10 Add a new harddisk ......................................... 231

Chapter 14 File and directory handling .......................... 201
14.1 Permissions and Type of Access ............................. 201
14.1.1 Permissions of a file .................................... 201
14.1.2 Permissions of a directory ............................... 202
14.1.3 Types of Access .......................................... 202
14.1.4 Example .................................................. 202

Chapter 15 Useful tools for Red Hat Enterprise Linux WS 3 .... 205
15.1 How to use a memory stick under Linux ...................... 205
15.1.1 PC with SCSI drives .................................... 205
15.1.2 PC with IDE drives ..................................... 208
15.2 Firewall configuration ....................................... 209
15.2.1 Firewall configuration .................................. 210
15.3 Tools for internal communication ............................. 212
15.3.1 Installation description of an additional package: xinetd 213
15.3.2 Check if all necessary components are installed ........ 213
15.4 Setting up permissions for rsh, rlogin and rcp .............. 214
15.5 Creating a screenshot of the desktop ....................... 215
15.6 Creating an icon on the desktop ............................. 215
15.6.1 Create an icon for opening a pdf file with Acrobat Reader 215
15.7 Red Hat Network: Hotfixes to keep the system secure .... 217
15.7.1 Activate your Linux license at Red Hat Network ....... 217
15.7.2 Register the PC to the Red Hat Network ............... 219
15.7.3 Activate the Red Hat Alert Notification Tool .......... 224
15.8 The Emergency Recovery CD / Image CD .................. 226
15.8.1 Creating a boot floppy .................................. 227
15.8.2 Creating the Rescue Disk ............................... 227
15.8.3 Creating the Emergency Recovery CD ................. 227
15.8.4 Using the Emergency Recovery CD ................. 228
15.9 Using the CD-Writer ........................................ 229
15.10 Add a new harddisk ......................................... 231
Chapter 16  Appendix ................................................................. 233
   16.1 Some notes for the helium handling ........................................... 233
       16.1.1 Automatic notification for helium refill ................................. 233
       16.1.1.1 Set minimum limit of helium level ..................................... 233
       16.1.1.2 Create shell script 'heliumwarn' for email notification .......... 234
   16.2 Script for saving important files .............................................. 236
   16.3 Where Do I Find What? ........................................................ 237
Chapter 17  Books and Web addresses on Linux ................................. 239
Chapter 18  Bruker addresses .......................................................... 241
Chapter 1

Introduction

1.1 About this manual

This manual describes the installation of the TopSpin 1.3 under RED HAT ENTERPRISE LINUX WS 3.

It is available:

- as a hard copy ‘Installation Guide for TopSpin: RED HAT ENTERPRISE LINUX WS 3’
- as pdf file on the toplevel of the TopSpin DVD
- as TopSpin Online Help: click Help → Installation Guide
- as the up to date version on the Bruker web-server:

  http://www.bruker-biospin.de/NMR/nmr-softw/passwd/docu/index.html

- Note that this manual does not contain the TopSpin Release letter. That is a separate document which is not available as a hard copy but delivered as pdf and text files on the TopSpin DVD and also on the Bruker web-server (you can find it at the same URL as the Installation Guide)

  http://www.bruker-biospin.de/NMR/nmr-softw/passwd/docu/index.html
This manual is subdivided into an introduction and three main parts. It depends on your local demands which of these are necessary for you at the moment.

The first part shows how to install and configure TopSPIN and some essential additional software packages. It is recommended to follow the instructions step by step.

Part two describes the scratch installation of Red Hat Enterprise Linux WS 3 and some configuration steps like setup for network and printers. If you want to install Bruker BioSpin TopSPIN on a PC which is already in use, you can skip this part.

In the last part, you can find some additional information for working with Red Hat Enterprise Linux WS 3 and TopSPIN and also some tips for troubleshooting.

Note that all text-messages and graphics shown in this book are taken from the current version of the respective software products. Small differences to other versions are possible but generally speaking they should be very similar.

If you have any comments or suggestions, or if you find any errors in this manual, please do not hesitate to contact us at:

nmr-software-support@bruker.de

1.2 Conventions

The following conventions will be used throughout this manual:

- **Bold-Courier**: Linux commands to be entered from the keyboard
- **Bold-Times**: Linux commands/applications to be clicked with the mouse
- **Bold-Courier-Italics**: NMR Suite commands to be entered from the keyboard
- **Bold-Times-Italic**: NMR Suite commands to be clicked with the mouse
- **Courier**: a file name or directory name
- **Courier Small Italic**: responds of the system
- **Courier Small**: the contents of a file
- **Times italics**: any name which is not a file name e.g. host names, user names
1.3 Hardware and software requirements for TopSpin

1.3.1 Operating system requirements

The following operating systems are tested and supported for TopSpin 1.3.

<table>
<thead>
<tr>
<th>Linux</th>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red Hat Enterprise Linux WS 3</td>
<td>Windows 2000 / Windows XP</td>
</tr>
</tbody>
</table>

Any other operating systems might also work but because TopSpin 1.3 was not tested there, usage of not supported operating system is at one’s own risk.

1.3.2 Special PC Hardware requirements

To run TopSpin 1.3 we recommend the following computer hardware:

- PC\(^1\) with CPU Clock \(\geq\) 1 GHz
- Memory \(\geq\) 512 MB
- Video (graphics)-card memory: 64 MB \(^2\)
- 2 Ethernet cards (the second card is only required if your PC controls a spectrometer)
- DVD device\(^3\)
- Mouse with 3-button possibilities

If your hardware does not meet these requirements, TopSpin might still run but with a much lower performance.

Installation was tested on a HP XW4100 PC running under Red Hat Enterprise Linux WS 3 and TopSpin 1.3.

---

1. TopSpin only runs on x86-based systems. It does not support 64bit architecture
2. It is recommend not to use shared memory graphics, because in some cases memory problems could be observed.
3. TopSpin is delivered on DVD’s with “.R” format
1.3.3 Spectrometer requirements

TopSpin 1.3 is released for datastations and Avance-AQS, Avance-AQX/AQR.

For upgrade possibilities of your spectrometer with TopSpin 1.3, please check with your local Bruker office.

Hardware components that are TopSpin version or operating system dependent are listed below. Components that are not listed here do not need an upgrade for TopSpin 1.3.

Please note that AQS and AQX/AQR components cannot be interchanged.

If your Avance spectrometer does not meet the above specifications, please get in touch with your local Bruker representative for your upgrade options.

1.3.3.1 Avance systems with AQS rack

- CCU:

<table>
<thead>
<tr>
<th>LINUX, independent of your TOPSPIN version</th>
<th>required minimum EC level</th>
</tr>
</thead>
<tbody>
<tr>
<td>CCU 10 (part # H9503, EC level 00 to 19)</td>
<td>06</td>
</tr>
<tr>
<td>CCU 10 (part # H9503, EC level &gt; 19)</td>
<td>22</td>
</tr>
<tr>
<td>CCU 11 a (part # H9503V1)</td>
<td>00 (recommended 01)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Windows, independent of your TOPSPIN version</th>
<th>required minimum EC level</th>
</tr>
</thead>
<tbody>
<tr>
<td>CCU 10 (part # H9503)</td>
<td>any</td>
</tr>
<tr>
<td>CCU 11 a (part # H9503V1)</td>
<td>00 (recommended 01)</td>
</tr>
</tbody>
</table>

a. Note that CCU 11 also exists for AQX/AQR spectrometers.
• **FCU 3:**

<table>
<thead>
<tr>
<th>FCU 3</th>
<th>required minimum EC Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>part # H5822 (64k memory)</td>
<td>04</td>
</tr>
<tr>
<td>part # H9598 (256k memory)</td>
<td>02</td>
</tr>
</tbody>
</table>

• **RCU:** (Note: RCU of the AQX/AQR rack can be used also in a AQS rack)

<table>
<thead>
<tr>
<th>RCU</th>
<th>EC level</th>
</tr>
</thead>
<tbody>
<tr>
<td>RCU 1/2 (part # Z003678)</td>
<td>any</td>
</tr>
<tr>
<td>RCU 1/3 (part # Z022488)</td>
<td>any</td>
</tr>
</tbody>
</table>

• **Multiple Receiver RCU:**

<table>
<thead>
<tr>
<th>Multiple Receiver RCU</th>
<th>EC Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>RCU 1/4 (part # Z052488)</td>
<td>any</td>
</tr>
<tr>
<td>RCU 2/4 (part # Z062488)</td>
<td>any</td>
</tr>
<tr>
<td>RCU 3/4 (part # Z072488)</td>
<td>any</td>
</tr>
<tr>
<td>RCU 4/4 (part # Z082488)</td>
<td>any</td>
</tr>
<tr>
<td>RCU 1/5 (part # Z003206)</td>
<td>any</td>
</tr>
<tr>
<td>RCU 2/5 (part # Z003207)</td>
<td>any</td>
</tr>
<tr>
<td>RCU 3/5 (part # Z003208)</td>
<td>any</td>
</tr>
<tr>
<td>RCU 4/5 (part # Z003209)</td>
<td>any</td>
</tr>
</tbody>
</table>

• **TCU 3:**

<table>
<thead>
<tr>
<th>TCU 3</th>
<th>required minimum EC Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>part # H5813, EC level 00 to 19</td>
<td>09</td>
</tr>
<tr>
<td>part # H5813, EC level 20 to 29</td>
<td>28</td>
</tr>
<tr>
<td>part # H5813V1</td>
<td>any</td>
</tr>
<tr>
<td>part # H5813F2</td>
<td>any</td>
</tr>
<tr>
<td>part # H5813F3</td>
<td>any</td>
</tr>
</tbody>
</table>
1.3.3.2 Avance systems with AQX/AQR rack

<table>
<thead>
<tr>
<th>RCU</th>
<th>required minimum EC level</th>
</tr>
</thead>
<tbody>
<tr>
<td>RCU 1/1 (part # Z002488) 64 kB SRAM &amp; 1MB DRAM</td>
<td>06</td>
</tr>
<tr>
<td>RCU 1/2 (part # Z012488) 256 kB SRAM &amp; 2MB DRAM</td>
<td>06</td>
</tr>
<tr>
<td>RCU 1/3 (part # Z022488) 1 MB SRAM &amp; 2MB DRAM</td>
<td>06</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>WINDOWS</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>CCU 04 (part # H2552)</td>
<td>04</td>
</tr>
<tr>
<td>CCU 05 (part # H2570, EC 00 to 19)</td>
<td>05</td>
</tr>
<tr>
<td>CCU 06 (part # H2570, EC 20 to 29)</td>
<td>24</td>
</tr>
<tr>
<td>CCU 08 (part # H2570, EC 30 to 39)</td>
<td>35</td>
</tr>
<tr>
<td>CCU 09 (part # H2570)</td>
<td>any</td>
</tr>
<tr>
<td>CCU 11a (part # H2570V1)</td>
<td>any</td>
</tr>
</tbody>
</table>

a. Note that CCU 10 does not exist for AQX/AQR spectrometers. Further note that CCU 11 also exists for AQS spectrometers.
## LINUX

<table>
<thead>
<tr>
<th>CCU</th>
<th>required minimum EC level</th>
</tr>
</thead>
<tbody>
<tr>
<td>CCU 04</td>
<td>05</td>
</tr>
<tr>
<td>(part # H2552)</td>
<td></td>
</tr>
<tr>
<td>CCU 05</td>
<td>06</td>
</tr>
<tr>
<td>(part # H2570, EC 00 to 19)</td>
<td></td>
</tr>
<tr>
<td>CCU 06</td>
<td>26</td>
</tr>
<tr>
<td>(part # H2570, EC 20 to 29)</td>
<td></td>
</tr>
<tr>
<td>CCU 08</td>
<td>38</td>
</tr>
<tr>
<td>(part # H2570, EC 30 to 39)</td>
<td></td>
</tr>
<tr>
<td>CCU 08</td>
<td>46</td>
</tr>
<tr>
<td>(part # H2570, EC 40 to 49)</td>
<td></td>
</tr>
<tr>
<td>CCU 09</td>
<td>55</td>
</tr>
<tr>
<td>(part # H2570, EC 50 to 59)</td>
<td></td>
</tr>
<tr>
<td>CCU 09</td>
<td>62</td>
</tr>
<tr>
<td>(part # H2570, EC 60 to 69)</td>
<td></td>
</tr>
<tr>
<td>CCU 11</td>
<td>any</td>
</tr>
<tr>
<td>(part # H2570V1)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TCU</th>
<th>required minimum EC level</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCU 1 main board</td>
<td>03</td>
</tr>
<tr>
<td>(part # H5811 or 5812)</td>
<td></td>
</tr>
<tr>
<td>TCU 0 main board</td>
<td>07</td>
</tr>
<tr>
<td>(part # H2558)</td>
<td></td>
</tr>
<tr>
<td>TCU extention board</td>
<td>03</td>
</tr>
<tr>
<td>(part # H2562)</td>
<td></td>
</tr>
<tr>
<td>TCU extention board</td>
<td>20</td>
</tr>
<tr>
<td>(part # H2562)</td>
<td></td>
</tr>
<tr>
<td>in DMX/DRX with &gt; 5 channels</td>
<td></td>
</tr>
</tbody>
</table>
Note: ‘normal’ RCUs and multiple receiver RCUs should not be mixed!

<table>
<thead>
<tr>
<th>Multiple Receiver RCU</th>
<th>EC level</th>
</tr>
</thead>
<tbody>
<tr>
<td>RCU 1/4 (part # Z052488)</td>
<td>any</td>
</tr>
<tr>
<td>RCU 2/4 (part # Z062488)</td>
<td>any</td>
</tr>
<tr>
<td>RCU 3/4 (part # Z072488)</td>
<td>any</td>
</tr>
<tr>
<td>RCU 4/4 (part # Z082488)</td>
<td>any</td>
</tr>
<tr>
<td>RCU 1/5 (part # Z003206)</td>
<td>any</td>
</tr>
<tr>
<td>RCU 2/5 (part # Z003207)</td>
<td>any</td>
</tr>
<tr>
<td>RCU 3/5 (part # Z003208)</td>
<td>any</td>
</tr>
<tr>
<td>RCU 4/5 (part # Z003209)</td>
<td>any</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>FCU0</th>
</tr>
</thead>
<tbody>
<tr>
<td>64k memory: part # H2556</td>
</tr>
<tr>
<td>64k memory: part # H2554</td>
</tr>
<tr>
<td><strong>FCU0:</strong> for use without cortab</td>
</tr>
<tr>
<td><strong>FCU0:</strong> for DSX without use of cortab</td>
</tr>
<tr>
<td><strong>FCU0:</strong> for use with cortab with EC level between 00 and 19</td>
</tr>
<tr>
<td><strong>FCU0:</strong> for use with cortab with EC level ≥ 20</td>
</tr>
</tbody>
</table>
1.3.4 Software requirements

Because of the variety of Linux systems and their possible problems with some PC-hardware components, Bruker only supports RED HAT ENTERPRISE LINUX WS 3 and the hardware components described in section 1.3.2. This software/hardware combination was successfully tested with the TopSpin 1.3. Any other Linux systems and PC hardware components might work, but are not tested and supported by Bruker.

Requirements for TopSpin:
- Red Hat Enterprise Linux WS 3
- Adobe Acrobat Reader (WWW)

Requirements for NMR-GUIDE:
- Web Browser: Mozilla (CD or WWW)
1.4 Important Red Hat Linux Enterprise WS 3 configurations

1.4.1 KDE - desktop manager: recommended by Bruker BioSpin

All information described in this manual is based on the desktop manager KDE. If you use GNOME, there will be differences in names, directories and files.

In the login window, type in:

- your login name
- your password
- choose as Session KDE
- press Enter

---

1. If you choose KDE as login session the first time, you will be asked if KDE should become your default session type. If you agree KDE will be used automatically in the future.
Chapter 2
Express Installation and Configuration of TOPSPIN

2.1 About this chapter
This chapter gives a brief description of how to install Bruker BioSpin’s TOPSPIN.
This chapter is directed to users who would like to install TOPSPIN 1.3 on a PC, on which XWIN-NMR or a version of TOPSPIN is already installed and configured correctly. Therefore this chapter provides an overview and provides not information on all aspects of configuring TOPSPIN. Further details can be found in the following chapters.
For more details on the installation see chapter 4
For more details on the TOPSPIN commands like cf, expinstall etc. please refer to the description of these commands in the Acquisition Reference manual.

2.2 Installing TOPSPIN
The main decision you have to make during installation is where do you want to install the new TopSpin version. If you a have previous NMR SUITE or TOPSPIN
installation on this PC available, you can either:

- install the new version in parallel to the previous one
- or
- install the new version in the same directory as the previous one

The installation in parallel has the advantage, that the previous version remains unchanged. After a parallel installation you can start working with the new version and if you want to go back to the previous version for whatever reasons you can just start and reuse it.

The installation of TopSpin 1.3 offers an automatic import of your individual configuration of a previous version, so that there is no advantage to install the new version in the same directory as the old one.

### 2.2.1 Installation in parallel

1. Close ALL WINDOWS on the desktop.
2. Insert the DVD 'TopSpin 1.3'
3. Start of the installation
   - If the automatic start of the DVD is enabled, the shell described in the next step appears automatically, go to step 4
   - If the shell of the next step does not appear automatically you have click on the DVD icon on your desktop and click on the file `install`
4. If you are not logged in as root, a Linux shell will appear that asks you for the root password:
   
   Please enter root password if prompted for it:
   
   Password:
   - Enter root password and press enter
5. The window TopSpin Installation Manager will appear
6. The window Welcome! will appear
   - Click Next

---

1. Please note that there is also a file called `install.cmd` on the DVD. This file is the installation script for windows, under Linux you have to click on the file `install`
7. The window *TOPSPIN Release Letter* will appear:
   Please read the NMR Release letter! You can find therein all information about
   news and bug fixes of the current version.
   • When you have finished reading the Release Letter click **Next**

8. The window *Please select a target directory for TOPSPIN* will appear:
   Enter an installation path which does not exists so far, e. g. `/opt/topspin1.3`
   • Click **Next**

9. If the installation directory does not exist so far, you will be asked if the instal-
   lation process should create it
   • Click **Yes**

10. A window *Please select the setup type* will appear:
   a) Select the setup type. Do one of the following:
      • Select **Data Processing only** if you want to use TOPSPIN for data process-
        ing.
      • Select **Data processing, acquisition and automation** if you want to use
        TOPSPIN for spectrometer control. This will e. g. install **Diskless**
        automatically.
      • **Customized setup** (allows components selection) if you want to install
        selected programs only.
   b) Click **Next**

10.1. If **Customized** was selected in step 10 ...
   a) ... a window *Please select products to install* will appear:
      • Select the packages which you want to install (note that DISKLESS is
        only required if your PC controls a spectrometer or you want to con-
        figure it like this (see chapter 6.2.2).
      • Click **Next**

11. The window *Select a spectrometer configuration to import* will appear. You can
    either import no spectrometer configuration, or browse for a spectrometer con-
    figuration or select one of the configurations you get offered within this win-
    dow.¹

12. If a previous topspin installation is available in the global environment variable
    Path, you will be asked if you want to define the current installation path
instead. It is recommended to set the current installation into the PATH variable, so enable.:

Yes, add the new TOPSPIN installation directory to the global PATH
  • Click Next

13. A window appears that asks for the installation path of FlexLM. It is strongly recommended to accept the default path:
  • Click Next

14. A window appears that displays the program selection of step 10a
  • Click Next

15. A window 'Set NMR Super User' will appear:
   a) Do one of the following:
      • Accept the default NMR SUPERUSER (nmrsu) or
      • Enter a special user for this purpose, e.g. named nmr-admin or
      • Enter any other user
      If the user does not exist, the installation will create it. For further details see chapter 4.1 or the TopSpin Users Guide.
   b) Click Next

16. A window 'Password Input' will appear and asks for the NMR ADMINISTRATION PASSWORD (for more details about this feature see chapter 4.1)
   a) Type in the NMR ADMINISTRATION PASSWORD
   b) Re-enter the NMR ADMINISTRATION PASSWORD
   c) Click Next

17. If Data Processing, acquisition and automation or Customized with the Disk-

---

1. The installation process will offer all configurations which are available in the TopSpin /XWIN-NMR installation that are defined in the /etc/profile.d/xwinnmr(.csh/.sh) resp. topspin/.csh/sh) directory.
2. In case more than one TopSpin version is installed in parallel it is your decision which one should be defined here
3. It is strongly recommended to accept the default path for the FlexLM installation: /usr/local/flexlm If you choose a user defined path, it may cause some problems with other applications using the FlexLM
4. Certain commands like \textit{cf} and \textit{expinstall} ask for the NMR ADMINISTRATION PASSWORD.
less package was selected in step 8 a window will appear to inform that the spectrometer has to be shut down.

a) If the PC is not yet connected to a spectrometer or if the CCU is not booted\(^1\) you can promptly
   • Click \textbf{Next}

b) If your PC is currently connected to a spectrometer and the CCU is booted:
   a) Open a Linux shell
   b) enter the command:

   \texttt{telnet spect}

   c) login as \textit{root}
   d) enter the command:

   \texttt{init 5}

   → this will shut down the CCU

e) Close the Linux shell
f) Click \textbf{Next} in the window that asked you about shutdown the CCU

\textit{Note: The CCU is now either down or switched off and should be turned on again at the end of this procedure.}

→ The installation of \textsc{TopSpin} will start now.

18. After installation is finished a window appears that informs about all installed programs
   • Click \textbf{Seen}

19. Depending if you have installed \textsc{Diskless} one of the following windows will appear:
   • If you have installed \textsc{Diskless} a window will appear that asks you to reboot the PC. Make sure that you can reboot the PC now (check for any unsaved windows (e. g. an editor window) and check if no other users are logged in into this PC) then click on \textbf{Yes}
   • If you have not installed \textsc{Diskless} a window will appear that informs you to log out and log back in before you start \textsc{TopSpin}, click \textbf{Seen}

\footnotesize{\textsuperscript{1} Note that during a first time installation of the \textsc{TopSpin} the CCU can not be booted.}
20. The window wherein you entered the root password informs you that you have to press Enter to close this window
   • Press Enter

21. If you have started the installation manually by clicking the file ‘install’ in the Konqueror window, you have to close this Konqueror window.

22. To eject the DVD click right on the DVD icon on the desktop and choose eject

2.2.2 What do you want to do with TopSPIN?

• it should control a spectrometer or you want to use a special spectrometer configuration
  → you have to execute cf and expinstall

• it should be used for data processing only?
  → you have to execute expinstall

For more details please refer to the next chapter

2.3 Configuring TopSPIN

The idea of this chapter is to give you some guidelines to configure TopSPIN for using it on a workstation for data processing, or for operating a spectrometer. We do not discuss the commands in detail here. For a full description refer to the TopSPIN manuals.

Start TopSPIN:

• Click the icon TopSPIN on the desktop¹, or

• Click ‘redhat’ → Other → TopSPIN<vers.>

After the first startup of TopSPIN you have the possibility to configure the software depending upon the hardware of your spectrometer. If you do this, you are probably in one of the following five situations:

1. You want to configure a processing-only-PC with a default configuration on a datastation → go to chapter 2.3.1 (for details see chapter 6.2.3)

2. You have installed the new software on the same PC as a previous XWIN-NMR/TopSPIN installation, so the old spectrometer configuration is available on

---

¹. How to create a icon? See chapter 15.6.1
Express Installation and Configuration of **TOPSPIN**

the same PC → go to chapter 2.3.2 (for details see chapter 6.2.1)

3. You want to configure a processing-only-PC like your spectrometer-PC, so you have the spectrometer configuration on another computer → go to chapter 2.3.3 (for details see chapter 6.2.2)

4. You have to configure the software for controlling a spectrometer on a new hard disk without a backup of the spectrometer configuration, so you have no configuration files → go to chapter 6.2.4

5. You have to configure the software for controlling a spectrometer with a new spectrometer hardware component → go to chapter 6.2.5

2.3.1 If you want to use a default configuration on a datastation

A default configuration can be used on a PC that is used for processing only. It is automatically performed (no **cf** required) during the installation of **TOPSPIN**...

- in a new **TOPSPIN** installation directory
- if no **TOPSPIN/XWIN-NMR** was installed on this computer so far

The default configuration name is **Bruker_default_av500** and corresponds to an Avance 500 MHz spectrometer.

For data processing only you have to execute **expinstall** and select *Installation for Datastation (Default)*.

For further details please refer to the respective chapters (see chapter 6.2.3).

2.3.2 If your PC controls a spectrometer:

1. Be sure that the spectrometer is booted (see chapter 9.3.0.3 and 12.3.4.2)

2. Open a dataset

   - **Type** **new** and create a new dataset.
   - You can also select a dataset (e.g. 'exam1d_1H') acquired with another **TOPSPIN** or **XWIN-NMR** version

3. Enter **cf** (The command **cf** now configures the software according to the hardware of your spectrometer.)

   a) A window will appear:

   *Password request. Please enter the NMR Administration Password*
Type in the NMR ADMINISTRATION PASSWORD. Click OK.

b) A window will appear:
*Spectrometer configuration: ...*
Select your previous configuration and press **Edit** to confirm this configuration.

c) A window will appear:
*Edit configuration. ...*
The selected configuration is displayed. Choose whether to configure it as a spectrometer or datastation. Choose the type of your spectrometer e.g.
**AVANCE → ENTER**. Check or type in the 1H frequency of the magnet e.g.
**500.13 → ENTER**. Use the debug mode only in case of troubleshooting.

d) A window will appear:
*Specify the channel to which external devices are connected. The RS232/485 channel for external devices—Table appears.*
Check if the tty-numbers of the hardware components are set correctly.

e) A window will appear:
*Additional configuration. Security check. Enable peak power check (POWCHK). Enable pulse power check (PULCHK).*
Choose the options if you want to use this security options. **Powchk** and **Pulchk** require special probes and **cortab**. If in doubt contact your local Bruker representative, please.

f) Only if you have a sample changer!
*Should the Sample Changer control the Lift? (yes/no)*
The answer depends on how the air flow is connected, normally you will answer: **yes → ENTER**
If you have a sample changer, this question appears:
*Delay between SX and next command [sec]??*
Type in the length of the delay e.g. **10 → ENTER**

g) The nuclei-table appear
Check if the frequency of the nuclei are set correctly. If in doubt click **Restore** then click **Save**
h) The results of \texttt{cf} appears in a text window. Check this list carefully and compare the result with an list from an earlier configuration (if available) click \texttt{Print} and store the paper output with your other spectrometer documentation, then click \texttt{OK}. These data are saved in: \\
<TOPSPINHOME>/conf/instr/<spect>/uxnmr.info

\textbf{If during 'cf' an error message occurs that invites you to do a firmware update see chapter 6.3}

After finishing \texttt{cf} the window '\texttt{config}' will appear showing a list of configuration steps. You will be asked for the NMR ADMINISTRATION PASSWORD several times:

- Continue with \texttt{expinstall}
  a) Type in the NMR ADMINISTRATION PASSWORD and \texttt{ENTER}
  b) Click \texttt{Next} if you either have not modified Bruker BioSpin Parameter files, AU-programs and Pulse-programs or if you have archived them in a different directory. Your individual Parameter files, AU-programs and Pulse-programs etc. that are named different to the original Bruker BioSpin files will not be destroyed during the installation.
  c) A window appears: Check \texttt{Installation for Spectrometer} → Click \texttt{Next}
  d) In the appearing window: Check the \texttt{required system} → Click \texttt{Next}
  e) In the appearing dialog box: Select the spectrometer configuration name → Click \texttt{Next}
  f) In the appearing dialog box: Check the items you want to install or, accept the default selection → Click \texttt{Next}
  g) In the appearing dialog box: Select the default printer and plotter and the desired paper format → Click \texttt{Next}
  h) In the appearing window: Enter the desired spectrometer frequency, acquisition mode and pre-scan-delay or, accept the default values → Click \texttt{Next}
  i) In the appearing information box: Check the configuration selection and, if it is correct → Click \texttt{Finish}

- Continue with \texttt{edsolv}
  Check the list of lock solvents → click \texttt{Save} if it is correct → Click \texttt{Close}

- Continue with \texttt{edhead}
  Select the current probe → click \texttt{Define as current probe} → Click \texttt{Exit}
• Continue with **edprosol**
  Check the parameters for your observed nuclei, and if necessary change
  and/or recalculate them → Click **Save** to store to disk → Click **Exit**

• Continue with **edlock**
  Check the lock table values (field, lock phase, ...), change them and click
  **Save** if necessary, otherwise click **Abort**

• Continue with **edscon**
  Check the spectrometer constants, change them and click **Save** if necessary,
  otherwise click **Cancel**

After **cf, expinstall**,... have finished insert a sample and make sure that you
can lock on the lock solvent. Type **ii** and read with **rpar** a standard Bruker
BioSpin parameter file (e. g. 'rpar PROTON all'), type **getprosol rga, wobb** and **zg** and collect a normal $^1$H NMR spectrum.

### 2.3.3 If you want to configure a processing-PC like your spectrometer-PC:

If the PC does not control a spectrometer but is used in connection with a particular spectrometer, e.g. for setting up experiments, processing and or plotting, you
should configure it as that spectrometer (see FAQ 210 on [www.bruker-biospin.de](http://www.bruker-biospin.de))
(see chapter 6.2.2).
Part I

TopSpin
Installation
and
Configuration
Chapter 3

General Installation Information

3.1 Installation order

A complete new installation on a PC connected to a spectrometer involves the following steps:

1. Installing RED HAT ENTERPRISE LINUX WS 3 (see chapter 9.1)
2. Installing additional packages (see chapter 9.2)

Step 1 to 2 are normally already done by the manufacturer.

3. Configuring the network (see chapter Chapter 10)
4. Installing TOPSPIN (see chapter 4.3)
5. Installing TOPSPIN license (see chapter Chapter 5)
6. Configuring of TOPSPIN (see chapter 6.1)
7. Installing a printer (see chapter Chapter 11)

If your PC has already been used for TOPSPIN/XWIN-NMR, steps 1 and 2 are probably already done. In that case, you can start with step 3.
Chapter 4

Installing TOPSPIN

4.1 NMR SUPERUSER and NMR ADMINISTRATION PASSWORD

TOPSPIN offers a complete new password check for the configuration tools of TOPSPIN. During the TOPSPIN installation, you are prompted to define:

1. The username for the so called NMR SUPERUSER. The NMR SUPERUSER can be nmrsu (this is the default) or any other user (if the user does not exists so far, it will automatically be created during installation process).

   • After the installation, the NMR SUPERUSER is the owner of all TOPSPIN program files. Log in as this user allows you to remove these files, change file permissions etc. The name of the NMR SUPERUSER will be stored in the readable text file: <TOPSPINHOME>/conf/nmrsuperuser

2. The NMR ADMINISTRATION PASSWORD to be used for TOPSPIN configuration commands. This password can be freely chosen and is not connected to any user. TOPSPIN asks for this password by commands like cf, expinstall etc. The encrypted NMR ADMINISTRATION PASSWORD is stored in the file:

   <TOPSPINHOME>/conf/nmranadminpassword

Note: The NMR SUPERUSER login password and the NMR ADMINISTRATION PASSWORD have different purposes and are totally independent. Changing one of them does not affect the other.
With the information about the NMR ADMINISTRATION PASSWORD and NMR SUPERUSER TopSpin is ready to be configured. The NMR ADMINISTRATION PASSWORD will be asked for every time a configuration type command is entered. If this password is typed in correctly, the command will be executed regardless of which user is logged in the operating system. As a result all newly created configuration files will be owned by the user that was logged in at the time the configuration command was executed. Any other user can modify the configuration during his login session, just by knowing the correct NMR ADMINISTRATION PASSWORD. This is possible because all configuration files are read- and writeable for everybody, but TopSpin will not write them without the correct NMR ADMINISTRATION PASSWORD!

TopSpin also offers a so-called Security Mode. With this feature all configuration files are read- and writeable only for the NMR SUPERUSER.

4.1.1 How to change the NMR ADMINISTRATION PASSWORD

The installnmr script can be used to change the NMR ADMINISTRATION PASSWORD and the NMR SUPERUSER. If it is called with the option '-secure', it changes the permissions in a way, that only the NMR SUPERUSER can execute the configuration commands and the resulting files are readable and writable only for him, all other users have read-only permissions.

To change the NMR ADMINISTRATION PASSWORD, you have to:

1. Login as NMR SUPERUSER
2. Open a Linux shell.
3. Go to the TopSpin installation directory, in a default installation this is
   /opt/topspin
4. Enter the command:
   
   prog/bin/installnmr <TOPSPINHOME> <NMRSUPERUSER>

   If you installed TopSpin in the default directory and you want to use the user 'nmrsu' as NMR SUPERUSER, you have to type in
   
   prog/bin/installnmr /opt/topspin nmrsu
5. Enter the old password and new password as requested.
4.1.2 How to define a new NMR ADMINISTRATION PASSWORD

To define a new NMR ADMINISTRATION PASSWORD, for example because you have forgotten it, you have to:

1. Open a Linux shell
2. Login as root with the command
   `su -`
3. Delete the file
   `<TOPSPIN_HOME>/conf/nmrdadminpassword`
4. Enter the command
   `prog/bin/installnmr <TOPSPINHOME> <NMRSUPERUSER>`
5. Enter new password as requested.

4.2 Packages on the TOPSPIN DVD

1. TOPSPIN: Acquisition and processing software
2. TOPSPIN PLOT EDITOR: Object oriented WYSIWYG plot editor
   (automatically installed as part of the TOPSPIN package)
3. ICON-NMR: Icon-driven interface for Routine Spectroscopy and Automation
4. NMR-GUIDE: Web-browser based teaching and training program
5. DISKLESS: Spectrometer CCU operating system
6. NMR-SIM: Program for numerical simulation of NMR experiments
7. AMIX-Viewer: new multiple object viewer (requires a separate license)
8. AURELIA: Analysis of 2D/3D/4D NMR data (requires separate license)
9. GLP: Program for ‘Good Laboratory Practice’ tests (requires separate license)
10. FLEXLM: License manager required for starting TOPSPIN programs.
11. GNU TOOLS: System tools required by TOPSPIN.
    (automatically installed as part of the TOPSPIN package)
12. PERL: language interpreter required for certain TOPSPIN commands.
    (automatically installed as part of the TOPSPIN package)
4.3 Installing TopSpin

This chapter describes the installation of the TopSpin.

The main decision you have to make during installation is where do you want to install the new TopSpin version. If you have a previous NMR Suite or TopSpin installation on this PC available, you can either:

- install the new version in parallel to the previous one
- install the new version in the same directory as the previous one

The installation in parallel has the advantage, that the previous version remains unchanged. After a parallel installation you can start working with the new version and if you want to go back to the previous version for whatever reasons you can just start and reuse it.

The installation of TopSpin 1.3 offers an automatic import of your individual configuration of a previous version, so that there is no advantage to install the new version in the same directory as the old one.

4.3.1 Installation in parallel

1. Close ALL WINDOWS on the desktop
2. Insert the DVD "TopSpin 1.3"
3. Start of the installation
   - If the automatic start of the DVD is enabled, the shell described in the next step appears automatically, go to step 4
   - If the shell of the next step does not appear automatically you have click on the DVD icon on your desktop and click on the file install
4. If you are not logged in as root, a Linux shell will appear that asks you for the root password:
   Please enter root password if prompted for it:
   Password:
   • Enter root password and press enter

1. Please note that there is also a file called ‘install.cmd’ on the DVD. This file is the installation script for windows, under Linux you have to click on the file ‘install’
5. The windows TOPSPIN Installation Manager and Welcome to the Bruker Software Installation Manager will appear:

- Click Next

6. A window Release Letter TOPSPIN will appear:

   a) Please read the NMR Release letter! You can find therein all information about news and bug fixes of the current version.
   
   b) When you have finished reading the Release Letter click Next

7. A window Please select a target directory for TOPSPIN will appear:

   Enter an installation path which does not exist so far, e.g. /opt/topspin1.3

- Click Next
8. If the installation directory does not exist you will be asked if the installation process should create it automatically
   • Click Yes
9. A window Please select the setup type will appear:

   ![Please select the setup type window]

   a) Select the setup type. Do one of the following:
      • Select Data Processing only if you want to use TopSpin for data processing.
      • Select Data processing, acquisition and automation if you want to use TopSpin for spectrometer control. This will e. g. install Diskless automatically.
      • Customized setup (allows components selection) if you want to install selected programs only.

   b) Click Next
9.1. If Customized was selected in step 9...
... a window *Please select products to install* will appear:

<table>
<thead>
<tr>
<th>Please select products to install</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>TOPSPIN - Acquisition &amp; Processing Software</td>
<td>1.38.13</td>
<td>40.3 MB</td>
</tr>
<tr>
<td>Plot Editor</td>
<td>4.3</td>
<td>3.7 MB</td>
</tr>
<tr>
<td>ICON-NMR Automation Modules</td>
<td>4.0.0.35</td>
<td>19.3 MB</td>
</tr>
<tr>
<td>Disk less - CCU Operating System</td>
<td>20.00.001</td>
<td>20.2 MB</td>
</tr>
<tr>
<td>NMR-SIM - Experiment Simulator</td>
<td>4.3.9</td>
<td>3.7 MB</td>
</tr>
<tr>
<td>NMR-GUIDE - NMR Encyclopedia</td>
<td>4.2.37</td>
<td>18.1 MB</td>
</tr>
<tr>
<td>NMR-Data - NMR Example Data Set</td>
<td>4.4.a</td>
<td>4.2 MB</td>
</tr>
<tr>
<td>AURELIA-AUX-Viewer - Automatic Alignment</td>
<td>3.3.2</td>
<td>19.3 MB</td>
</tr>
<tr>
<td>FLEXSim - License Manager</td>
<td>9.3.3</td>
<td>3.5 MB</td>
</tr>
<tr>
<td>NMR-GLP - Spectrometer Validation Tool</td>
<td>4.3</td>
<td>2.6 MB</td>
</tr>
</tbody>
</table>

- Select the packages which you want to install (note that **Diskless** is only required if your PC controls a spectrometer or you want to configure it like this (see chapter 6.2.2).
  - **TOPSPIN**: Acquisition and processing software
  - **TOPSPIN PLOT EDITOR**: Object oriented WYSIWYG plot editor
  - **ICON-NMR**: Icon-driven interface for Routine Spectroscopy and Automation
  - **Diskless**: Spectrometer CCU operating system
  - **NMR-SIM**: Program for numerical simulation of NMR experiments
  - **NMR-GUIDE**: Web-browser based teaching and training program
  - **NMR-Data**: Spectroscopic example data
  - **AURELIA-AMIX-Viewer**: Viewer of 2D/3D/4D NMR data (requires separate license)
  - **NMR-GLP**: Program for 'Good Laboratory Practice' tests (requires separate license)

- **Click Next**

10. The window *Select a spectrometer configuration to import* will appear. You can either import no spectrometer configuration, or browse for a spectrometer configuration or select one of the configurations you get offered within this window.
The configurations that are shown in this picture are just an example. On your PC this list could look different.

11. If a previous topspin installation is available in the global environment variable Path, you will be asked if you want to define the current installation path instead. It is recommended to set the current installation into the PATH variable, so enable:

   Yes, add the new TOPSPIN installation directory to the global PATH

   • Click Next

12. A window appear that asks for the installation path of the FlexLM. It is strongly recommended to accept the default path!

   • Click Next

---

1. The installation process will offer all configurations which are available in the TOPSPIN / XWIN-NMR installation that are defined in the /etc/profile.d/xwinnmr(.csh/.sh) resp. topspin(.csh/.sh) directory.

2. In case more than one TopSpin version is installed in parallel it is your decision which one should be defined here

3. It is strongly recommended to accept the default path for the FlexLM installation: /usr/local/flexlm! If you choose a user defined path, it may cause some problems with other applications using the FlexLM
13. A window appear that displays the programs which will be installed

![Installation window](image)

- Click Next

14. A window will appear that prompted for a definition of an NMR SUPERUSER

![User input window](image)

a) Do one of the following:

- Accept the default NMR SUPERUSER \((\text{nmsra})\) or
- Enter a special user for this purpose, e.g. named \(\text{nmr-admin}\)
- Enter any other user

If the user does not exists, the installation will create it. For further details see chapter 4.1 or the TOPSPIN Users Guide.

b) Click Next

15. A window 'Password Input' will appear and asks for the NMR ADMINISTRA-
1. Certain commands like `cf` and `expinstall` ask for the NMR ADMINISTRATION PASSWORD.
2. Note that during a first time installation of the TopSpin the CCU can not be booted.
Installing TOPSPIN

c) login as root
d) enter the command:

\textbf{init 5}

→ this will shut down the CCU
e) Close the Linux shell
f) Click \textbf{Next} in the window that asked you about shutdown the CCU

Note: The CCU is now either down or switched off and should be turned on again at the end of this procedure.

→ The installation of TOPSPIN will start now.

17. After installation is finished the window ‘Setup is complete’ will appear:

![Setup is complete window]

• Click \textbf{Seen}

18. Depending if you have installed DISKLESS one of the following windows will appear:

• If you have installed DISKLESS a window will appear that asks you to reboot the PC. Make sure that you can reboot the PC now (check for any unsaved windows (e. g. an editor window) and check if no other users are logged in into this PC) then click on \textbf{Yes}
• If you have not installed Diskless a window will appear that informs you to log out and log back in before you start TopSpin, click **See**n

19. The window wherein you entered the root password informs you that you have to press **Enter** to close this window
   • Press **Enter**

20. If you have started the installation manually by clicking the file ‘install’ in the Konqueror window, you have to close this Konqueror window.

21. To eject the DVD click right on the DVD icon on the desktop and choose **eject**

22. To start TopSpin log out and log back in

### 4.3.2 What do you want to do with TopSpin?

• it should control a spectrometer or you want to use a special spectrometer configuration
  → you have to execute **cf** and **expinstall**
• it should be used for data processing only?
  → you have to execute **expinstall**

For more details please refer to the next chapter

### 4.4 Perl and GCC

The packages Perl and GCC are automatically installed in the directory `<TOPSPIN_HOME>/gnu` and `<TOPSPIN_HOME>/perl` where `<TOPSPIN_HOME>` is the directory where **TopSpin** is installed (default `/opt/topspin`). Perl and GCC are needed for compiling **TopSpin** AU programs.
4.5 Installing TopSpin patches

TopSpin patches are parts of TopSpin which contain bug fixes. They are available on the Bruker WWW and FTP server. We recommend to install new patches whenever the patchlevel on your system is older than the one on the WWW / FTP server.

Perform the following steps:

1. Open a shell
2. Type `patchlevel`
   This will show you the patchlevel on your system.

Download from WWW server

1. Log in on a computer which is connected to the internet
2. Open your web browser
3. Go to [http://www.bruker-biospin.de](http://www.bruker-biospin.de)
4. Click on NMR → tech support → Software → Downloads → Linux PC and select the package you want to download

Download from ftp server

Type `ftp ftp.bruker.de`

```
Name: ftp
Password: enter your own full Email address
ftp> cd /pub/nmr/topspin/patches/topspin<vers.>/LINUX
ftp> bin
ftp> ls
```
(if patches are available, you will see a file `topspin-<vers.>-patchX.tar.gz` where X is the patchlevel)

```
ftp> get topspin-<vers.>-patchX.tar.gz
ftp> get topspin-<vers.>-patchX.readme
ftp> bye
```

Install the patches according to the file `topspin-<vers.>-patchX.readme`

You can also get TopSpin patches from the American FTP server:
4.6 The usage of the NMR-GUIDE

NMR-GUIDE 4.0 that comes with TopSPIN 1.3 uses an own web server and the TopSPIN internal java package. Therefore it is not necessary anymore to have these packages installed/configured separately!

4.6.1 Requirements for NMR Guide 4.0

The using of NMR-GUIDE 4.0 requires the installation of TopSPIN 1.3. Also be sure that the following components are installed:

1. Web browser Mozilla
2. PDF viewer
   NMR-GUIDE offers among other things a lot of PDF documents. To display these documents it is necessary to install the acrobat reader. For an installation description see chapter 9.2.1.2
3. NMR-GUIDE license (contact license@bruker.de for a three month demo license or order a official license from your local Bruker representative). Note that the NMR-GUIDE license is already part of a full or demo TopSPIN 1.3 license.

Mozilla is an official part of the operating system RED HAT ENTERPRISE LINUX WS 3. The WWW browser gets documents from the locally installed WWW server. The client - server communication is established over a network socket connection, but the communication partners only use the localhost TCP/IP host identifier. These pages are shown in the right-hand side window of the browser.

The WWW browser also gets dynamically created pages from the localhost. These workstation specific pages are coming from a gserver. This is a platform independent Java web server written by Bruker BioSpin and acts as a daemon running on the locally installed JAVA virtual machine. The gserver is included in the NMR Guide&Encyclopedia package. The table of contents is generated dynamically and displayed in the left-hand side window of the browser.

TopSPIN commands can be invoked from the WWW browser. This process is also
managed by the gserver. The gserver is an essential component of the NMR Guide&Encyclopedia and requires an NMR-GUIDE license.

4.6.2 Java Requirements for NMR-GUIDE 4.0

For using NMR-GUIDE 4.0 that comes with the TopSpin 1.3 version it is not necessary to install/configure a special Java package. NMR-GUIDE uses the TopSpin internal Java package that is automatically installed and configured during installation of TopSpin.

4.6.3 Working with the NMR-GUIDE

In order to work with the NMR-GUIDE, the following procedure must be followed.

4.6.3.1 Start up of the NMR-GUIDE

1. Start TOPSPIN and enter the command:
   
   ghelp

   or enter the command (this allows to start a search within NMR-GUIDE:

   help

   or select from the Help pull-down menu of TOPSPIN the entry:

   NMR-GUIDE

2. Your standard web browser will automatically starts and shows the page

You can now use the functionality of NMR-GUIDE

4.6.3.2 Functionality test of NMR-GUIDE

If you want to test whether all functions and auxiliary programs that are used in connection with the NMR-GUIDE are correctly installed, then enter the URL

http://localhost:6060/guide/test.html

and follow the instructions.

4.6.3.3 Using the NMR-GUIDE search engine

One of the very important and useful tools of NMR-GUIDE is its search engine. It
offers the possibility to search within thousands of html pages that contain a huge amount of information about NMR spectroscopy.

For using this search engine you can start NMR-GUIDE and enter the keyword therein (or select an entry of the list of commonly used keywords). With NMR-GUIDE 4.0 you have also the possibility to search directly from within TOPSPIN, just enter the command:

```plaintext
help <keyword>
```
Chapter 5

The TOPSPIN license

5.1 Questions and answers about the TOPSPIN license

1. Which programs need a license?

   TOPSPIN, TOPSPIN PLOT EDITOR, NMR-SIM and NMR-GUIDE need a license. However, if you order a license for TOPSPIN, you automatically get a license for all four programs.

   If you do not have a license for TOPSPIN, it will start up in an emergency mode if your PC is connected to a spectrometer. However, NMR-SIM and NMR-GUIDE will not run without a valid license.

   ICON-NMR is always used in connection with TOPSPIN and does not need an individual license.

   AURELIA, AMIX, MAXENT, GLP and PARAVISION do need a license which must be ordered for each program separately.

2. Which license types are available and what programs may be run with each?

   There are six different license types, details of each are given in the following table. For more information please refer to the Bruker license order page on the web server:

   https://www.bruker-biospin.de/NMR/nmr-softw/licenses/index.html
or contact your local Bruker BioSpin representative.

<table>
<thead>
<tr>
<th>License type</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full</td>
<td>Acquisition, Processing, Automation (ICON-NMR), Plotting, Experiment Simulation and NMR-Guide</td>
</tr>
<tr>
<td></td>
<td>license period: 15 years</td>
</tr>
<tr>
<td>Demo</td>
<td>Acquisition, Processing, Automation (ICON-NMR), Plotting, Simulation and NMR-Guide</td>
</tr>
<tr>
<td></td>
<td>license period: 3 months</td>
</tr>
<tr>
<td></td>
<td>Node locked, uncounted, free of charge</td>
</tr>
<tr>
<td>Processing-Only</td>
<td>Processing and Plotting</td>
</tr>
<tr>
<td></td>
<td>license period: 15 years</td>
</tr>
<tr>
<td></td>
<td>no Acquisition, no NMR-SIM, no NMR-GUID</td>
</tr>
<tr>
<td>Presenter</td>
<td>Viewing and Plotting</td>
</tr>
<tr>
<td></td>
<td>license period: 15 years</td>
</tr>
<tr>
<td></td>
<td>no Acquisition, no Processing, no NMR-SIM, no NMR-GUID</td>
</tr>
<tr>
<td>Teaching</td>
<td>NMR-SIM and restricted Processing and Plotting</td>
</tr>
<tr>
<td></td>
<td>license period: 15 years</td>
</tr>
<tr>
<td></td>
<td>TopSpin can only process datasets created with XWIN-NMR ≥ 3.1 that are older than 4 weeks or datasets created by NMR-SIM. One TopSpin-plot session (without portfolio editor) can be started, Node locked, count 1.</td>
</tr>
<tr>
<td>Developer</td>
<td>Special license for extending TOPSPIN with own functionalities.</td>
</tr>
<tr>
<td></td>
<td>Allows viewing of data</td>
</tr>
<tr>
<td></td>
<td>license period: unlimited</td>
</tr>
<tr>
<td></td>
<td>no Acquisition/Processing/Plotting/NMR-SIM/NMR-GUID, free of charge</td>
</tr>
</tbody>
</table>

3. **What kind of licenses do I need?**

If you want to use TopSpin 1.x you need a FEATURE line ‘TOPSPIN1’ in your license.dat file. If you have ‘XWIN/NMR3’ you can only start XWIN-NMR 3.x.

If more than one license is available, as many copies of the program as are cov-
4. Which licensing program is used for TopSpin?

The Flexlm license manager is used and is delivered on the TopSpin DVD. The Flexlm package occupies about 3 MByte of disk space. It contains the 'bruker_lmgr' license manager, the 'lmutil' program, Help files and example license.dat file.

5. What are the requirements for the Flexlm to function?

Your PC must have an Ethernet card

6. What is a Floating license?

Floating licenses are licenses that are available for more than one computer in a network. Floating licenses are issued based on the Host-ID of one particular computer. This computer becomes the 'license server'. All computers that can communicate with this 'license server' computer can use the licenses managed by this computer. For this to work, the same license file must be installed on all participating computers, including the 'license server'. The Flexlm license manager software must only run on the 'license server' computer.

A Floating license can have just one license for a program like TopSpin. In such a case, the respective program can be started once on one computer in the network. If more than one license is available, as many copies of the program as are covered by the license can be started simultaneously. For example, if you have a license file with 5 licenses for TopSpin, TopSpin can be started 5 times from any 5 computers in the network.

The number of licenses is stated in the FEATURE for the respective program.

7. What is the difference between 1-Server / 3-Server Licenses?

Floating licenses can be ordered as 1-server or 3-server licenses. In a 1-server license you have only one license server, and in a 3-server license there are three license servers defined in the license file.

- The advantage of a 1-server license is that it is only necessary to have one computer active at a time to make the license available.
- The advantage of a 3-server license is that any of the three license servers can be inactive and the license management is then done by the remaining two servers.
- One requirement for the three license servers is that all of them have TCP/IP active.
The operating system on the three computers can be the same or can be different (Linux, Windows).

8. **What is a Node Locked license?**

A node-locked license allows you to start the respective program only on the computer with the Host-ID for which that license was generated. Typically, this license form is used for Demo and Teaching licenses. No other computer can use the license in the way described above for floating licenses.

9. **How do I know if my license is Floating or Node Locked?**

You can recognize this from the syntax of the license FEATURES in the license.dat file:

```
/usr/local/flexlm/Bruker/licenses/license.dat
```

If the entry `HOSTID=` appears after the encrypted password, the license is Node locked and can only be used on the local PC.

```
FEATURE TOPSPIN1 bruker_1s 0.0 6-aug-2018 3 9B1EA0113CD53A883974 HOSTID=006008d244fe vendor_info=....
```

→ **Node locked** license for three parallel sessions of TopSpin that can be started on the local PC

```
FEATURE TOPSPIN1 bruker_1s 0.0 6-aug-2018 3 9B1EA0113CD53A883974 vendor_info=....
```

→ **Floating** license for three parallel sessions of TopSpin that can be started on every PC in the local network

10. **If I have a Floating license and I have a dual-boot PC (e.g. Windows XP and Linux), can I use the license on both operating systems?**

Yes, the license is based on the physical address of the Ethernet card and not on the operating system. Copy the license file `license.dat` to:

Windows:

```
c:\flexlm\Bruker\licenses\license.dat
```

Linux:

```
/usr/local/flexlm/Bruker/licenses/license.dat
```

11. **How can I determine the hostid of my PC?**

See chapter 5.2.2.

12. **How do I install a license (full or demo) on my PC?**

See chapter 5.2.

13. **Does a Demo license require SERVER/DAEMON lines in license.dat?**
No, a Demo license is Node Locked uncounted and therefore only requires FEATURE lines. If SERVER and/or DAEMON lines exist, they are ignored.

14. I have a Floating license. Must the file license.dat be identical on all hosts, server and clients?
Yes, you have to install the license.dat on the server and copy it to all clients.

15. Must the Flexlm license manager run on all hosts in the network?
No, it only needs to run on the license server. If the license manager also runs on a license client, this is simply ignored.

16. Must the Flexlm license manager run on a host with a Demo license?
No, it only needs to run on the server for counted licenses, a demo license is uncounted.

17. What can I do if TOPSPIN does not start after I installed the license?
See chapter 12.1

18. How is it possible that TOPSPIN starts even though I do not have a license?
If you do not have a license for TOPSPIN, it will start up in an emergency mode if your PC is connected to a spectrometer. Also one TOPSPIN PLOT EDITOR session (without portfolio editor) can be started from within TOPSPIN. However, NMR-SIM and NMR-GUIDE will not run without a valid license.

19. What can I do if TOPSPIN cannot find the license server?
Please try to restart the license server:

```
    service bruker_lmgr start
```

5.2 Ordering and installing the TOPSPIN license

5.2.1 Ordering a license

You can order a license from Bruker BioSpin Germany. Demo licenses are free of charge, for other licenses you must specify your order number.

Licenses can be ordered from the German Bruker BioSpin web server:

```
    https://www.bruker-biospin.de/NMR/nmr-softw/licenses/index.html
```
5.2.2 How do I determine the correct hostid

The hostid is a 12-digit hexadecimal number. It is the physical address (also called Mac address or Node address) of the Ethernet card. After installing TopSpin, including the Flexlm license manager, you can determine the hostid in two ways:

- Start TopSpin; a command prompt will pop up, which will list the hostid, if no licence.dat file is available.
- Open a Linux shell and enter:
  
  ```
  /sbin/ifconfig eth0
  ```
  
  take the numbers of the HWaddr.

5.2.3 Installing a Demo license

A Demo license can be installed as follows:

1. Log in as Administrator
2. Install the Flexlm license manager as described in chapter 4.3
3. Open a Linux shell and enter:

   ```
   kedit /usr/local/flexlm/Bruker/licenses/license.dat
   ```

   enter the FEATURE lines, save and exit the file

5.2.4 Installing a full license on a license server

The Flexlm license manager must always be installed and run as a service on the license server. It is delivered on the TopSpin DVD and can be installed as described in chapter 4.3. In case the license file identifies the PC as license server, Flexlm is automatically installed as a service which is then automatically started during boot time

On the license server, the file license.dat must contain a SERVER line, a DAEMON line and FEATURE lines. An example would be:

```
SERVER tulip 0060080e830d 1700
DAEMON bruker_ls /usr/local/flexlm/Bruker/bruker_ls
FEATURE TOPSPIN1 bruker_ls 0.0 6-aug-2018 3 0B0E4011FF0CD2FBFF1 \ vendor_info=" for hostid(s) : 0060080e830d" ISSUER=00047573d35e
FEATURE TOPSPIN_1D bruker_ls 0.0 6-aug-2018 3 9B3EA0218829E2716A \ vendor_info=" for hostid(s) : 0060080e830d" ISSUER=00047573d35e
FEATURE TOPSPIN_2D bruker_ls 0.0 6-aug-2018 3 AB3E80014D54FB3887 \```
The TOPSPIN license

where *tulip* is the hostname and *0060080e830d* the hostid of the computer. Note that the second part of the FEATURE lines, the vendor_info, does not necessarily exist. In that case a FEATURE line would look like:

```
FEATURE TOPSPIN1 bruker_ls 0.0 6-aug-2018 3 0B0E4011FF0CD32FBFF1"
```

To inform Flexlm about the new license enter in a Linux shell:

```
/usr/local/flexlm Bruker/lmreread -c /usr/local/flexlm Bruker/licenses/license.dat
```

### 5.2.5 Installing a full license on a license client

On a license client, license can be installed in two different ways, as described for a Demo license chapter 5.2.3. The only difference is that you do not have to setup a new file *license.dat*. You can just copy it from the license server which can be another PC (see question 10 in chapter 5.1).

### 5.2.6 Modifying the license file

If you have modified a license file, you have to inform Flexlm about the modified license with the command:

```
/usr/local/flexlm Bruker/lmreread -c /usr/local/flexlm Bruker/licenses/license.dat
```
Chapter 6
Configuration of TOPSPIN

The idea of this chapter is to give you some guidelines to full spectrometer or workstation configuration. We do not discuss the commands in detail here. For a full description refer to the TOPSPIN manual.

6.1 Take over the configuration of XWIN-NMR/TOPSPIN into TOPSPIN 1.3

The decision how to install TOPSPIN is very important in case you have already XWIN-NMR or TOPSPIN installed on the same or another PC. If so, you might want to take over the configuration of a previous XWIN-NMR/TOPSPIN into TOPSPIN 1.3 because of:

- in case the XWIN-NMR installation was used for controlling a spectrometer there are very important configuration files like the spectrometer configuration, shim files, your own pulse programs, parameter sets, etc.
- if XWIN-NMR was used for processing only there can be also very important configuration files like AU programs, macros, plot layouts etc.

Note: Transferring files could cause permission problems especially if they are transferred from one PC to another.
6.1.1 You have a XWIN-NMR configuration that you like to use for TopSpin (on the same PC)

You can take over the configuration during the Installation of TopSpin 1.3 (see chapter 4.3) or after the installation with the AU program nmr_save.

During the installation you will be asked if you want to import a spectrometer configuration. If you want to take over the configuration after installation is finished, start TopSpin

- and type in the command:
  
  nmr_save

- or click

  Options → Spectrometer Tools → Save/Restore configuration

A window 'Password request' will appear. Please enter the NMR administration password and click OK.

A window 'NMR_Save' appears.

- Accept or modify the 'Location of Backup file' (default: <TOPSPIN-HOME>nmr_backup).
- Enter the location of the installation to be saved (e.g. /opt/xwinnmr).
- Click on Save.

This will create a tar file of all necessary information from the TopSpin installation. The tar-file is called nmr_backup.tar and will be stored in the directory you selected.

To take over this information into TopSpin, start nmr_save again and ...

- Make sure that 'Location of Backup file' contains the correct path to your backup file
- Make sure that the restore destination is correct (previous settings might be overwritten in the restore destination!)
- Click on Restore.

After this process is finished, execute cf.

If you like to get more information about the command nmr_save refer to chapter 6.6
6.1.2 You have a XWIN-NMR configuration that you like to use for TOPSPIN (on another PC)

Before you start installation of TOPSPIN on PC-A you have to copy the two directories:

\(<xwinnmrhome>/conf\) and \(<xwinnmrhome>/exp\)

from the XWIN-NMR installation on the PC-B into the directory where TOPSPIN will be installed. The default installation directory of TOPSPIN is for Linux:

\(/opt/topspin\)

In case you will use the default installation path you have to create these directories and as a second step copy the two directories \(conf\) and \(exp\) into them. After these two directories are available on PC-A you can start the TOPSPIN installation.

6.2 Configuring TOPSPIN

There are two ways to start TOPSPIN:

1. Click the icon TOPSPIN on the desktop
2. Click Start → All Programs → Bruker TOPSPIN → TOPSPIN<vers.>

After the first startup of TOPSPIN you have to configure the software (depends on the hardware of your spectrometer). If you do this, you are mainly in one of the four following situations:

- You have installed the new software on the same PC as a previous XWIN-NMR/TOPSPIN installation, so the old spectrometer configuration is available on the same PC → go to chapter 6.2.1
- You want to configure a processing-only PC like your spectrometer PC, so you have the spectrometer configuration on another computer → go to chapter 6.2.2
- You have to configure the software on a new hard disk without a backup of the spectrometer configuration, so you have no configuration files anymore → go to chapter 6.2.4
- You have a new spectrometer hardware component, so you have no configuration file so far → go to chapter 6.2.5
6.2.1 If your PC controls a spectrometer

1. Be sure that the spectrometer is booted (see chapter 9.3.0.3 and 12.3.4.2)
2. Open a dataset
   • Type \texttt{new} and create a new dataset.
   • You can also select a dataset (e.g. \texttt{examld\_1H}) acquired with another
     TopSpin or XWin-NMR version.
3. Enter \texttt{cf} (The command \texttt{cf} now configures the software according to the
   hardware of your spectrometer):
   a) A window will appear:
      \begin{center}
      \textit{Password request. Please enter the NMR ADMINISTRATION PASSWORD}
      \end{center}
      Type in the NMR ADMINISTRATION PASSWORD. Click \texttt{OK}.
   b) A window \texttt{Cf} will appear:
      \begin{center}
      \includegraphics[width=0.5\textwidth]{cf_window.png}
      \end{center}
      Most likely you will select an existing configuration and press \texttt{Edit} to
      confirm this configuration.
   c) A window will appear:
      The selected configuration is displayed. Choose the type of your spectrometer e.g. \texttt{AVANCE} \rightarrow \texttt{ENTER}. Check or type in the 1H frequency of
      the magnet e.g. \texttt{500.13} \rightarrow \texttt{ENTER}. Use the debug mode only in a case
of trouble-shooting.

d) A window will appear:

Specify the channel to which external devices are connected. The RS232/485 channel for external devices
Table appears.

Check if the tty-numbers of the hardware components are set correctly.

e) A window will appear:

Additional configuration. Security check. Enable peak power check (POWCHK). Enable puls power check (PUL-
CHK).

Choose the options if you need this security options.

f) Only if you have a sample changer! A window will appear:

Should the Sample Changer control the Lift? (yes/no)

The answer depends on how the air flow is connected, normally you will answer: **yes → ENTER**
In this cases the question appear:

*Delay between SX and next command [sec]?

Type in the length of the delay e.g. 10 → ENTER

g) The nuclei-table appear.

Check if the frequency of the nuclei are set correctly. If in doubt click *Restore* then click *Save*

h) The results of *cf* appears in a text window. Check this list carefully and compare the result with an list from an earlier configuration (if available) click *Print* and store the paper output with your other spectrometer documentation, then click *OK*. *These data are saved in uxnmr.info.*

! **If during *cf*’ an error message occurs that invites you to do a firmware update see chapter 6.3**

After finishing *cf* the window *configure* will appear showing a list of configuration steps. Accept the default selection and click *Start* (You will be asked for the NMR ADMINISTRATION PASSWORD a couple of times):

- Continue with *expinstall*
a) Type in the NMR ADMINISTRATION PASSWORD and ENTER
b) Click Next if you either have no modified Bruker BioSpin-Parameterfiles,

AU-programs and Pulse-programs (If you have some, you have to archive them in a different directory before executing `expinstall`). Your individual Parameterfiles, AU-programs and Pulse-programs that have different names to the original Bruker BioSpin files will not be destroyed during the installation
c) In the window that appears → Check Installation for Spectrometer → Click Next
d) In the window that appears → Check *High Resolution Systems* → Click *Next*

![High Resolution Systems selection dialog](image)

c) In the dialog box that appears → Select the spectrometer configuration name → Click *Next*

![Spectrometer configuration dialog](image)

In the dialog box that appears → Check the items you want to install or, accept the default selection → Click *Next*
f) In the dialog box that appears → Select the default printer and plotter and the desired paper format → Click Next

![Image of dialog box]

- Select your printer:
  - Default printer: HP LaserJet 1200 Series PCL 6
- Select your plotter:
  - Default plotter: HP LaserJet 1300 Series PCL 6
- Select the plotter paper format:
  - Paper format: Letter/Legal

![Image of dialog box with selections]

g) In the window that appears → Enter the desired spectrometer frequency, acquisition mode and pre-scan-delay or, accept the default values

![Image of window]
→ Click Next

h) In the information box that appears → Check the configuration selection and, if it is correct → Click Finish

While `expinstall` is running you can go ahead with the other configuration commands.
• Continue with **edsolv**

<table>
<thead>
<tr>
<th>Solvent</th>
<th>Description</th>
<th>Reference Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASMe</td>
<td>AMe Solution</td>
<td>(86)</td>
</tr>
<tr>
<td>ACNo</td>
<td>ACN Solution</td>
<td>(86)</td>
</tr>
<tr>
<td>CDCl3</td>
<td>Chloroform-d</td>
<td>(86)</td>
</tr>
<tr>
<td>CDBr3</td>
<td>Bromoform-d</td>
<td>(86)</td>
</tr>
<tr>
<td>CDI</td>
<td>1,1,1-trifluoro-1,2,2-trichloroethane</td>
<td>(86)</td>
</tr>
<tr>
<td>DMSO</td>
<td>Dimethyl sulfoxide</td>
<td>(86)</td>
</tr>
<tr>
<td>DMSO-D6</td>
<td>Dimethyl sulfoxide-d6</td>
<td>(86)</td>
</tr>
<tr>
<td>DMSO-D8</td>
<td>Dimethyl sulfoxide-d8</td>
<td>(86)</td>
</tr>
<tr>
<td>DMSO-D16</td>
<td>Dimethyl sulfoxide-d16</td>
<td>(86)</td>
</tr>
<tr>
<td>DMSO-D18</td>
<td>Dimethyl sulfoxide-d18</td>
<td>(86)</td>
</tr>
<tr>
<td>DMSO-D30</td>
<td>Dimethyl sulfoxide-d30</td>
<td>(86)</td>
</tr>
</tbody>
</table>

Check the list of lock solvents and click **Save** if it is correct → Click **Close**

• Continue with **edhead**

Select the current probe, click the button **Define as current probe** → Click **Exit**
• Continue with edprosol

Check the parameters for your favorite nuclei, change them and calculate them, if necessary → Click Save to store to disk → Click Exit

• Continue with edlock
Check the lock table values (field, lock phase, ...), change them and click **Save** if necessary, otherwise click **Abort**

- Continue with **edscon**

Check the spectrometer constants, change it and click **Save** if necessary, otherwise click **Cancel**

After **cf**, **expinstall**... have finished, insert a sample and make sure that you can lock on the lock solvent. Type **ii** and read with **rpar** a standard proton parameter file, type **getprosol** and **rga** and collect a normal $^1$H NMR spectrum.

### 6.2.2 If you want to configure a processing-PC like your spectrometer-PC:

If the PC does not control a spectrometer but is used in connection with a particular spectrometer, e.g. for setting up experiments, processing and or plotting, you should configure it as that spectrometer (see FAQ 210 on [www.bruker-biospin.de](http://www.bruker-biospin.de)): for example the spectrometer is an AV300 configured with the name ‘av300’. Do the following:

a) Copy the configuration directory ‘<TOPSPINHOME>/conf/instr/av300’ from the spectrometer AV300 to the workstation.

b) On the workstation paste this ‘av300’ directory to ‘<TOPSPINHOME>/conf/instr’.

   (most likely this is the path: /opt/topspin/conf/instr)

c) Start TopSpin as normal user.

d) Perform **expinstall** as follows:

   Type in the command line **expinstall** or

   Click **Open** → **Setup** → **Experiment Installation** [**expinstall**]

e) Type in the NMR ADMINISTRATION PASSWORD and **ENTER**
f) In the appearing information box → Click Next if you either have no modified Bruker BioSpin-Parameterfiles, AU-programs and Pulse-programs (If you have some, you have to archive them in a different directory before executing `expinstall`). Your individual Parameterfiles, AU-programs and Pulse-programs that have different names to the original Bruker BioSpin files will not be destroyed during the installation.

![Information Box Screenshot]

CAUTION
Please archive all your MODIFIED Bruker PARAMETER-files, AU-programs and PULSE-programs.

CAUTION
Please archive all your MODIFIED Bruker PARAMETER-files, AU-programs and PULSE-programs.

![Information Box Screenshot]

Signage

- [ ] Installation for Datastation (Default)
- [x] Installation for Datastation (Customize)
- [ ] Installation for Spectrometer

g) In the appearing window → Check Installation for Datastation (Customize) → Click Next
h) In the appearing window → Check *High Resolution Systems* → Click **Next**

![Image](image1.png)

i) In the appearing dialog box → Select the spectrometer configuration name → Click **Next**

![Image](image2.png)

j) In the appearing dialog box → Check the items you want to install or, accept the default selection → Click **Next**

![Image](image3.png)
k) In the appearing dialog box → Select the default printer and plotter and the desired paper format → Click Next

l) In the appearing window → Enter the desired spectrometer frequency, acquisition mode and pre-scan-delay or, accept the default values → Click Next
m) In the appearing information box → Check the configuration selection and, if it is correct → Click **Finish**

![Configuration dialog box](image)

The installation of the selected items, will start now. Wait until this process has finished.

For more details on `expinstall`, please refer to the description of this command in the Acquisition Reference manual.

### 6.2.3 If you want to use a default configuration on a datastation

A default configuration can be used on a datastation. It is automatically performed (no `cf` required) during the installation of TopSPIN on a new computer, a new disk or in a new TopSPIN installation directory. The default configuration name is `Bruker_default_av500` and corresponds to an Avance 500 MHz spectrometer.

For manual or interactive data processing, the automatic default configuration is sufficient. If, however, you want to use AU programs, you must execute `expinstall` once, selecting **Installation for Datastation (Default)**.

### 6.2.4 If you do not know the configuration of your spectrometer

If you do not have any spectrometer configuration information, e.g. after a head-crash, then you have to recreate the configuration information.
In this situation there are two possibilities:

a) your spectrometer has a standard configuration

b) your spectrometer has a non-standard configuration

Case a)

If your spectrometer has a standard configuration, then you can easily do \texttt{cf} and if you give the correct information for the 'Type of Spectrometer' you will get the correct list of your hardware in the 'RS232 table'. You only have to type in the correct tty's of the interfaces.

Case b)

If your D*X spectrometer has a non-standard configuration, then the hardware configuration is read during the \texttt{cf} from the file 'hardware_list' file in the directory

\texttt{<TOPSPINHOME>/conf/instr/<spectrometer-name>}

TopSpin 1.3 offers the default file 'hardware.exam' which contains a list of all available hardware components which are important for the \texttt{cf} command. This file was generated in XWIN-NMR with the command \texttt{cf makelist}, now it is available in:

\texttt{<TOPSPINHOME>/conf/instr}

- Open this file with a text editor, e.g. kedit, and delete all lines except those that describe the hardware components of your spectrometer. You can get this information in the following way:
  
  Check the list in the file 'hardware.exam' with the components of your spectrometer and/or with the Bruker BioSpin delivery note(s). Please carefully check the PN-C/D/E and ECL numbers of the components

- \texttt{Save and exit} from 'hardware.exam'
- Copy the modified file 'hardware.exam' into the directory
  
  \texttt{<TOPSPINHOME>/conf/instr/<spect>}

- Rename the file
  
  \texttt{<TOPSPINHOME>/conf/instr/<spect>/hardware.exam to}
6.2.5 If you added a new hardware component to your spectrometer

If you want to add a new hardware component it is recommended to order somebody of your local Bruker BioSpin office to do this for you.

If you have to add a new hardware component to the configuration file of the software, do the following:

TOPSPIN 1.3 offers the default file ‘hardware.exam’ which contains a list of all available hardware components which are important for the cf command. This file was generated in XWIN-NMR with the command cf makelist, now it is available in:

<TOPSPINHOME>\conf\instr\spect/hardware_list

- Open this file with a text editor, e.g. kedit, and search and copy these line(s) that describe the new hardware component(s). Please carefully check the PN-C/D/E and ECL number(s) of the component(s).

- Copy the file
  <TOPSPINHOME>/conf(instr/spect/hardware_list to
  <TOPSPINHOME>/conf/instr/spect/hardware_list_sav

- Open the file
  <TOPSPINHOME>/conf/instr/spect/hardware_list

and paste the new entries to the correct positions.

6.3 Firmware update of the spectrometer hardware

This chapter describes how to update the firmware of certain spectrometer components. This is only necessary if the cf command has crashed and popped up a message window which informs that you have to do a firmware update of a component.

It is strongly recommended to do the firmware update only in this case, because the hardware component could get unusable if the update would be done incorrectly.
If you answer the question about the setting of the default path during the installation of the NMR Suite with yes, you can start the following service tools in a shell by typing their names:

- acb
- bsms
- grad
- hpcu
- hppr
- rx22

If you answer no you have to type in the name with the entire path:

<TOPSPIN_HOME>/prog/bin/scripts/<service-tool-name>

The following example shows the check of the bsms service tool with the entire pathname:

1. Open a shell
2. Type <TOPSPIN_HOME>/prog/bin/scripts/bsms
   - An automatic interactive procedure starts in this shell
3. Type y → ENTER
   - A dialog comes up in the shell
4. To check and eventually download a new firmware (from TopSpin) type
   2 → ENTER
5. The check starts and produce some messages e. g.:
   - if there is a problem with a component you get an information to contact your service office
   - if you need a firmware update you will get a message together with the length of time for the download. It is recommended to do the download as soon as possible.

During the download it is absolutely necessary that spectrometer and workstation are not disturbed! Make sure that no one pulls a cable out of the spectrometer or will crash the Linux system while using it in parallel! (Yes we know this seems very improbable, but if the download would
crash, your board might be unusable afterwards)

6. press \texttt{y} \rightarrow \texttt{ENTER} to start the download

A 'normal' error during downloading the new firmware (you will see a comment in the shell) requires to do the download once again!

If you have done a download of newer firmware, you have to do \texttt{cf} again!

If you do not need any downloads, you can follow the instructions in the command prompt to exit this tool.

6.4 Configuring the BSMS-Keyboard

For a full description how to configure the BSMS-Keyboard see your

• hard copy of \textit{BSMS-User Manual} or

• the respective entry on the BASH CD (Order Number Z36541)

A configuration step that should be done periodically is the spin rate calibration. For this you have to enter the \texttt{Menu} mode of your BSMS keyboard:

 press simultaneously \texttt{2nd} and \texttt{Y}3, then rotate the control knob as long as you see

1.\texttt{Sample} in the display, press \texttt{2nd} to go into this directory. The display will show 1.1 \textit{Spin calib}. press \texttt{2nd} to start this process and wait for \(\sim 3\) minutes.

 In this Menu mode, you can also define the helium warning level. If the liquid helium reaches the critical point, the BSMS-Keyboard starts beeping. A special password, the so called security code, is required to be able to change the setting. If in doubt about the setting, contact your service representative.

 For an additional possibility to get a warning about a low helium level see chapter 16.1.

6.5 A log of the entire system configuration

The \texttt{showconf} command provides you with various information about your hardware and software, both of the PC and of the spectrometer. Here is how showconf works: You type \texttt{showconf} in a shell - and wait the about 2 minutes until it has finished. After that showconf has produced a file called \texttt{confout} that contains all you need. \texttt{Confout} is located in your home directory. The size of this report is
usually less then 100 kbytes.

**DO KEEP A COPY OF THIS FILE IN A SAFE PLACE!**

### 6.6 Backup of VIFs (=Very Important Files) with nmr_save

It is not only necessary to create some backups for the operating system like Boot Disks and to store the acquired datasets.

It is strictly recommended to create a frequently backup of the 'VIFs’ - the 'Very Important Files’ of the configuration of TopSPIN.

There are many reasons like e. g. head crash or theft of the hard disk that makes it important that a weekly or monthly backup is made of important data, so that you would be able to restore the spectrometer configuration in a very short time.

TopSPIN offers an AU program¹ (*nmr_save*) for saving those important files that are not delivered by Bruker. This AU program can save and extract user specific data from the TOPSPINHOME directory and puts them into a tar-file. Files that start with an "." are ignored.

The AU program can be started as follows:

- Start TopSPIN and type in the command: 
  `{nmr_save}`
- or click 
  `Options → Spectrometer Tools → Save/Restore configuration`

A window 'Password request' will appear.

![Password request window](image)

Please enter the NMR administration password and click **OK**.

---

1. Bruker also offers a script (*xwinnmr.save*) which can be used for saving the 'VIF’s (see chapter 16.2).
A window 'NMR_Save' will appear.

Accept or modify the 'Location of Backup file' (the default is: <TOPSPIN-HOME>/nmr_backup). Enter the location of the installation which should be saved, select the respective spectrometer configuration and click on Save.

This will create a tar file of all necessary information from the selected installation/spectrometer configuration. The tar-file is called nmr_backup.tar and is stored in the directory:

<TOPSPINHOME>/nmr_backup

Files and directories will be saved into the special tar-file nmr_backup.tar which is, by default, in the directory TOPSPINHOME/nmr_backup.

The following directories are saved completely (hidden files are ignored!):

<TOPSPINHOME>/exp/stan/nmr/lists/group/
<TOPSPINHOME>/exp/stan/nmr/lists/scm/
<TOPSPINHOME>/exp/stan/nmr/lists/bsms/
<TOPSPINHOME>/exp/stan/nmr/lists/mac/
<TOPSPINHOME>/exp/stan/nmr/lists/f1/
<TOPSPINHOME>/exp/stan/nmr/lists/ds/
<TOPSPINHOME>/exp/stan/nmr/py/
<TOPSPINHOME>/prog/server/
<TOPSPINHOME>/conf/instr/probehead/
<TOPSPINHOME>/conf/instr/<spect>/prosol/
<TOPSPINHOME>/conf/instr/<spect>/cortab/
<TOPSPINHOME>/conf/instr/<spect>/inmrusers/
<TOPSPINHOME>/conf/instr/autoshim/refmaps/
<TOPSPINHOME>/data/final/nmr/protocolfiles/
<TOPSPINHOME>/QTP/

<spect> represents the current spectrometer name or the name specified explicitly when <nmr_save> is started.

From the following directories every file is saved that does not belong to the genuine Bruker distribution:
<TOPSPINHOME>/exp/stan/nmr/lists/pp/
<TOPSPINHOME>/exp/stan/nmr/lists/cpd/
<TOPSPINHOME>/exp/stan/nmr/lists/gp/
<TOPSPINHOME>/exp/stan/nmr/lists/wave/
<TOPSPINHOME>/exp/nmr/au/scl/
<TOPSPINHOME>/exp/nmr/au/src/
<TOPSPINHOME>/exp/nmr/par/
<TOPSPINHOME>/plot/layouts/
<TOPSPINHOME>/prog/tcl/xwish3_scripts/

Additionally, the following files are also saved:
<TOPSPINHOME>/conf/instr/<spect>/uxnmr.par
<TOPSPINHOME>/conf/instr/<spect>/uxnmr.info
<TOPSPINHOME>/conf/instr/<spect>/specpar
<TOPSPINHOME>/conf/instr/<spect>/2Hlock
<TOPSPINHOME>/conf/instr/<spect>/nuclei
<TOPSPINHOME>/conf/instr/<spect>/best-nmr/CurrPushSolvent
<TOPSPINHOME>/conf/instr/<spect>/best-nmr/hardware.par
For safety reasons the tar-file will not be replaced by executing `nmr_save` once again. So if you like to use this AU program several times, you have to move the `nmr_backup.tar` file from the directory `<TOPSPINHOME>/nmr_backup` on a backup medium (floppy, CD ...) and then start the script once again or you have to select the 'Overwriting existing backup file' option.

Example for transferring configuration information from a XWIN-NMR installation in `/opt/xwinnmr` and the spectrometer configuration 'spect' into a TopSpin installation in `/opt/topspin`:

1. This is the environment variable for the license file, in a default installation this is: `/usr/local/flexlm/Bruker/licenses/license.dat`
Backup:

If 'nmr_backup.tar' does not exist in the backup directory, the backup file 'xwin_backup.tar' will be taken (if existing). After this process is finished, execute `cf`.

Restore:
Chapter 7
Plotting and Printing with TopSpin

7.1 Printing / plotting data

7.1.1 Plotting and printing
Under RED HAT ENTERPRISE LINUX WS 3, all common printer drivers can be used for plotting and printing. When a printer is installed under RED HAT ENTERPRISE LINUX WS 3, it can be used for plotting from TopSpin and TopSpin Plot Editor.

7.1.2 Print/Plot from the Menu
The current data window can be printed as follows:
1. From the TopSpin menu:
   • Click the print button in the upper toolbar
   • or Click File → Print
   • or Enter print or Ctrl-p
All these actions are equivalent; they open the Print dialog box.

2. In the Print dialog box:
   a) Select **Print active window [prnt]**
   b) Click **OK**

Before printing starts, the operating system print dialog box will appear to select e.g. the printer and printer properties.

The Print dialog box contains two further options:

- **Print with layout - start Plot Editor [plot]**
  If you select this option and click OK, the Plot Editor will be started. This option is equivalent to entering `plot` on the TopSpin command line.

- **Print with layout - plot directly [autoplot]**
  Selecting this option activates the Plot Editor layout list box. Select the desired layout and click **OK** to print. Standard layouts are delivered with TopSpin. They use the Windows default printer. User defined layouts use the printer defined in the TopSpin Plot Editor. On a 1D dataset, only 1D layouts are listed, on a 2D dataset only 2D layouts are listed etc.

For each of the last two options one of the following parameters is required.

* **Use plot limits:**
  - from screen/ CY

   The plot limits and maximum intensity are used as they are on the screen.
(processing parameter F1P, F2P and CY, respectively)

- **from Plot Editor Reset Actions**
  The plot limits and maximum intensity are set according to the TopSpin Plot Editor Reset Actions (right-click inside the TopSpin Plot Editor data field and choose Automation to set the Reset Actions).

- **as saved in Plot Editor**
  The plot limits and maximum intensity are set according to the specified layout

**Fill dataset list:**

- **from your default portfolio**
  The portfolio contains the current TopSpin dataset plus the data from the default Plot Editor portfolio

- **from portfolio saved in dataset**
  The portfolio contains the current TopSpin dataset plus the data from the portfolio stored in this dataset

### 7.1.3 Plot data from the Processing guide

Printing/plotting data can be done from the Processing guide by clicking the *Plot/Print* button. If *Automatic mode* is checked, the active data window will be printed as it appears in the screen. If *Automatic mode* is unchecked, you will get the dialog box.

### 7.1.4 Plot data with the TopSpin Plot Editor

Although the *print* command allows you to use or start the TopSpin Plot Editor, you can also start it from the command line (enter *plot*). This will open the TopSpin Plot Editor from which you can create layouts and plot data. The complete TopSpin Plot Editor functionality is described in its online manual that can be opened from the TopSpin Plot Editor Help menu.

### 7.1.5 Store (Export) a Data Window as Graphics File

The clipboard and metafile formats are resizable vector formats. In addition to this, TopSpin allows you to save the contents of a data window in a graphics file of selectable type, e.g. .png, .tif, .wmf etc. To do that:

1. Click *Edit → Export*
2. Navigate to the storage folder
3. Enter the destination filename and extension
4. Click Export

The resolution of such a screen dump equals the resolution of your screen. When you import a graphics file into another program, you may lose information when resizing the graphics.

7.1.6 TopSpin Plot Editor

1. TopSpin Plot Editor uses the printer driver system of the operating system for any printer output. This means that any printer for which a system driver is correctly installed can be selected as print device. Note that the printer name in a layout file written by the Windows XP version is probably not known by the Linux version of TopSpin Plot Editor because of the different printer handling. Apart from that, layout files can be freely interchanged between the two platforms.

2. TopSpin Plot Editor for Linux offers an internal Clipboard. You can copy objects from one Plot Editor window into another by using copy and paste.

3. Another way of exporting graphics is the menu option 'File/Print' which allows you to print the complete layout into a file. The format can be chosen from a list (e.g., PostScript, Eps, PDF, JPEG, PCX, PNG or TIFF). Most current graphical-oriented windows applications can import this format. This provides a convenient way of importing TopSpin Plot Editor graphics into programs like Word or Powerpoint.

4. With the TopSpin Plot Editor you can directly send your current plot as Email. Just click File → Send and TopSpin Plot Editor will pop-up your default mail client and add the current plot as an EMF attachment.
Chapter 8
User Management

8.1 Adding a new user account

If you want to add a new user and this new user already exists on other hosts in the network, make sure that you use the same User ID and User Name on all hosts in the network. It is also useful to use the same Group ID and Group Name, especially, if you want to mount directories via NFS between IRIX and Linux systems.

Perform the following steps:

1. Click <red hat> → System Settings → User and Groups
2. If you are not logged in as root, a window run as root - KDE su will appear
   • enter root password

1. The default configurations of a new user are copied from /etc/skel/ into the home directory of the new user. If you want to change the default informations, e.g. by adding an icon that starts TOPSPIN copy the respective file into /etc/skel/
3. A window *KDE User Manager* will appear:

![KDE User Manager](image)

- Click *Add User*

4. A window *Create New User* will appear

![Create New User](image)

- Enter the new *User Name*
- Enter *Full Name* of the new user
- Enter and confirm the *password*
- Make sure that *Create home directory* is enabled and that a legal path is entered in the field *Home directory*. The default /home/ will create the home directory:
User Management

/home/<USER_NAME>

- The field **Create a private group of this user:**
  a) enabled (default):
  
  This configuration in conjunction with the default umask (002) will lead to the situation, that only the user is able to write in those files he created with the TopSpin. That means no other user could work with his spectroscopic data.
  
  b) disabled:
  
  New user will be assigned to the group **users**
  
  This configuration in conjunction with the default umask (002) will lead to the situation, that the user and all members of the group **users** are able to write in those files he created with the TopSpin. That means all other users of his/her group can work with his spectroscopic data.

- Enable the field **Specify user ID manually if necessary (see introduction of this chapter) and type in the desired ID of the new user**

- click **OK**

**8.1.1 Change group membership of an existing user**

1. Click **<red hat> → System Settings → Users and Groups**

2. If you are not logged in as root, a window **run as root - KDE su** will appear

   • enter root password

3. A window **KDE User Manager** will appear:

   • Click on an existing user and click on **Properties**
4. A window *User Properties* will appear:

![User Properties window](image)

- Click on **Groups**

  ![Groups selection](image)

  You will see in the appearing window the field **Primary Group** that shows the original group of the user.

- In the field **Select the groups that the user will be a member of** you can now add the user to other groups simply by selecting the respective field of the list of group(s)

- Click **OK**
Part II

RED-HAT
Enterprise Linux
WS 3
Installation-Tips
and
Configuration
Chapter 9

RED HAT

Enterprise Linux WS 3

9.1 Hints for installation of Red Hat

A Linux NMR workstation purchased from Bruker comes with a pre-installed Linux distribution, currently RED HAT ENTERPRISE LINUX WS 3.

If you want to install Red Hat by yourself, Bruker recommends to use the installation guide of the Red Hat Documentation CD. This offers, in different languages, a very easy and detailed description of all necessary steps. Those steps which are recommended by Bruker are listed below, for all other configuration steps you can choose your personnel settings.

9.2 Scratch installation of Desktop computer

1. Start the installation of RED HAT ENTERPRISE LINUX WS 3 as described on the Red Hat Documentation CD
2. In the window Mouse Configuration:
   - select your mouse (the default generic mouse might not support all features) (e.g.
select Microsoft Intellimouse if you have a wheel mouse, otherwise the middle button will not work correctly)

3. In the window Disk Partitioning Setup choose Manually partition with Disk Druid

4. In the window Partitioning:
   Bruker BioSpin recommends to create the following partitions on a 80GB hard-disk. For all these partitions you should select the button: **Force to be a primary partition** and as **File System Type** `ext3`:
   a) a partition `/boot` with 125MB size
   b) a partition `/` with 16GB size
   c) define the swap partition `/swap` with 2GB size by selecting **swap** as **File System Type**
   d) a partition `/opt` should use the remaining space (enable **Fill to maximum allowable size**)

5. In the window Boot Loader Configuration accept the default **Use GRUB as the boot loader**

6. In the window Network Configuration disable **Active on Boot** for eth1 if your PC does not control a spectrometer (e. g. notebook or workstation).
   If the PC is controlling a spectrometer you should select **Active on Boot** for eth1. Additionally you can click on **Edit** of eth1 and configure it for spectrometer control. For this you can type in the IP address and subnet mask:
   IP-address (eth1): 149.236.99.1
   Subnet mask (eth1): 255.255.255.0
   The hostname should be created by DHCP (if available). Changing the hostname to another name can be done in the installed system, see chapter 10.1

7. In the window Firewall, select the firewall configuration you prefer.
   If you select other than **No Firewall** and the installation is for spectrometer con-

---

1. `ext3` file system is a journaling filesystem. The advantage of a journaling filesystem is, that an accidental power off would not end in most cases to a file system check and missing data.
2. GRUB is more convenient than LILO especially for dual boot computer. if you want to use Norton GHOST 2003 for creating images of the harddisk you have to use LILO. PCs delivered from Bruker Germany have Norton Ghost 2003 attached. For more details see chapter 15.8
trol, you have to enable your spectrometer communication for full access. Click on eth1 in the section:

*If you would like to allow traffic from a device, select it below*

8. In the window Timezone Selection:

   it is necessary to configure the *Location*, but do not enable *System clock uses UTC*

9. In the window Package Defaults:

   we recommend to select: *Customize the set of packages to be installed*

   and in the following window Package Group selection

   scroll down to the end of the list and select *Everything*\(^1\)

10. During the installation process, you will be asked to insert all four installation CDs one after the other. After finishing with the fourth CD you will be asked to insert the first CD once again.

11. The window *Congratulations* appears and informs you about a successful installation. You have to remove the CD and press *Exit*, this will reboot the PC.

12. When the system is coming up again, a window *Welcome* appears

13. You have to accept the license agreement, to adjust date and time and you will be asked for creating a non-administrative user account.

14. In the window *Red Hat Network* you can select to register at the Red Hat Network right now (*Yes, ...*) or you can choose *No...* in case you have currently no network connection etc.

15. A window *Additional CDs* appear

   On HP computers it is necessary to install the drivers/update CD that can be downloaded from the HP web side


   Enter there the type of your PC (e. g. xw4100 for the currently delivered HP xw 4100) and follow the instructions of the following pages.

   If you have the correct CD for your PC available or any other CD that should be installed now (e. g. a Red Hat Extras CD), you have to insert the respective CD then click on the *Install...* button right to the text *Additional CDs*

16. You will be guided trough the installation process

---

\(^1\) This installation requires about 4GB space on the harddisk
17. After finishing the installation process of the HP driver/update CD you will be asked to reboot now or later. In case you want to install further CDs it is recommended to click on reboot later, because otherwise this process is stopped.

18. After finishing this installation you can start TopSpin installation (see chapter 2.2 for a brief description or chapter 4.3 for a detailed description).

9.2.1 Necessary additional packages

Bruker recommends to use the full installation of Red Hat Enterprise Linux WS 3 (see chapter 9.2 step 9). In addition to this complete installation you need for some special cases (see table below) the two packages bootparamd and Acrobat Reader. For an installation description see the following chapters.

<table>
<thead>
<tr>
<th>Package</th>
<th>available on</th>
<th>Necessary for</th>
</tr>
</thead>
<tbody>
<tr>
<td>bootparamd</td>
<td>TopSpin 1.3 DVD</td>
<td>acquisition</td>
</tr>
<tr>
<td>acrobat reader</td>
<td><a href="http://www.gurulabs.com/downloads">www.gurulabs.com/downloads</a></td>
<td>documentation viewer</td>
</tr>
</tbody>
</table>

9.2.1.1 Additional packages for spectrometer control - bootparamd

The software packages bootparamd is necessary if the PC controls a spectrometer.

1. Check if bootparamd is installed so far
   • `rpm -q bootparamd`
   • is the output like this
     `bootparamd=<version-number>`
   • Yes? You can skip this chapter
   • No? Go to step 2.

2. Insert DVD TopSpin 1.3

3. Click on the DVD icon on the desktop

4. A window `file:/mnt/cdrom - Konqueror` will appear
   • click Linux → `rpm`

5. Click on `bootparamd=<version_number>.i386.rpm`
6. A window *Query* will appear

```
Password for root [ ]
```

- enter root password

7. A window *Completed System Preparation* will appear

```
1 packages are queued for installation.
This will take 17 Kibibytes of disk space.
```

- click *Continue*

### 9.2.1.2 Additional packages for documentation view - Acrobat Reader

The software packages *acroread* is necessary if you want to view manuals in the *Help* menu of TopSpin.

1. Check if *acroread* is installed so far
   - Open a shell and type in:
     ```
     rpm -q acroread
     ```
   - Is the output like this
     ```
     acroread-<version-number>
     ```
   - Yes? You can skip this chapter
   - No? Go to step 2.

3. Search for the entry `acroread-<version-number>.i386.rpm`
4. Download `acroread-<version-number>.i386.rpm`
5. Download `acroread-plugin-<version-number>.i386.rpm`
6. Install the rpm packages. You can do this either...
   - on a shell, type in the command
     
     ```bash
     rpm -Uvh <path_of_the_rpm>/acroread-<version-number>.i386.rpm
     ```
   - click on the icon `Home` on the desktop. Go to the directory the rpm packages were stored and click on the file. Installation will start immediately or you will be asked for the root password.

### 9.3 Installation of additional Red Hat packages on already installed systems

If you have done the full installation of *Red Hat Enterprise Linux WS 3* as it is described in chapter 9.2, the packages described in this chapter are already installed and you can skip this chapter.

If you want to prepare an already installed *Red Hat Enterprise Linux WS 3* system for *TopSpin*, you have to make sure that the following packages are available:

<table>
<thead>
<tr>
<th>Package</th>
<th>on CD</th>
<th>Necessary for</th>
</tr>
</thead>
<tbody>
<tr>
<td>nfs-utils</td>
<td><em>Red Hat Enterprise Linux WS 3 Operating System CD 2 of 4</em></td>
<td>acquisition</td>
</tr>
<tr>
<td>redhat-config-nfs</td>
<td><em>Red Hat Enterprise Linux WS 3 Operating System CD 2 of 4</em></td>
<td>acquisition</td>
</tr>
<tr>
<td>uucp</td>
<td><em>Red Hat Enterprise Linux WS 3 Operating System CD 2 of 4</em></td>
<td>acquisition</td>
</tr>
<tr>
<td>glibc-kernheaders</td>
<td><em>Red Hat Enterprise Linux WS 3 Operating System CD 3 of 4</em></td>
<td>compiling AU programs</td>
</tr>
<tr>
<td>glibc-devel</td>
<td><em>Red Hat Enterprise Linux WS 3 Operating System CD 3 of 4</em></td>
<td>compiling AU programs</td>
</tr>
<tr>
<td>mutt</td>
<td><em>Red Hat Enterprise Linux WS 3 Operating System CD 2 of 4</em></td>
<td>email</td>
</tr>
</tbody>
</table>

For an installation description see the following chapters. For more information
about useful packages, please refer to chapter 15.3.1

9.3.0.3 uucp, nfs-utils and redhat-config-nfs

The software packages nfs-utils, redhat-config-nfs and uucp are necessary if the PC controls a spectrometer.

1. Check if nfs-utils, redhat-config-nfs and uucp is installed so far
   • Open a shell and type in:
     
     rpm -q nfs-utils
     rpm -q redhat-config-nfs
     rpm -q uucp
   • is the output like this
     nfs-utils-<version-number>
     redhat-config-nfs-<version-number>
     uucp-<version-number>
   • Yes? You can skip this chapter
   • No? Go to step 2.

2. Insert RED HAT ENTERPRISE LINUX WS 3 Operating System CD 2 of 4

3. Click <red hat> → System Tools → More System Tools → File Manager - Super User Mode

4. A window run as root - KDE su will appear
   • enter root password

5. A window file:/root - Konqueror will appear
   • go to file:/mnt/cdrom/RedHat/RPMS

6. Search for the entry uucp-<version-number>.i386.rpm
7. Double click `uucp<version-number>.i386.rpm`
8. A window Completed System Preparation will appear
   • click Continue
9. In the window `file:/root - Konqueror` search for the entry `redhat-config-nfs-
   <version-number>.i386.rpm`
10. Double click `redhat-config-nfs-<version-number>.i386.rpm`
11. A window Completed System Preparation will appear
    • click Continue
12. In the window `file:/root - Konqueror` search for the entry `nfs-utils-<version-
    number>.i386.rpm`
13. Double click `nfs-utils-<version-number>.i386.rpm`
14. A window Completed System Preparation will appear
    • click Continue
15. Close the `Konqueror` window **`file:/mnt/cdrom/RedHat/RPMS`**
16. To eject the CD click right on the CD icon on the desktop and choose `eject`

### 9.3.1 Additional packages for the compilation of AU programs

The packages `glibc-kernheaders` and `glibc-devel` are necessary for the compilation of
AU programs.

#### 9.3.1.1 glibc-kernheaders

1. Check if `glibc-kernheaders` is installed so far
   • `rpm -q glibc-kernheaders`
   • is the output like this
     `glibc-kernheaders-<version-number>`
   • Yes? You can skip this chapter
   • No? Go to step 2.
2. Insert **RED HAT ENTERPRISE LINUX WS 3 Operating System CD 2 of 3**
3. Click `<red hat> → System Tools → More System Tools → File Manager -
   Super User Mode`
4. A window `run as root - KDE su` will appear
• enter root password
5. A window file:/root - Konqueror will appear
• go to file:/mnt/cdrom/RedHat/RPMS
6. Search for the entry glibc-kernheaders-<version-number>.i386.rpm
7. Double click glibc-kernheaders<version-number>.i386.rpm
8. A window Completed System Preparation will appear
• click Continue
9. Close the Konqueror window file:/mnt/cdrom/RedHat/RPMS
10. To eject the CD click right on the CD icon on the desktop and choose eject

9.3.1.2 glibc-devel
1. Check if glibc-devel is installed so far
   • rpm -q glibc-devel
   • is the output like this
e   glibc-devel-<version-number>
   • Yes? You can skip this chapter
   • No? Go to step 2.
2. Insert RED HAT ENTERPRISE LINUX WS 3 Operating System CD 2 of 3
3. Click <red hat> → System Tools → More System Tools → File Manager - Super User Mode
4. A window run as root - KDE su will appear
   • enter root password
5. A window file:/root - Konqueror will appear
   • go to file:/mnt/cdrom/RedHat/RPMS
6. Search for the entry glibc-devel-<version-number>.i386.rpm
7. Double click glibc-devel-<version-number>.i386.rpm
8. A window Completed System Preparation will appear
   • click Continue
9. Close the Konqueror window file:/mnt/cdrom/RedHat/RPMS
10. To eject the CD click right on the CD icon on the desktop and choose eject
9.3.2 Additional package for sending data by email

The package `mutt` is necessary for the `smail` command in `TopSpin`, the email notification in ICON-NMR and for the automatic notification for helium refill. If you want to work with these tools, you have to install the mutt package.

9.3.2.1 Mutt

1. Check if `mutt` is installed so far
   - `rpm -q mutt`
   - is the output like this
     `mutt-<version-number>`
   - Yes? You can skip this chapter
   - No? Go to step 2.
2. Insert RED HAT ENTERPRISE LINUX WS 3 Operating System CD 2 of 3
3. Click `<red hat> → System Tools → More System Tools → File Manager - Super User Mode`
4. A window `run as root - KDE su` will appear
   - enter root password
5. A window `file:/root - Konqueror` will appear
   - go to `file:/mnt/cdrom/RedHat/RPMS`
6. Search for the entry `mutt-<version-number>.i386.rpm`
7. Double click `mutt-<version-number>.i386.rpm`
8. A window `Completed System Preparation` will appear
   - click `Continue`
9. Close the `Konqueror` window `file:/mnt/cdrom/RedHat/RPMS`
10. To eject the CD click right on the CD icon on the desktop and choose `eject`

9.4 Check if all necessary components are installed and active

To check if all necessary components are installed and active, please type

`/sbin/chkconfig --list`
in a shell and compare the output with this example

```
nfs   0:off 1:off 2:on 3:on 4:on 5:on 6:off
nfslock 0:off 1:off 2:off 3:on 4:on 5:on 6:off
bootparam 0:off 1:off 2:on 3:on 4:on 5:on 6:off
portmap 0:off 1:off 2:off 3:on 4:on 5:on 6:off
```

If an entry is off, you can activate it in general:

```
/sbin/chkconfig <service> on
```

If an entry is off, you can activate it for a specific runlevel:

```
/sbin/chkconfig --level <runlevel> <service> on
```

for example to start bootparam at runlevel 5:

```
/sbin/chkconfig --level 5 bootparam on
```

With `chkconfig` command you define (permanently) which service will be started/not started on which runlevel after the next reboot. It does NOT activate/deactivate the respective service, instantly.

For a temporary activation/deactivation of a process you have to use the command:

```
service <service> start/stop
```

There are mostly more possibilities for the different services like reload, restart ... . To get a list which possibilities are available just type in

```
service <service>
```

### 9.5 Dual Boot computer

It is possible to configure a PC in a dual boot mode, so that you can decide during boot time if you like to start Windows or Linux. This is not a necessary feature for spectrometer PC’s and Bruker does not recommend to configure the PC in dual boot mode.

If you like to configure a dual boot PC on your own, Bruker has some tips in the FAQ list on the Bruker web page:

`http://www.bruker-biospin.de/NMR/nmrsoftw/passwd/faq/faqalone/161.html`
Chapter 10

Network configuration

10.1 Configuring the laboratory network

The easiest way to add a Linux PC to a laboratory network is using 'DHCP' (Dynamic Host Configuration Protocol). It allows you to go online just by defining the hostname. The IP address, name- and mailserver will be created dynamically. Please contact your network administrator to find out whether DHCP is the right choice for you, or whether a fixed TCP/IP address is to be assigned to your PC. Because the licensing of TopSpin needs a correct network configuration there are three ways to do this:

1. Those PC’s which are configured by Bruker BioSpin Germany are set to DHCP. If this configuration can be used the PC should be connected to the network before the boot process starts. After the PC is coming up the network works correctly and TopSpin can be started.

2. If the PC should connected to the network by using a fix IP address you have to ask your system administrator for it. After the correct configuration the network works correctly and TopSpin can be started.

3. If the PC should not get a network connection it is necessary to work with a neutral IP address e. g. 192.168.1.1. This address is not routed to any network computer by world-wide-agreement. If you configure this number you will not have a connection to any other computer (internet, intranet, network printers ...)

107
but TopSpin can be started

### 10.2 Some useful commands

- There are two commands that allows to easily check if network is set up correctly:
  
  **hostname**
  
  **hostname -f**
  
  **hostname** has to show the short name of the PC, e.g. **nmrpc** and **hostname -f** has to show the full qualified name e.g. **nmrpc.chemistry.university.anywhere**. If the answers are not as described, you find out that something is wrong with your network configuration. Because the Linux system reacts very sensitive on wrong network configuration, you might get several problems, e.g. TopSpin does not start, spectrometer will not boot, the TopSpin license can not checked out ...

- A convenient command for checking the functionality of the ethernet cards is **/sbin/mii-tool**
  
  The output of this command shows a list of all ethernet cards and gives the information if the connection is working properly or not.

- If a ethernet card is not able to be activated in the graphical tool, you can use the following commands (in this example for ,eth0):
  
  **service network restart**
  
  **ifdown eth0**
  
  **ifup eth0**

#### 10.2.1 Configuring the laboratory network by DHCP

1. Click **<red hat> → System Settings → Network**

   a window *Query* will appear and asks for the root password

   - enter root password

---

1. The shell command for starting the network configuration is: **redhat-config-network** or simply **neat**
2. A window *Network Configuration* will appear

![Network Configuration Window](image)

- On the tab pane *Devices* click on the ethernet card you want to use for the laboratory network (typically this ‘eth0’) and click *Edit*

3. A window *Ethernet Device* will appear

![Ethernet Device Window](image)

- select the field:
Activate device when computer starts

- select the field:

  Automatically obtain IP address settings with:

and click the little arrow to the right of this field and select:

dhcp

![Image]

- enter the hostname of the PC in the field Hostname (optional)
- Contact your network administrator to get the information if you can check the field Automatically obtain DNS information from provider
- click OK

e) In the window Network Configuration click on the tab pane Hosts

![Image]

- Either this entry is correct and was visible in previous Linux versions, you will not see here an entry 127.0.0.1 / Name: localhost.localdomain / Nickname: localhost The operating system controls this entry and does not show it here in this interface. Nevertheless you can check the file /etc/hosts to get the information if this entry is there or not.
- Be sure that there is NO entry with the name of this PC. If there is one highlight it and click on Delete

---

1. This information is stored in the file /etc/hosts
The two entries that can be seen in the picture are necessary for the spectrometer connection. If this PC does not control a spectrometer they are not necessary.

f) Click on the tab pane DNS

- enter the hostname without the domainname into the field Hostname
- click File → Save
- click File → Quit

10.2.2 Configuring the laboratory network by using a fixed TCP/IP address

1. Click <red hat> → System Settings → Network

   a window Query will appear and asks for the root password
   - enter root password

---

1. In this field you have to enter the hostname only, without domainnames, i.e. only nmrpc and not nmrpc.chemistry.university.anywhere
2. The shell command for starting the network configuration is: redhat-config-network or simply neat
2. A window *Network Configuration* will appear

![Network Configuration Window](image)

- On the tab pane **Devices** click on the ethernet card you want to use for the laboratory network (typically this 'eth0') and click **Edit**

3. A window *Ethernet Device* will appear

![Ethernet Device Window](image)
• select the field:
  
  *Activate device when computer starts*

• select the field:
  
  *Statically set IP addresses*

  and type in the

  *IP address*,

  *Subnet mask* and

  *Default Gateway Address*

  that should be used from this PC (if you do not know them, contact your network administrator)

• click **OK**

g) In the window *Network Configuration* click on the tab pane **Hosts**¹

![Network Configuration window](image)

- Either this entry is correct and was visible in previous Linux versions, you will not see here an entry `127.0.0.1 / Name: localhost.localdomain / Nickname: localhost` The operating system controls this entry and does not show it here in this interface. Nevertheless you can check the file `/etc/hosts` to get the information if this entry is there or not.

---

¹ This information is stored in the file `/etc/hosts`
• click **Add** and create an entry for the IP address of this PC. The Name has to be the full qualified domain name like this:

   `nmrpc.chemistry.university.anywhere`

   and the Nickname:

   `nmrpc`

• The two entries that can be seen in the picture are necessary for the spectrometer connection. If this PC does not control a spectrometer they are not necessary.

h) Click on the tab pane **DNS**

   ![Network Configuration](image)

• enter the hostname without the domainname into the field **Hostname**

• enter the domain name in the field **DNS Search Path**

• click **File → Save**

• click **File → Quit**

Remember, that the network administrator must enter your new host on the nameserver.

1. In this field you have to enter the hostname only, without domainnames, i.e. only `nmrpc` and not `nmrpc.chemistry.university.anywhere`
10.2.3 Spectrometer PC that should not be connected to the laboratory network

In case the spectrometer PC should not be connected to the laboratory network, it is nevertheless necessary to configure a kind of ‘virtual network’.

1. Click \texttt{<red hat> → System Settings → Network}\(^1\)
   a window \textit{Query} will appear and asks for the root password
   • enter root password

2. A window \textit{Network Configuration} will appear

\begin{center}
\includegraphics[width=0.5\textwidth]{network_configuration.png}
\end{center}

• On the tab pane \texttt{Devices} click on the ethernet card you want to use for the laboratory network (typically this ‘\texttt{eth0}’) and click \texttt{Edit}

---

1. The shell command for starting the network configuration is:
   \texttt{redhat-config-network} or simply \texttt{neat}
3. A window Ethernet Device will appear

- select the field:
  
  *Activate device when computer starts*

- select the field:
  
  *Statically set IP addresses*

  and enter in the field:

  *Address:*

  192.168.1.1

  and in the field:

  *Subnet Mask:*

  255.255.255.0

- click OK
i) In the window Network Configuration click on the tab pane Hosts

- Either this entry is correct and was visible in previous Linux versions, you will not see here an entry 127.0.0.1 / Name: localhost.localdomain / Nickname: localhost The operating system controls this entry and does not show it here in this interface. Nevertheless you can check the file /etc/hosts to get the information if this entry is there or not.
- click Add and create an entry for the IP address of this PC. The Name has to be the full qualified domain name like this:
  nmrpc.chemistry.university.anywhere
  and the Nickname:
  nmrpc
- The two entries that can be seen in the picture are necessary for the spectrometer connection. If this PC does not control a spectrometer they are not necessary.

---

1. This information is stored in the file /etc/hosts
j) Click on the tab pane *DNS*

![Network Configuration](image.png)

- enter the hostname without the domainname into the field *Hostname*
- enter the domain name in the field *DNS Search Path*
- leave the DNS fields empty
- click **File → Save**
- click **File → Quit**

### 10.3 Configuring the spectrometer network

The network configuration for spectrometer control will be done automatically in case the ethernet card is not yet configured. This configuration will be done by the *Diskless* package that is part of a TopSpin installation. The description of the following chapter can be used for checking the configuration.

#### 10.3.1 Configuration of the spectrometer network

1. Click **<red hat> → System Settings → Network**

1. In this field you have to enter the hostname only, without domainnames, i.e. only `nmrpc` and not `nmrpc.chemistry.university.anywhere`
a window Query will appear and asks for the root password
- enter root password

2. A window Network Configuration will appear

![Network Configuration](image)

- click on the ethernet card you want to use for the spectrometer network (normally this 'eth1') and click **Edit**

2. The shell command for starting the network configuration is:
   
   redhat-config-network or simply neat
3. A window *Ethernet Device* will appear

![Ethernet Device window](image)

- be sure that the field *Activate Interface at boot time* is checked¹
- be sure that the field *Allow any user to (de)activate interface* is not checked
- select the field: *Statically set IP address*
  and enter in the field:
  *Address:*  
  149.236.99.1
  and in the field:
  *Subnet Mask:*  
  255.255.255.0
- click OK

k) In the window *Network Configuration* click on the tab pane *Hosts*²

---

¹ On notebooks it might be useful to disable the *Activate Interface at boot time* function. This will avoid waiting for time outs during boot process, if there is no network connection.
be sure that there are the following entries:

<table>
<thead>
<tr>
<th>IP</th>
<th>Name</th>
<th>Nickname</th>
</tr>
</thead>
<tbody>
<tr>
<td>149.236.99.1</td>
<td>ASP_ST2</td>
<td>&lt;whatever&gt;</td>
</tr>
<tr>
<td>149.236.99.99</td>
<td>spect</td>
<td>&lt;whatever&gt;</td>
</tr>
</tbody>
</table>

If one of them is missing click **Add** and create them

- click **File → Save**
- click **File → Quit**

### 10.3.2 Changing the hostname

For changing the hostname please use the network configuration tool as described in chapter 10.1.

Changing the hostname may have an effect on programs. For the Bruker BioSpin software you have to check these two places:

1. In case the PC is a license server the name of the PC is stored in the license.dat file that is stored in the flexlm installation directory. In a default installation this is:
   
   /usr/local/flexlm/Bruker/licenses/license.dat

   If this PC acts as a license server and you changed the license file, you have to be sure that the respective file is changed in the same way on all license clients.

2. The user specific configuration is stored in the directory:
   
   <USER_HOME>/topspin-<PC_NAME>

   To keep the individual TopSpin configuration in case the computer name was changed, rename these directories.

### 10.4 Email client

For using the **TopSpin** command **TopSpin smail** under Linux, it is necessary to install the program **MUTT**. **MUTT** is distributed by Red Hat and most Linux sys-
tems. For installation please refer to chapter 9.3.2

### 10.5 Network diagnostic commands

Here is a list of the most important network diagnostic commands as they can be entered from the shell:

- **arp** - displays or modifies the IP to physical address translation tables
- **hostname** - displays the short name of the current host
- **hostname -f** - displays the full qualified name of the current host
- **host IP** - displays the name that is connected with this IP
- **ifconfig** - displays information about the current TCP/IP configuration
- **netstat** - displays protocol statistics and current TCP/IP connections
- **ping** - checks if a destination host is receiving TCP/IP packets
- **route** - maintains and displays routing tables
- **traceroute** - displays the route, packets take to a destination host
- **mii-tool** - list all ethernet cards and show if they work or not

For more details about commands you can enter either:

```
man <command>
```

or

```
<command> --help
```

### 10.6 Accessing remote files and directories

#### 10.6.1 Sharing directories from a Linux host using Samba

If you are logged in on a Windows 2000/XP host, you can access data which reside on a Linux host, using the sharing mechanism. This, however, only works if the Samba package is installed on the Linux host (see chapter 15.3).

After installation of Samba is done, you can configure it with SWAT (Samba Web Administration). This tool can be started from your Web Browser, e.g.:

```
<red hat> → Internet → Mozilla Web Browser
```
Network configuration

by entering the address: http://localhost:901/

You will be asked for username and password. For configuration of SWAT it is necessary to login as root. Other users are neither able to see the whole information nor can change it!

There you have to define:

- the **password** and the **user** for configuration in the **Password** section
- the **workgroup** in the **GLOBALS** section
- the **directories** you want to share in the **SHARES** section

Reboot the PC

10.6.2 Mounting Windows 2000/XP partitions on a Linux host using Samba

This is more convenient than mounting via NFS because you do not need to have a NFS package installed on the Windows PC. The only thing that you need is the Samba package for the Linux PC, which is available on the Red Hat CDs.

To define a mounted directory you have to gather the following information:

1. Check a valid user and the name of the Windows PC and get the information which directories are available (=shared), enter the command:

   ```bash
   smbclient -L <WIN_PVC_NAME> -U <WIN_PC_USER>
   ```
for example for the Windows PC `nmrpc.chemistry.university.anywhere` and the user `Administrator` the command looks like this:

```
smbclient -L nmrpc.chemistry.university.anywhere -U Administrator
```

You will be asked to enter the users password. The answer of the command is a list of all shared directories on the Windows PC, e.g.:

<table>
<thead>
<tr>
<th>Sharename</th>
<th>Type</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>E$</td>
<td>Disk</td>
<td>Default share</td>
</tr>
<tr>
<td>tmp</td>
<td>Disk</td>
<td></td>
</tr>
</tbody>
</table>

Now you have four information available:

1. `<WIN_PC_NAME>`
2. `<WIN_PC_USER_NAME>`
3. `<WIN_PC_USER_NAME_PASSWORD>`
4. `<WIN_PC_SHARE>`

2. Create a group called `nmruser` and add those user who should get access into the shared directory. To get information how to create a group please refer to chapter 8.1

3. As a second step you have to define the directory wherein the contents of the shared Windows directory should appear. It is recommended to create therefor a new directory:

```
mkdir <WIN_PC_DATA_DIR>
```

4. To allow an automatic mount of the directory of the Windows PC during boot of the Linux PC you have to create a text file (= `<FILEX>`) with the information of the user name and corresponding password. The syntax of the file has to be:

```bash
username = <WIN_PC_USER_NAME>
password = <WIN_PC_USER_NAME_PASSWORD>
```

Because the file contains a plain password, you have to make sure that it is only readable by root. You can do this as root on a LINUX shell with the two commands:

```
chown root.root <FILEX>
chmod 600 <FILEX>
```

Now you can put together the information and add a new line in the file
/etc/fstab:
//<WIN_PC_NAME>/<WIN_PC_SHARE> /<WIN_PC_DATA_DIR> smbfs rw,gid=nmruser,dmask=775,credentials=<FILEX>,user 1 2
This is one line between smbfs and rw is a space. The option gid=nmruser,dmask=775 gives full control to the user and the group, others get read and execute.

10.6.3 Mounting Windows 2000/XP partitions from a Linux host using NFS

This requires that the NFS server is installed on the Windows PC. If this PC is controlling a spectrometer, the Hummingbird NFS Server is already installed. The partition C:\Bruker\Diskless\clients\spect is mounted via NFS by the spectrometer CCU (which is a UNIX host). In the same way, you can mount any Windows 2000/XP partition or directory on any UNIX or Linux host. Proceed as follows:

1. Export the Windows 2000/XP partition as described in Installation Guide for Windows XP.
2. On the Linux host:
   a) Open a shell
   b) Type su to become superuser
   c) Create a mount directory, e.g. mkdir /ntdata
   d) Mount the partition, e.g.:
      
      ```
      mount nhost:/c/data /ntdata
      ```

      Note that if the pathname on the Windows 2000/XP host contains upper case letters, these must also be specified with the mount command.

10.6.4 FTP and Telnet

The security level of ftp and telnet are not very high. Because of this, these services are not installed on a typical RED HAT ENTERPRISE LINUX WS 3 installation. The modern and secure alternative is SSH.

If you want to install ftp and telnet services see chapter 15.3
Chapter 11

Installing a Printer

11.1 Introduction

In the following you can find the description of the print system 'CUPS'. In RED HAT ENTERPRISE LINUX WS 3 CUPS is the only print system, the older 'LPRng' is not available anymore.

Note: While using CUPS, TOPSPIN PLOT EDITOR 1.3 can print the Bruker logo which is part of the standard Bruker layouts. BUT previous XWIN-PILOT versions are not able to create a plot with the Bruker logo using CUPS. The workaround here is to remove one of the last lines in the file:

<TOPSPIN_HOME>/plot/epsi/bruker.eps

Find the following lines at the end of the file:

```plaintext
... 
%%Trailer 
cleartomark 
countdictstack exch sub{end}repeat 
restore 
%%End
```

and remove the line ‘%%Trailer’ so that it looks like this:

```plaintext
... 
cleartomark 
```
Another workaround is, to use the additional option '-oraw' in the print command of the TopSpin plot editor layout. This is only possible in case the required printer is able to understand PostScript code.

11.2 Print system 'CUPS'  

11.2.1 Installation of a Local printer

In order to install a Local printer on a Linux PC, you have to take the following steps:

1. Click <red hat> → System Settings → Printing

   A window Query will appear and asks for the root password
   • enter root password

2. The window Printer configuration will appear

   ![Printer configuration window]

   • Click New

1. To define the default printer of the system root can also execute the command:
   `lpadmin -d <printer_name>`

   To define a user specific default printer the user has to execute the command:
   `lpoptions -d <printer_name>`
3. A window *Add a new Print Queue* will appear

![Add a new print queue](image)

- Click **Forward**

4. The window changes to *Queue name*

![Queue name](image)

Enter name and short description of the printer (in this example *printer-nmr3* and *HP printer on NMR-3*)

- Click **Forward**
5. The window changes to *Queue type*

![Queue type window](image)

Select *Locally-connected* and the port where the printer is connected (in this example /dev/lp0)

- Click *Forward*

6. The window changes to *Printer model*

![Printer model window](image)

Select the manufacturer and the model of the printer in this example *HP Laser Jet 1220*

- Click *Forward*
7. The window changes to *Finish, and create the new print queue*

![Image of the printer configuration window]

- Click *Apply*

8. The new window *Question* appears

![Image of the test page question]

In case the printer is already connected it is recommended to print a test page

- Click *Yes*

If it is not connected so far, click on *No* and back in the window *Printer configuration* on *Apply*

9. To configure the printer click on its name and on *Edit*
10. The new window *Edit a print queue* appears

11. To change the driver click on the tab pane *Printer driver*

   ![Edit a print queue window]

   If there are several printer drivers, *Postscript* is always a good choice, and the old *ljet4* works also in most cases very well)

12. Click *OK* and back in the window *Printer configuration* on *Apply*

13. The printer is ready to use
11.2.2 Installation of a Unix network printer

In order to install a Unix network printer on a Linux PC, you have to take the following steps:

1. Click `<red hat> → System Settings → Printing`
   
   A window *Query* will appear and asks for the root password
   
   • enter root password

2. The window *Printer configuration* will appear

   ![Printer configuration window](image)

   • Click New

3. A window *Add a new Print Queue* will appear

   ![Add a new print queue](image)

   • Click Forward
4. The window changes to *Queue name*

![Queue name window](image1)

Enter name and short description of the printer (in this example *printer-nmr3* and *HP printer on NMR-3*)

- Click **Forward**

5. The window changes to *Queue type*

![Queue type window](image2)

Select *Networked UNIX (LPD)* and enter the hostname/IP address\(^1\) and the queue of the printer (in this example *viola.software.bruker.de* and *laserjet1200*)

- Click **Forward**

\(^1\) You can enter either a name or a IP address of the printer. Everything will work what can be used for a successfully **ping** to the respective PC
6. The window changes to *Printer model*

![Printer model window]

Select the manufacturer and the model of the printer in this example *HP Laser Jet 1220*)

- Click **Forward**

7. The window changes to *Finish, and create the new print queue*

![Finish, and create the new print queue window]

- Click **Apply**
8. The new window Question appears

![Question](image)

In case the printer is already connected it is recommended to print a test page

- Click Yes

If it is not connected so far, click on No and back in the window Printer configuration on Apply

![Printer configuration](image)

9. To configure the printer click on its name and on Edit
10. The new window *Edit a print queue* appears

![Edit a print queue window](image)

11. To change the driver click on the tab pane **Printer driver**

![Printer driver window](image)

If there are several printer drivers, *Postscript* is always a good choice, and the old *ljet4* works also in most cases very well)

12. Click **OK** and back in the window *Printer configuration* on **Apply**

13. The printer is ready to use
11.2.3 Installation of a Windows network printer

In order to install a Windows network printer on a Linux PC, you have to take the following steps:

1. Click `<red hat> → System Settings → Printing`
   
   A window *Query* will appear and asks for the root password
   
   • enter root password

2. The window *Printer configuration* will appear

   ![Printer configuration window](image)

   • Click New

3. A window *Add a new Print Queue* will appear

   ![Add a new print queue window](image)

   • Click *Forward*
4. The window changes to **Queue name**

Enter name and short description of the printer (in this example *printer-nmr3* and *HP printer on NMR-3*)

- Click **Forward**

5. The window changes to **Queue type**

Select *Networked Windows (SMB)* and the required shared printer from the list. You will see all printers that are reachable without username and password. If the required printer is not in the list, ...

- Click **Specify**
The window Authentication appears, enter all entries manually

.. if it is on the list, click on the entry and the window Authentication will appear with those information that are available. Fill in the missing information about the user name and password.

- Click Forward

6. The window changes to Printer model
   Select the manufacturer and the model of the printer

- Click Forward

7. The window changes to Finish, and create the new print queue
   - Click Apply
8. The new window **Question** appears

![Question Window]

In case the printer is already connected it is recommended to print a test page

- Click **Yes**

If it is not connected so far, click on **No** and back in the window **Printer configuration on Apply**

![Printer Configuration Window]

9. To configure the printer click on its name and on **Edit**
10. The new window *Edit a print queue* appears

![Image of the Edit a print queue window]

11. To change the driver click on the tab pane **Printer driver**

![Image of the Printer driver tab]

If there are several printer drivers, *Postscript* is always a good choice, and the old *ljet4* works also in most cases very well.

12. Click **OK** and back in the window *Printer configuration* on **Apply**

13. The printer is ready to use
11.2.4 Installation of a Jet Direct printer

In order to install a Jet Direct printer on a Linux PC, you have to take the following steps:

1. Click `<red hat> → System Settings → Printing`

   A window `Query` will appear and asks for the root password
   - enter root password

2. The window `Printer configuration` will appear

   ![Printer configuration window]

   - Click **New**

3. A window `Add a new Print Queue` will appear

   ![Add a new print queue]

   - Click **Forward**
4. The window changes to Queue name

Enter name and short description of the printer (in this example printer-nmr3 and HP printer on NMR-3)

- Click Forward

5. The window changes to Queue type

Select Networked JetDirect and enter name and port of the printer (in this example printersw and 9100)

- Click Forward

6. The window changes to Printer model

Select the manufacturer and the model of the printer in this example HP Laser
7. The window changes to Finish, and create the new print queue.

8. The new window Question appears.
In case the printer is already connected it is recommended to print a test page
- Click Yes

If it is not connected so far, click on No and back in the window Printer configuration on Apply

9. To configure the printer click on its name and on Edit
10. The new window Edit a print queue appears
11. To change the driver click on the tab pane **Printer driver**

![Image of Printer driver selection screen]

If there are several printer drivers, ‘Postscript’ is always a good choice, and the old ‘ljet4’ works also in most cases very well.

12. Click **OK** and back in the window **Printer configuration** on **Apply**

13. The printer is ready to use
Part III

Tips, Tricks and Troubleshooting
Chapter 12
Troubleshooting TopSpin

12.1 TopSpin does not start

If TopSpin does not start, you should first look for an error message in the window where the TopSpin startup messages appear. Then check if you have one of the following problems:

- A window Choose Server or File appears:
  The file license.dat was not found. You might have one of the following problems:
  - license.dat has been deleted or renamed
    → Setup the file license.dat as described in chapter 5.2.
- Invalid license key (inconsistent license key)
  The file license.dat might contain one of the following errors:
  - The FEATURE line contains the wrong license key, the wrong date and/or the wrong number of licenses
  - The hostid is appended at the end of the FEATURE line

- Invalid host
The file `license.dat` contains additional characters at the end of the FEATURE line (after “”)

12.2 TopSpin troubleshooting

`TopSpin` should not get into any trouble in general! Nevertheless, if your current `TopSpin` session has a problem, you can find in this chapter some instructions how to get rid of this situation.

In order to stop TopSpin in case of any problems, the first thing to know is, that TopSpin is working with a client / server structure. The server is the program itself and the client is the graphical interface. It is possible to exit each of them separately. It is also possible to start more than one client (graphical interface). This feature is used for the remote control but can also be very useful for troubleshooting (see below)!

- The client (=graphical user interface of `TopSpin`) can be stopped without touching a running acquisition.
- Stopping the program itself will also stop a running acquisition.

12.2.1 Troubleshooting while no acquisition is running

The most convenient way to get rid of a problem inside `TopSpin` is, to stop the complete program. For this you can do the following steps. These steps are increasingly drastic.

1. Enter `exit` in the `TopSpin` command line or press the X in the upper right corner of the program window.

   Is the `TopSpin` window closed?
   - Yes? Start `TopSpin` once again, in case there will be still some problems go ahead with step 2
   - No? go ahead with step 2

2. Stop the current `TopSpin` window and start a new one

   a) Enter in the `TopSpin` command line:

   - `logoff`

   b) Open another Linux shell and start a second `TopSpin`:

   - `topspin -client`
Has the first TopSpin window been closed and does the second one work fine?

- Yes? The problem is solved you can go ahead with TopSpin
- No? go ahead with step 3

3. Stop all TopSpin windows and end the program itself

a) Try to stop all TopSpin windows by enter the command:

   - `logoff`
   in the TopSpin command line

b) To close all the TopSpin windows that could not be closed in step a), open a Linux shell and enter

   - `ps -ef | grep /opt/topspin/home/jre/bin/java`

   You have to replace the `<TOPSPIN_HOME>` with the path of your TopSpin installation. In a default installation this is `/opt/topspin`, in this case the command would be:

   - `ps -ef | grep /opt/topspin/jre/bin/java`

   The answer is something like this:

   `<USER> <xxx> <yyy> 0 <date/time> pts/<z> 00:00:00 /opt/topspin/jre/bin/java ...`

c) Kill all those sessions by entering the command in a Linux shell:

   - `kill <xxx>`

d) In case the ‘normal’ kill does not work use the kill -9 command:

   - `kill -9 <xxx>`

e) Enter the command in a Linux shell:

   - `shmrm`

12.2.2 Troubleshooting while an acquisition is running

The difference to the situation that no acquisition is running is, that you can try to stop only the graphical user interface without stopping the acquisition. Steps 1-3 do not stop the acquisition, step 3-5 will stop also the acquisition.

1. Stop the current TopSpin window and start a new one

a) Enter in the TopSpin command line:

   - `logoff`

b) Open another Linux shell and start a second TopSpin:
• **topspin -client**
  Has the first TopSpin window been closed and does the second one work fine?
  • Yes? The problem is solved you can go ahead with TopSpin
  • No? go ahead with step 2

2. Stop all TopSpin windows and end the program itself
   a) Try to stop all TopSpin windows by enter the command:
      • **logoff**
        in the command line of the TopSpin windows
   b) Open a Linux shell and enter
      • **ps -ef | grep <TOPSPIN_HOME>/jre/bin/java**
        You have to replace the <TOPSPIN_HOME> with the path of your TopSpin installation. In a default installation this is /opt/topspin, in this case the command would be:
        • **ps -ef | grep /opt/topspin/jre/bin/java**
          The answer is something like this:
          <USER> <xxx> <yyy> 0 <date/time> pts/<z> 00:00:00 /opt/topspin/jre/bin/java ....
      c) Kill all those sessions by entering the command in a Linux shell:
         • **kill <xxx>**
      d) In case the 'normal' kill does not work use the kill -9 command:
         • **kill -9 <xxx>**
   3. Enter the command in a Linux shell:
      • **shrm**
   4. To get a list of all TopSpin processes open a Unix shell and enter
      • **uxproc**
   5. Kill any hanging TopSpin processes with the command:
      • **kill -9 <xxx>**
        and the respective ID of the process you got in step 4.
12.2.3 Send debug information to Bruker BioSpin

If you are in a situation, that TopSpin problems appear periodically you can send the information about this situation to Bruker BioSpin. To get the information go into the Linux shell where TopSpin was started and press the keys Ctrl and Backslash simultaneously\(^1\). This will create a debug output inside the shell. Please copy this output into an email and send it to this address:

nrn-software-support@bruker.de

For a complete debugging it is useful to attach the history file of the TopSpin session. For this attach the following two files:

<TOPSPIN_HOME>/prog/curdir/<USER_NAME>/history

<USER_HOME>/.topspin-<PC_NAME>/prop/protocol.txt

12.3 Communication problems between PC and CCU

If the acquisition (\texttt{sg}, \texttt{gs}, \texttt{wobb}) and/or the configuration (\texttt{cf}) fail, you might have a communication problem between the Linux PC and the spectrometer CCU. Typically you will get error messages from TopSpin like:

\begin{itemize}
  \item Connect to spect: unable to connect to remote host
  \item Connection to spect. aqport0, failed
  \item Acquisition hardware not present or defect
\end{itemize}

Check the communication between the PC and the CCU in the following way:

\begin{enumerate}
  \item Open a shell
  \item Type \texttt{telnet spect}
\end{enumerate}

Depending on whether \texttt{telnet spect} works (you get a login prompt) or not, continue with paragraph 12.3.1 or 12.3.2.

12.3.1 Communication problems but \texttt{telnet spect} works

If \texttt{telnet spect} works, the CCU has booted. This means that the spectrometer network software is installed and running. The communication problems obviously have other causes. Two of the most common causes are mentioned below.

\(^1\) If this key combination does not work, you might have a German keyboard configuration, in this case you have to switch it into English.
In each of the following steps you must be logged in on the PC as root and type the indicated commands in a shell.

1. Check if the process `startd` is running on the CCU:
   a) Type `telnet spect` and log in on the CCU as root
   b) Type `ps -efw | grep startd`
      Does this command show you 2 processes `/etc/startd`?
      YES? Then `startd` is running, type `exit`, go to step 2
      NO? Then you found the problem, go to step 1c.
   c) Type `/etc/startd`
      Trying to start `startd` in this way might show you the reason why `startd` was not started automatically. You might have a hardware problem and starting the `startd` manually indicates which board has a failure. Run the corresponding hardware test (see chapter 12.8.1).

2. Check if the spectrometer has an alias name which is not specified in `/etc/hosts`:
   a) Type `cd /<TOPSPIN_HOME>/conf/instr`
      `<TOPSPIN_HOME>` is the directory where TopSpin is installed (default is `/opt/topspin`)
   b) Type `more curinst`
      What is the output of this command?
      • spect? Then the spectrometer does not have an alias name different from spect, e.g. av600? Then do the following:
         type `grep spect /etc/hosts`
         What is the output of this command?
         149.236.99.99 spect av600? Then the alias name is specified
         149.236.99.99 spect? Then you found the problem, go to c)
   c) Edit the file `/etc/hosts`:
      append the alias name, e.g. av600 after spect

If these two steps did not solve your problem, copy the contents of the two history files into an email to your local Bruker office. Where do you can find the files, can be seen by entering the command hist in TopSpin. These files contain the neces-
sary information:
<TOPSPIN_HOME>/prog/curdir/<USER_NAME>/history
<User_home>/topspin-<PC_NAME>/prop/protocol.txt

12.3.2 Communication problems and telnet spect does not work

If telnet spect does not work, the CCU has probably not booted up completely. This can have several causes. In each of the following steps you must be logged in on the PC as root and type the indicated commands in a shell. After each step, type telnet spect and see if you get a login prompt.

12.3.2.1 Software related problems

1. Open a Linux shell and become superuser; type su -
2. Check if there are firewall rules that prohibit to contact the spectrometer
   a) go to the directory /etc/sysconfig
      • cd /etc/sysconfig
   b) what is the configuration of iptables¹
      • iptables -L
        Did you get a information that contains three times (policy ACCEPT)?
        • Yes ? No problem, go to step 3
        • No, the answer is at great length? go to step c
   c) to check if this is the problem stop the firewall temporarily, type in :
      • service iptables stop
        Check the spectrometer connection once again. Does it work now?
        • No ? No problem, go to step 3
        • Yes ? You might have found the problem. The system administrator has to make sure that the ethernet card for spectrometer control gets full access or he has to disable firewall package in general. This can be done by the command:
          chkconfig iptables off
          Note: You have to reboot the PC.

¹. If you use the firewall package iptables, you have to make sure that it allows the ethernet card for spectrometer control full access (see chapter 15.2.1)
3. Reboot the PC and CCU using reviveccu¹:
   
   type reviveccu
   
   → follow the instructions:
   
   a) You will be asked to switch off the acquisition rack
   b) reviveccu will automatically reboot the PC
   c) Switch on the acquisition rack after the PC has rebooted

4. Check the nameserver configuration:

   a) Type `grep hosts /etc/nsswitch.conf`

      What is the output of this command?
      
      Nothing? No problem, go to step 5.
      
      • `Cannot open nsswitch.conf`? No problem, no nameserver; go to step 5.
      • `hosts: files dns nisplus`? No problem, this entry is correct; go to step 5
      • `hosts dns....` or `hosts nisplus....`? You found the problem: go to step b.

   b) Edit the file `/etc/nsswitch.conf` and check if the line `hosts` looks like this: `hosts: files dns nisplus`

      where `files` refers to the local `/etc/hosts` file and `dns` to the DNS (bind) and `nisplus` refer to nameservers.

      This specifies that network commands like `telnet` should first check the local file `/etc/hosts` then, if the host was not found, contact the Domain Name System (`dns`) and finally the Network Information System (`nisplus`). The entries `dns` and `nisplus` are only useful if you have the corresponding network systems. Make sure the entry `files` comes first, the existence and the order of entries `nisplus` and `dns` depends on your network.

5. Check if NFS is running:

   a) Type `ps -efw| grep nfsd`

      Does the output of this command show you 8 processes `/usr/etc/nfsd` ?
      
      YES? Then NFS is running, continue with step 7
      NO? Then you found the problem, continue with step c

   b) Check the file

1. The command `reviveccu` executes a shell script which will first remove the two files: `/usr/diskless/clients/spect/root/etc/mtab` and `.../utmp` and then reboot spectrometer-CCU and Linux-PC
Troubleshooting TopSpin

- /etc/sysconfig/network
  Does the file contain the entry
  NETWORKING=yes
  YES? Then NFS can be started, continue with step 7
  NO? Then you found the problem, change the entry to yes and restart NFS manually. Open a shell and type in:

  `service nfs restart`

  c) Type `/sbin/chkconfig nfs on`
  d) Type `reviveccu`
  e) Run step 5a again and if NFS is still not running continue with step 6

6. Check if NFS is installed:
   a) Type `rpm -q nfs-utils`
      Does the output of this command show you the package `nfs-utils`?
      YES? Then NFS is installed, go to step 7
      NO? Then you found the problem, install the package `nfs-utils`. For an installation description please refer to chapter 9.2.1.1

7. Check if the process `bfsd` is running:
   a) Type `ps -efw | grep bfsd`
      Does the output of this command show you the process
      `/usr/diskless/bfsd.linux`
      YES? Then `bfsd` is running, continue with step 8
      NO? Then you found the problem, continue with step 7b
   b) Check the configuration of bfsd. Correct it if it is wrong.
      - type in `/sbin/chkconfig --list bfsd` and check if the output show `on` in runlevel 5, e.g.:

      ```
      bfsd 0:off 1:off 2:on 3:on 4:on 5:on 6:off
      ```
      c) Start the bfsd manually.
         - type in `service bfsd start`
         and check if the output of step 7a is correct now. If it is not, go ahead.

1. If a process like this is not started, start it on a shell by typing `service <process> start`
d) Check the output of the command **hostname**
   
   Is the output of this command:
   
   - a plain *hostname*? No problem, continue with step 8.
   - a **hostname.domainname**? You found the problem. Change the hostname as described in chapter 10.3.2. Then continue with step 7h.

e) Check the output of the command **hostname -f**
   
   Is the output of this command:
   
   - a **hostname.domainname**? No problem, continue with step 8.
   - a plain *hostname*? You found the problem. Change the hostname as described in chapter 10.2. Then continue with step 7h.

f) Check the file `/etc/hosts`¹ - at least the following entries have to exist for spectrometer control:

   ```
   127.0.0.1 localhost.localdomain localhost
   149.236.99.1 ASP_ST2
   149.236.99.99 spect
   ```

   If the ethernet card for the laboratory network is not configured as DHCP, also the name of the own PC has to be listed:

   ```
   xyz.xyz.xyz.xyz name_of_own_pc.domain name_of_own_pc
   ```

   Does this entry exists?
   
   - Yes? No problem, continue with step 8.
   - No? You found the problem. Add the name of the PC as described in chapter 10.2.2. Then continue with step 7h.

g) Check if the ethernet card for the laboratory network is configured as DHCP (see chapter 10.2.1). If so check if the DHCP server is still active:

   - open a Linux shell
   - type in **su** – to become superuser
   - type in **ifconfig**

   you will get a description of the configurations of the ethernet cards. Check the IP address of the PC, this is the number behind `inet addr`, typ-

---

¹. It is also possible to use the graphical tool for checking / configuring the entry, see chapter 10.2.2
ically of eth0

- take the IP address and type in `host <IP-address>`

is the answer like this:

```<IP-address>.in.addr.arpa. domain name pointer <PC-Name.domainname>```

Yes? No problem, continue with step 8.
No? You found the problem. Contact your network administrator to check the nameserver and DHCP server.

h) Type `reviveccu`

8. Check if the `/usr/diskless` partitions are exported:

a) Type `/usr/sbin/exportfs -v`

Does the output of this command show you both partitions with correct options:

```/usr/diskless/dl_usr
   spect (ro,async,wdelay,root_squash)```

and

```/usr/diskless/clients/spect
   spect (rw,async,wdelay,no_root_squash)```

YES? Then the partitions are exported, continue with step 9
NO? Then you found the problem, continue with step 8b

b) Check the file `/etc/exports` and correct it if it is wrong (see chapter 12.3.3.1)

c) Type `reviveccu`

9. Check if the spectrometer network is correctly configured:

- Please refer to chapter 10.3.1

10. Reconfigure the spectrometer network:

- You can use the automatic procedure which will be started by typing:

  ```/<TOPSPIN_HOME>/prog/bin/install.net/install.net```

  where `<TOPSPIN_HOME>` is the directory where TopSpin is installed (default `/opt/topspin`). This command reconfigures the entire spectrometer network.

- You can check it manually, see chapter 10.3
11. Reconfigure the spectrometer network by re-installing the DISKLESS package: 
   Insert the TopSpin DVD into the DVD drive, select the Diskless package and 
   deselect all other packages. For more details see installation description in chap-
   ter 10.3.1

12.3.2.2 Hardware related problems

1. Check if the ethernet cable between PC and CCU is properly connected.
   → Remove and re-connect the ethernet cable and the transceiver or minihub.

2. Check if the ethernet interface is broken.
   a) Physically connect the CCU to the first ethernet interface (eth0) ¹
   b) Become superuser; type su -
   c) Change the configurations between eth0 and eth1 as described in chapter 
      10.2.2 and 10.3.1.

   !
   Note: Write down all configuration parameters like IP addresses, nameserver 
   etc.

3. Replace the ethernet cable, transceiver or minihub between the PC and CCU to 
   find out if either of these components is broken.

4. If a new CCU was installed:
   a) login as root
   b) Type arp -d spect
   c) Type reviveccu

12.3.3 Files which are needed for the spectrometer network

12.3.3.1 File entries made for the spectrometer network

   • /etc/hosts
     149.236.99.1    ASP_ST2
     149.236.99.99   spect

   • /etc/bootparams
     spect root=ASP_ST2:/usr/diskless/clients/spect/root
     swap =ASP_ST2:/usr/diskless/clients/spect/swapfile

¹ assuming that the CCU is currently connected to the second ethernet interface.
dump= /ASP_ST2:/usr/diskless/clients/spect/dump

Note that this is one line with a blank between the three entries.

- /etc/exports
  /usr/diskless/dl_usr spect (ro)
  /usr/diskless/clients/spect spect (rw, no_root_squash)

- /etc/sysconfig/network
  NETWORKING=yes
  HOSTNAME=hosttest
  GATEWAYDEV=
  GATEWAY=

- /etc/sysconfig/network-scripts/ifcfg-lo
  DEVICE=lo
  IPADDR=127.0.0.1
  NETMASK=255.0.0.0
  NETWORK=127.0.0.0
  # If you're having problems with gated making 127.0.0.0/8
  # a martian, you can change this to something else
  # (255.255.255.255, for example)
  BROADCAST=127.255.255.255
  ONBOOT=yes
  NAME=loopback
  BOOTPROTO=none

- /etc/sysconfig/network-scripts/ifcfg-eth1
  BROADCAST=149.236.99.255
  NETWORK=149.236.99.0
  NETMASK=255.255.255.0
  IPADDR=149.236.99.1
  DEVICE=eth1
  ONBOOT=yes
  BOOTPROTO=none
  USERCTL=no

- /usr/diskless/clients/spect/root/etc/fstab
12.3.3.2 Files created for the spectrometer network

- `/usr/diskless/clients/spect/swapfile`

This file can also be created manually with the command:

```
    dd if=/dev/zero of=/usr/diskless/clients/spect/swapfile bs=8000000 count=1
```

- `/etc/rc2.d/S95bfsd`

This file is a symbolic link to the file `/etc/init.d/bfsd`. From this file the `bfsd` daemon `/usr/diskless/bfsd` is started.

- `/usr/diskless/clients/spect/root/dev`

This directory contains a large number of special files such as `tty00`, `tty01`, `tty02`, etc. These files are created during the installation of the DISKLESS package from the TopSpin DVD. They can also be created manually:

  a) Become superuser: `type su`
b) cd /usr/diskless/clients/spect/root/dev
c) ./MKDEV -m RS3330

12.3.4 View the output of the CCU console

In order to view the output of the CCU you must connect serial port 2\(^1\) of the PC with tty00 of the CCU, you need a cable with a round rs232 plug on the CCU side (order number HZ04161/A). The program \textit{cu} can be used to make the output of the CCU visible in a shell on the PC.

Check if \textit{cu} is installed:

\texttt{rpm -q uucp}

if it is installed and active the answer should be:

\textit{uucp-<versions-no>}

If it is not installed yet, please refer to the installation description in chapter 9.2.1.1

In case of any problems with this package check the permissions of the program.

1. Type \texttt{ls -l /dev/ttyS1}

The permissions, owner, and group of this file must be: \texttt{crw-rw-rw-}, \texttt{root} and \texttt{uucp} respectively. If they are different, change them as follows:

\begin{verbatim}
chmod a+rw /dev/ttyS1
chown root.uucp /dev/ttyS1
\end{verbatim}

1. Type \texttt{ls -l /var}

The group of the directory \texttt{lock} must be \texttt{uucp} and has to have write permissions. If they are different, change them as follows:

- login as root
- type in:

\begin{verbatim}
chgrp uucp /var/lock
\end{verbatim}
- type in:

\begin{verbatim}
chmod g+rwx /var/lock
\end{verbatim}

Type \texttt{/sbin/reboot}

---

1. If you connect the cable with serial port 1, you have to use \texttt{ttyS0} instead of \texttt{ttyS1}
12.3.4.1 View/change the prom parameters

1. Open a shell and become root
2. Type `cu -lttyS1`
   → You will get the prompt `connected` and you can see the CCU output messages:
   a) Push the reset button of the CCU
   b) Press `Control-C` to interrupt the boot process
      The CCU will be in Monitor Mode now, the prompt will change to `>>`, type:
      `>> printenv`
      You will get a list of environment variables, the most important are:
      ```
      netaddr=149.236.99.99
      netmask=0xffffff00
      bootfile=bfs()/usr/diskless/clients/spect/root/unix.r4600_std
      bootmode=c
      ```
      These values must be shown as specified above. You can set the environment variables as follows:
      ```
      >> setenv netaddr 149.236.99.99
      >> setenv netmask 0xffffff00
      ```
      To boot the CCU again, type:
      `>> u`
   c) To exit the `cu` program type:
      `>> .Enter` (press the keys: tilde, dot, Enter)

12.3.4.2 Viewing the boot process

When all environment parameters are correct, you can view the boot process and see where it hangs. This might give you an indication as to what the problem is.

---

1. For CCU 4-7 the bootfile entry is:
   `bootfile=bfs()/usr/diskless/clients/spect/root/unix.r3004_std`
2. If the `netaddr` is different, the spectrometer network files must be adjusted. However, when you install the DISKLESS package the entries are set back to `149.236.99.99` and your CCU will not boot anymore. Therefore we strongly recommend not to change the `netaddr`. 
1. Open a shell and become root
2. Type `cu -lttyS1`
   → you will get the prompt *connected* and after typing *Enter* you can see the CCU output
3. Push the reset button of the CCU

   The CCU will try to boot now. The output of the boot process is listed below. The marks ‘---?---’ indicate positions where the boot process possibly hangs or goes into an endless loop:
   
   `Autoboot: Waiting to load`
   `bfs() /usr/diskless/clients/spect/root/unix.r4600_std`
   `(CTRL-C to abort)`
   `loading`

   ---1---
   
   `Obtaining /usr/diskless/clients/spect/root/unix.r4600_std from server c85`
   `851056+115728+824448 entry: 0x80021000`
   `CPU: MIPS R4700 Processor Chip Revision: 1.0`
   `FPU: MIPS R4700 Floating Point Unit [CP1] Revision: 1.0`
   `RISC/os Release 4.52 mips Version UMIPS`
   `Total real memory = 16777216`
   `Available memory   = 14356480`

   ---2---
   
   `Root on nfs file : Swap on nfs file :`

   ---3---
   
   `hostname: spect`
   `domainname: dummy`

   ---4---
   
   `Root fstype nfs`
   `Available memory   = 12705792`

   ---5---
   
   `Root on nfs file : Swap on nfs file :`

   ---6---
   
   `The system is coming up. Please wait.`
   `ASP_ST2:/usr/diskless/clients/spect/var mounted on /var`
   `ASP_ST2:/usr/diskless/dl_usr mounted on /usr`
Booting might hang, stop (and print an error message) or go into an endless loop at one of the positions 1 through 5. This might be caused by one of the problems mentioned below. Check the indicated files and correct them if necessary or perform the indicated steps.

a) If booting stops at position ---1--- you might have one of the following problems:
   - the *bfsd* is not running; go to 12.3.2.1, step 7
   - the DISKLESS packages is not installed; see chapter 12.3.2.1, step 11
   - the network is not set up correctly; check the configuration (see chapter 10.3.1)

   If the problems above do not exist, please enter the following command in a shell:

   ```bash
   /sbin/arp -a
   ```

   The output should contain a line like:
   ```plaintext
   spect (149.236.99.99) at a.b.c.d.e.f [ether] on eth1
   ```
   where *a.b.c.d.e.f* is a hexadecimal hardware ethernet address of the CCU

b) If booting stops at position ---2--- please try the following:
   - push the CCU reset button
   - type Ctrl-C to interrupt the boot process and enter:
     ```plaintext
     >> setenv bootmode m
     >> setenv bootmode c
     ```
   - push the CCU reset button

c) If booting stops at position ---3--- one of the following problems exist:
   - the CCU (hostname spect) is searched for on a nameserver first:
     The search order is determined by hosts:
     ```plaintext
     /etc/nsswitch.conf: hosts: files dns nisplus
     ```
     Make sure the first location to be searched is the local `/etc/hosts` file as specified by the entry `files` as specified above.
the network is not set up correctly; check `/etc/hosts`, `/etc/boot-params`.

the swapfile does not exist; check the file
`/usr/diskless/clients/spect/swapfile`
If the file does not exist please refer to chapter 12.3.3.2.

start of bootparam fails; check if `bootparam` is active right now¹:
`ps -ef | grep bootparam`
Does the answer show the two processes `rpc.bootparam` and `grep bootparam`?
Yes? Continue with the troubleshooting list
No? Do the following:

start `bootparam` right now:
```
  service bootparam start
```
and check what is the general configuration for bootparam:
`/sbin/chkconfig --list bootparam`
If the entry for 5 is off, activate it in general:
`/sbin/chkconfig --level 5 bootparam on`

edit the file `/etc/hosts.allow` and add the line
```
ALL: spect
```

d) If booting stops at position ---4--- one of the following problems exist:

NFS is not running; see chapter 12.3.2.1, step 5

diskless partitions are not exported; see chapter 12.3.2.1, step 8

the network is not set up correctly; check the file `/etc/hosts`

e) If booting stops at position ---5--- or ---6--- with the following error message please do like described:
```
mount root ASP_ST2:/usr/diskless/clients/spect/root failed, rpc status 15
```

¹. Note that in case the laboratory network is not active, starting of the bootparam might fail.
For checking the network you can use the command `/sbin/mii-tool`. The output shows if the ethernet cards are connected and working properly.
PANIC: vfs_mountroot: cannot mount root'
you had to check the file ( see chapter 12.3.3.1)
/etc/xinetd.d/bootparamd

f) If booting is very slow or hangs at an arbitrary point you might have a hard-
ware problem (see chapter 12.3.2.2).

4. To exit the cu program type:
   >> ~/.Enter (press the keys: tilde, dot, Enter)

12.3.4.3 Running CCU diagnostic tests

1. Open a shell and become root
2. Type cu -lttyS1
   → you will get the prompt connected and you can see the CCU output:
   a) Push the reset button of the CCU
   b) Press Control-C to interrupt the boot process
      The CCU will be in monitor mode now, the prompt will change to >>
      >> setenv bootmode m
c) Push the CCU reset button
      The CCU diagnostic tests will start automatically. If one or more diagnostic
tests fail, the CCU could be broken. If they are all passed successfully, your
CCU seems to be okay. The bootmode is automatically set back to its normal
value c.
d) To exit the cu program press:
   >> ~/.Enter (press the keys: tilde, dot, Enter)

12.4 General steps that you can try to locate or solve problems

12.4.1 Check the WWW for FAQ’s, known bugs or known problems

The Bruker WWW pages contain a large amount of information about known
errors and problems:

1. Start your WWW browser
2. Go to the Bruker home page: www.bruker-biospin.de
3. Click Analytical → NMR → Software
4. Click on FAQ or Bugs

Note that you need an account to enter these pages. If you do not have one, click on WW account and fill out the form to get a free account.

12.4.2 RED HAT help

1. Manual Pages: help on Linux commands
   - Click red hat → Documentation
     a konqueror window will appear that offers a description of Linux commands
   - Type man <command>, e.g. man find

12.4.3 Checking the history of TopSpin

The history function keeps track of all the commands you have entered in TopSpin and of all error messages. This can be very useful if you discuss a problem with your Bruker service or support person.

- Enter hist in TopSpin
  you will get a window with the information about the two history files and the contents of these files. You can use this window to copy-and-paste error messages into your email to Bruker BioSpin.

The history file:
<TOPSPIN_HOME>/prog/curdir/<USER_NAME>/history
is automatically re-initialized (overwritten) when TopSpin is started and the previous one is store as history.old

12.4.4 Rebooting the PC

Rebooting the PC workstation is a quick and efficient way to kill and restart any hanging processes. Perform the following steps:

1. Check who is logged in: type who
   → warn all users who are logged in that you are going to shutdown the system
2. Shutdown the computer: type /sbin/shutdown
3. When the computer is down, switch it off; push the power button
4. Switch the computer on, it will boot automatically

12.4.5 Rebooting the PC and the CCU with ‘reviveccu’

If you have any kind of communication problem between the PC and the spectrometer CCU, it is always a good idea to reboot both.

1. Check who is logged in; type `who`
   → warn all users who are logged in that you are going to shutdown the system
2. Become superuser: type `su`
3. Type `reviveccu`
   → follow the instructions:
   a) You will be asked to switch off the acquisition rack
   b) reviveccu will automatically reboot the PC
   c) Switch on the acquisition rack after the PC has rebooted

12.5 Various problems in Linux

12.5.1 The entire screen is frozen

If you have lost mouse control on the entire screen, there are several things you can do. The following steps are increasingly drastic; perform the next higher step only if the previous one didn’t help.

1. Press the Escape key: `Esc`
2. Press the three keys: `Ctrl-Alt-F1` simultaneously
   • this will open a text console, you may login as root and enter `init 3` and then `init 5`, if this does not work ...
   • ... press the three keys: `Ctrl-Alt-Delete` simultaneously
     → this will reboot the system
3. If the system is connected to the network, log in as root via ssh from a different host and type `/sbin/reboot`

1. To force a file system check after the reboot you can use the command `shutdown -F`
→ this will reboot the PC

4. Push the power button, this is not dangerous in case the Linux system uses an ext3 file system

Important: before you reboot or shutdown the system, first check who is logged in if this is still possible: type `who`. Warn all users who are logged in that you are going to shutdown the system.

12.5.2 Programs like shmrm, reviveccu and touser are not found

These programs are delivered with TopSpin and are executed by the superuser from a shell. However, if you become superuser with the command `su`, the programs may not be found. You can solve this problem in two different ways:

1. Become superuser with the command `su -` or

2. Log out and log in as root

   Now the programs `shmrm, reviveccu, touser` etc. can be typed in from any directory and will always be found.

12.5.3 Xserver does not start after reboot / not enough disk space available

In case the Xserver does not start after a reboot of the Linux PC, the cause could be that the harddisk is 100% full. In every user’s home directory there is a file called `.xsession-errors` that could contain a lot of error messages and become very big (xGB!). It is possible to delete this file with the shell command:

```
rm -rf .xsession-errors
```

Note: After deleting this file you have to log out to free the reserved disk space.

It is helpful to check these files and of course the core file which are named as core.<pid> under Linux. To find them, you can use the command:

```
find / -name core.* -print
```
12.6 Trouble under Linux

A selection of some important problems that could occur under Linux are described in this chapter.

12.6.1 You cannot log in as normal user

There are several possible reasons why you cannot login as normal user. First find out if other normal users can log in. If they can, the problem is user specific:

1. Your password is wrong
2. One of your personal setup files is corrupt. Check the files:
   - /home/<user>/.desktop-<hostname>/log
   - /var/log/messages

12.7 Useful configuration hints

In this chapter you can find some useful configurations of the XF86Config file.

1. Definition of the font path

In the file /etc/X11/XF86Config you can add an information about the location of the fontpath, which make it easier for programs to find the necessary fonts:

```
... 
Section "Files"
   RgbPath "/usr/X11R6/lib/X11/rgb"
   FontPath "unix:/7100"
EndSection
...
```

2. Definition of the two possibilities USB and PS/2 to connect the mouse. If this configuration is used, you should not use anymore the hardware configuration tool 'kudzu' for configuration of the mouse.

```
Section "ServerFlags"
...
   AllowMouseOpenFail
...
```
EndSection
...
Section "InputDevice"
 Identifier "Mouse1"
 Driver "mouse"
 Option "Device" "/dev/input/mice"
 Option "Protocol" "IMPS/2"
 Option "Emulate3Buttons" "off"
 Option "ZAxisMapping" "4 5"
EndSection
Section "InputDevice"
 Identifier "DevInputMice"
 Driver "mouse"
 Option "Device" "/dev/psaux"
 Option "Protocol" "IMPS/2"
 Option "Emulate3Buttons" "off"
 Option "ZAxisMapping" "4 5"
EndSection
...
Section "ServerLayout"
 Identifier "AGP"
 Screen "Screen AGP"
 InputDevice "Mouse1" "CorePointer"
 InputDevice "DevInputMice" "SendCoreEvents"
 InputDevice "Keyboard1" "CoreKeyboard"
EndSection
12.8 Spectrometer hardware tests

The *TopSpin* DVD contains various programs to test the spectrometer hardware components.

12.8.1 Spectrometer internal boards

Test programs for spectrometer internal boards like RCU, TCU, FCU etc. are started on the CCU.

1. Type `telnet spect` and log in as root
2. Type `/u/systest/rcu/rcutest` (to test the rcu)

After starting a test, type `h` to get help or type `auto` to run a complete test. The tests for the other boards are started in the same way, just replace the names accordingly.
Chapter 13

Important Linux features

13.1 The Boot Floppy

13.1.1 Creating a boot floppy

During installation process you were asked if you wanted to create a boot floppy. If you want to create a boot floppy after the installation, you have to get the information about the ‘operating system release’ first. The command mkbootdisk uses this information and will create a boot floppy.

1. Open a shell and enter `uname -r`
2. The output of this command looks like `w.x.y-z`, e.g. `2.4.2-2`
3. Enter `mkbootdisk <output_of_uname-r>` in the example above `mkbootdisk 2.4.2-2`

! Store your boot floppy in a safe place!
### 13.2 Important Commands

#### 13.2.1 rpm

 calls the Red Hat package manager which manage the installation of software packages.

- `rpm -q ABC` → list version of installed package *ABC*
- `rpm --help` → list options and their description for the rpm command
- `rpm -qa` → list all installed programs
- `rpm -Uvh abc` → install or upgrade the rpm package *abc*. This action is silent and shows #-marks as display of progress
- `rpm -Fvh abc` → upgrade the rpm package *abc*. Does not install any new packages. This action is silent and shows #-marks as display of progress
- `rpm -Va` → list all files of the default installation which are modified since the installation
- `rpm -qi ABC` → list informations of version and installation of package *ABC*
- `rpm -ql ABC` → list informations of installed files of package *ABC*

#### 13.2.2 cd

`cd` : "change directory"

- `cd` → change to your home directory
- `cd dira` → change to directory *dira*
- `cd /u/data/guest/nmr` → change to directory */u/data/guest/nmr*
- `cd dataseta` → change to directory */u/data/guest/nmr/dataseta*
- `cd ..` → change to directory */u/data/guest/nmr*
- `cd ../../usera/nmr` → change to directory */u/data/usera/nmr*
13.2.3 ls
ls: list the contents of a directory

- `ls` → list files and subdirectories in current directory
- `ls -l` → list complete file information
- `ls -al` → also list files starting with ‘.’
- `ls -Rl` → also list the contents of all subdirectories
- `ls -lt` or `ls -lrt` → sort by time of last modification

13.2.4 chmod
chmod: change the permissions of a file or directory
(To understand the permissions and type of access please refer to chapter 14.1)

1. using the character representation: `chmod [ugo][+-][rwx] filename`
   - `chmod a+r fila`
     make fila readable for all users
     `-r--r--r-- user group 102 Apr 10 12.20 fila`
   - `chmod a+w fila`
     make fila writable for all users
     `-rw-rw-rw- user group 102 Apr 10 12.20 fila`
   - `chmod ug+x fila`
     make fila executable for the owner and the group
     `-rwxrwxrw- user group 102 Apr 10 12.20 fila`
   - `chmod o-w fila`
     make fila not writable for others
     `-rwxrwxr-- user group 102 Apr 10 12.20 fila`
• **chmod \-R +w dira**
  make the directory tree dira, including all files and sub directories, writable for all users

2. using the numerical representation: **chmod xxx filename**

• **chmod 444 fila**
  make fila readable for all users
  `r--r--r--` user group 102 Apr 10 12.20 fila

• **chmod 222 fila**
  make fila writable for all users
  `--w--w--w` user group 102 Apr 10 12.20 fila

• **chmod 640 fila**
  make fila read/write for the owner, read for the group
  `-rw-r-----` user group 102 Apr 10 12.20 fila

• **chmod 751 fila**
  make fila read/write/execute for the owner, read/execute for the group and execute for others
  `-rwxr-x--x` user group 102 Apr 10 12.20 fila

• **chmod \-R 222 dira**
  make the directory tree dira, including all files and sub directories, writable for all users

13.2.5 **chown / chgrp**

  *chown / chgrp*: change the owner/group of a file or directory. The output of:
  `ls -l filea` or
ls -ld dira shows the result.

- change the owner of the file fila to usera
  chown usera fila
  -r--r--r-- usera system 102 Apr 10 12.20 fila

- change the group of the file fila to grpa
  chgrp grpa fila
  -r--r--r-- usera grpa 102 Apr 10 12.20 fila

- change the owner of directory dira to usera
  chown usera dira

- change the owner of directory tree dira to usera, including all files and subdirectories
  chown -R usera dira

- change the group of directory tree dira to grpa
  chgrp -R grpa dira

- set the owner and group of the directory tree dira to usera and grpa
  chown usera.grpa dira
  -rwxr-xr-x usera grpa 102 Apr 10 12.20 dira

13.2.6 grep

grep: search for a string in a text file and show the lines containing this string

- search for string stringa in the file fila
  grep stringa fila
• search for `stringa` in all files in the current directory
  \[\text{grep } \text{stringa } *\]

• search for `stringa` in all files AND directories in the current directory
  \[\text{grep } -r \text{stringa } *\]

• search for `stringa` in all files which starts with `a`, `b`, `c` or `d`
  \[\text{grep } \text{stringa } [a-d] *\]

• print the lines in fila not containing `stringa`
  \[\text{grep } -v \text{stringa } \text{fila}\]

• ignore upper/lower case in `stringa`
  \[\text{grep } -i \text{stringa } \text{fila}\]

• search for `stringa` or `stringb` in the file `filea`
  \[\text{grep } -i \text{"stringa|stringa" } \text{fila}\]

• search for `stringa` in the output of a command, e. g. `ps -ef`
  \[\text{ps } -efw| \text{grep } \text{stringa}\]

13.2.7 find

**find**: search for files and directories in a directory tree

• search for entries (files and directories) called `fila` in the directory tree `dira`
  \[\text{find } \text{dira } -\text{name } \text{fila } -\text{print}\]

• search for `fila` on all local partitions, not on NFS mounted partitions
find / -local -name fila -print

- search for entries that start with a
  find dira -name "a*" -print

- search for entries not called fila
  find dira ! -name fila -print

- search for entries newer than the file fila
  find dira -newer fila -print

- search for files bigger than 1000 blocks
  find dira -size +1000 -print

- run a Linux command (e.g. rm, lp) on all entries fila
  find dira -name fila -exec lp {} \;

  for example to delete 2D processed data: 2rr, 2ri, 2ir and 2ii in /opt/topspin:
  find /opt/topspin -name "2[ir][ri]" -exec rm {} \;

13.2.8 ps

ps: show the Linux process table

- show all processes
  ps -efw

  UID   PID  PPID  C   STIME   TTY   TIME   CMD
  root   0    0     0 14:01:12 ?   0:01  sched
  root   1    0     0 14:01:12 ?   0:00  /etc/init
  root 164   1    0 14:01:48 ?   0:00  /usr/etc/nfsd 4
13.2.9 kill

kill: terminate a Linux process

(for a graphic tool use <red hat> → System → KDE System Guard)

- kill processes with PID 1149, 1151 and 1143
  
  kill 1149 1151 1143

- kill directly processes with PID 1149, 1151 and 1143
  
  kill -9 1149 1151 1143

Use **kill -9 PID** only if **kill PID** does not kill the process!

13.2.10 compress, gzip

compress, gzip, bzip: compression to reduce the size of a file

File compression can be used to:
Important Linux features

- save disk space on rarely used files
- reduce network traffic (e.g. `rcp`, `ftp`, E-mail)

- compress a file, `fila` is replaced by `fila.Z`
  ```
  compress fila
  ```

- uncompress a file, `fila.Z` is replaced by `fila`
  ```
  uncompress fila
  ```

- compress a file, `fila` is replaced by `fila.gz`
  ```
  gzip fila
  ```

- uncompress a file, `fila.gz` is replaced by `fila`
  ```
  gunzip fila
  ```

- compress a file, `fila` is replaced by `fila.gz`
  ```
  bzip2 fila
  ```

- uncompress a file, `fila.gz` is replaced by `fila`
  ```
  bunzip2 fila
  ```

Some remarks:
- Uncompression does not require the suffix `.Z` or `.gz`
- compression factor depends on the file type (20-70%)
- `gzip` gives a better reduction in size than `compress`
- many files on the Bruker FTP server have the extension `.gz`, which means they have been compressed with `gzip`
13.2.11 tar

**tar**: This command allows to convert a directory (tree) into a file. This is a convenient tool for attaching many files to an email or transferring them via ftp

- copy the directory-tree `dira` into the file `dira.tar`
  
  ` tar cvf dira.tar dira`

- extract `fila` from `dira.tar`
  
  ` tar xvf dira.tar fila`

- copy the directory-tree `dira` into the file `dira.tar` and compresses (gzip) the file
  
  ` tar cvzf dira.tar.gz dira`

- copy the directory-tree `dira` into the file `dira.tar` and compresses (bzip2) the file
  
  ` tar cvjf dira.tar.bz2 dira`

- extract `fila` from compressed file `dira.tar.gz`
  
  ` tar xvzf dira.tar.gz fila`

- list the occurrences of `fila` in `dira.tar`
  
  ` tar tvf dira.tar fila`

- append `filb` to the end of the archive
  
  ` tar rvf dira.tar filb`

- append if `fila` does not exist in `fila.tar` or if it exists but has been modified
  
  ` tar uvf dira.tar fila`

- you can copy with relative pathnames e.g.
Important Linux features

```
  cd /u/data/guest/nmr
  tar cvf dataseta

  • or with absolute pathnames e.g.
    tar cvf /u/data/guest/nmr/dataseta
```

13.3 Important Files

13.3.1 `/etc/shadow`

the file `/etc/shadow`:

• contains the complete password information

• has one line for each user (account) on the system, each line contains 9 fields separated by colons

• example

  
  root:*$1$Oz.sVA5j8yMP3jpXgNT1jLT06CZ7QK1:11432:0:99999:7:::
  bin:*:11432:0:99999:7:::
  daemon:*:11432:0:99999:7:::
  adm:*:11432:0:99999:7:::
  lp:*:11432:0:99999:7:::
  sync:*:11432:0:99999:7:::
  shutdown:*:11432:0:99999:7:::
  halt:*:11432:0:99999:7:::
  mail:*:11432:0:99999:7:::
  news:*:11432:0:99999:7:::
  uucp:*:11432:0:99999:7:::
  operator:*:11432:0:99999:7:::
  games:*:11432:0:99999:7:::
  gopher:*:11432:0:99999:7:::
  ftp:*:11432:0:99999:7:::
  nobody:*:11432:0:99999:7:::
nscd:!!:11432:0:99999:7:::
mailnull:!!:11432:0:99999:7:::
ident:!!:11432:0:99999:7:::
rpc:!!:11432:0:99999:7:::
rpcuser:!!:11432:0:99999:7:::
xfs:!!:11432:0:99999:7:::
gdm:!!:11432:0:99999:7:::
apache:!!:11535:0:99999:7:::
testuser:oaHKvUemEH3TE:11561:0::7:::0

meaning of the fields:
1. Login name
2. Encrypted password
3. Days since Jan 1, 1970 that password was last changed
4. Days before password may be changed
5. Days after password must be changed
6. Days before password is to expire that user is warned
7. Days after password expires that account is disabled
8. Days since Jan 1, 1970 that account is disabled
9. A reserved field

13.3.2 /etc/passwd

the file /etc/passwd:
- contains the complete login account information
- has one line for each user (account) on the system, each line contains 7 fields separated by colons

eample

root:x:0:0:root:/root:/bin/bash
bin:x:1:1:bin:/bin:
daemon:x:2:2:daemon:/sbin:
adm:x:3:4:adm:/var/adm:
lp:x:4:7:lp:/var/spool/lpd:
sync:x:5:0:sync:/sbin:/bin-sync
shutdown:x:6:0:shutdown:/sbin:/sbin/shutdown
halt:x:7:0:halt:/sbin:/sbin/halt
mail:x:8:12:mail:/var/spool/mail:
news:x:9:13:news:/var/spool/news:
uucp:x:10:14:uucp:/var/spool/uucp:
operator:x:11:0:operator:/root:
games:x:12:100:games:/usr/games:
gopher:x:13:30:gopher:/usr/lib/gopher-data:
ftp:x:14:50:FTP User:/home/ftp:
nobody:x:99:99:Nobody:/
nscd:x:28:28:NSCD Daemon:/sbin:/bin/false
mailnull:x:47:47::/var/spool/mqueue:/dev/null
ident:x:98:98:pident user:/bin/false
rpc:x:32:32:Portmapper RPC user:/bin/false
rpcuser:x:29:29:RPC Service User:/var/lib/nfs:/bin/false
xfs:x:43:43:X Font Server:/etc/X11/fs:/bin/false
gdm:x:42:42::/home/gdm:/bin/bash
apache:x:48:48:Apache:/var/www:/bin/false
testuser:x:1001:1003:testuser:/home/testuser:/bin/bash

meaning of the fields:
1: Login name
2: password
3: User Id; must be a unique number for each user
4: Group Id; must be a unique number for each group
5: Full Name: the users full name, may contain blanks
6: home directory: usually /home/"user", but can be different
7: shell; must contain full pathname e.g. /bin/sh or /bin/bash

In the field password there are several entries possible:

- the field is empty
  Security leak: the user has no password, everybody is able to login on this ac-
  count
- the field contains an encrypted password
  Security leak: the user has a password, everybody is able to read and proba-
  bly able to decrypt this password
- the field contains: *
  There is no password which translates to the encrypted password: *
  Nobody is able to login on this account
- the field contains: x (default configuration)
  The account has a shadow password. The encrypted password is written in
  the file /etc/shadow that is only readable for root (see chapter 13.3.1).
  This is the default setting on Red Hat Enterprise Linux WS 3

13.3.3 /etc/group

The file /etc/group

- contains the complete information for groups of login accounts
- has one line for each group on the system

Each line contains 4 fields separated by colons:

example

root::0:root
users::100:guest,jim
meaning of the fields:

1. the Group Name
2. encrypted group password; usually empty
3. group Id; must be unique for a group and the same on each host
4. the list of users who belong to this group, separated by commas

Why are users divided into groups?

You can share your files with users within your group and protect them from all other users.

The file /etc/group can only be changed by root.

### 13.3.4 .bashrc

The file `.bashrc`:

- sets your personal Linux environment
- is executed every time you log in
- resides in your home directory
- is used in connection with the shells `sh` and `bash`

You can edit the file `.bashrc` and add your personal preferences, e.g.:

- `umask 002`
- `PATH=$PATH:/home/guest`
- `NMR=/opt/topspin/data/guest/nmr`
- `export PATH NMR`
- `lr() { find $@ -name lr -ls }`
- `alias ts=topspin`

Now open a new shell:
• *umask* will be set to 002
• guests home directory is part of the Linux search path
• you can type `cd $NMR` instead of `cd /opt/topspin/data/guest/nmr`
• you can type `lr <dirA> <dirB>` for searching all files called *lr* in the directory trees `dirA` and `dirB`
• you can type `ts` instead of `topspin`

Note the difference between *NMR*, an environment variable and *xw*, a Linux function.

For *csh* and *tcsh* the file `cshrc` is used. Note that the setting of environment variables is handled differently.

### 13.3.5 umask

*umask*: set the initial permissions for file creation

the initial permissions of a file are set according to:

```markdown
permission = creation permission - umask
```

• the creation permissions are:
  666 for files created by an editor (e.g. *vi*, *emacs*)
  777 for an executable program, created by a compiler

• each user can set his own umask, e.g. in his `.profile`

examples

1. create a file *fila*, e.g. with *vi*, for different values of umask

---

1. *umask* can be set for all users in the file `/etc/profile` and `/etc/csh.login` (*sh* and *bash*) or `/etc/csh.cshrc` (*csh* and *tcs*)
Important Linux features

2. show the output of `ls -l fila`

- umask 000 → permissions 666
  -rw-rw-rw- 1 owner group 10 Jun 7 12:20 fila

- umask 002 → permissions 664
  -rw-rw-r-- 1 owner group 10 Jun 7 12:20 fila

- umask 024 → permissions 642
  -rw-r---w- 1 owner group 10 Jun 7 12:20 fila

- umask 666 → permissions 000
  ----------- 1 owner group 10 Jun 7 12:20 fila

13.4 Linux shells

A Linux shell:
- is a layer between the operating system and the user.
- offers the user a way to communicate with the OS.
- is selected upon installation of a new user

Type `echo $SHELL` to find out which shell you use!

different Linux shells and the files executed during login:
- `.profile`
  - `sh` and `bash` (also executes `.bashrc` if it exists)
- `.cshrc`
  - `csh` and `tcsh`

Important differences between shells:
- How do you set environment variables
194 Important Linux features

sh and bash:
1. _export_ variable=value

_csh_ and _tcsh_:
1. _setenv_ variable value

- _tcsh_ and _bash_ offer history substitution
  you can use the arrow keys to repeat and modify previously entered commands.

### 13.4.1 How to use the bash

- Open a shell and type in commands

- How to repeat a previously entered command
  1. use the _arrow keys_ to get a command back
  2. hit the _Enter key_ to execute the command again

- How to repeat and change a previously entered command
  1. use the _arrow keys_ to get a command back
  2. use the _arrow keys_ to move around in the line
     use _Control-a_ to move to the beginning of the line
     use _Control-e_ to move to the end of the line
  3. change the command according to your needs
  4. hit the _Enter key_ to execute the command

- How to search for previously entered commands:
  type _Control-r_ and enter a string or keyword to search for the last command
  containing that string by typing _Control-r_ again, you can search for earlier

1. type _man sh_ or _man csh_ for more information on these shells
Important Linux features

commands containing the same string

- Use <TAB> key for filename/command completion:
  Not sure how File or command is written? Just enter the first characters and press <TAB> key, e.g.:
  vi /etc/X11/XF<TAB> -> vi /etc/X11/XF86Config

- How to set the prompt in the bash
  The prompt can be changed by defining the environment variable PS1.
  1. type `cd` to change to your home directory
  2. edit (e.g. with vi) the file `.profile` and set PS1; you can include several items into the prompt, e.g.:
     a) the hostname of the computer:
        ```bash
        PS1='\h'
        ```
     b) the logname of the user:
        ```bash
        PS1='\u'
        ```
     c) the current directory:
        ```bash
        PS1='\w'
        ```
     d) the last part of the current directory:
        ```bash
        PS1='\W'
        ```
     e) certain characters, e.g.:
        ```bash
        PS1=hello or PS1=% or PS1='>'
        ```
     f) a combinations of the items above, e.g.:
        ```bash
        PS1='\h:\w>'
        ```

  in case of the last example the prompt will look like:
  `<hostname> : /u/data/guest >`

1. characters which have a special meaning in Linux, e.g. `<`, `>`, `\`, and `;` must be quoted
3. save the file and leave the editor
4. log out and log in again to see the effect of the change

The second prompt can be set be defining the variable $PS2$.
If you want to read the manual pages for the $bash$, type: `man bash`

### 13.5 Useful tips for Linux

#### 13.5.1 Configure the screen resolution with Xconfigurator

*NOTE:* It is possible to define the resolutions of the screen depending on the colour depth by the software package `Xconfigurator`. This tool removes all old entries in the respective configuration file `/etc/X11/XF86Config-4` and stores just those one, you are defining with `Xconfigurator`. This might cause some trouble, so it is strongly recommended to create a backup of the configuration file, e. g.:

```
/etc/X11/XF86Config-4.orig
```

before starting `Xconfigurator` (see below).

Bruker recommends not to use the software package `Xconfigurator`, manually adding the screen resolution entries in the configuration file is more safe (see e. g. description in chapter 12.7).

Starting `Xconfigurator`:
- Press `Ctrl`-`Alt`-`F1` to switch to text mode
- Login as root
- Go to the directory `/etc/X11`

```
    cd /etc/X11
```
- create a backup copy of all files starting with `XF86Config`
Important Linux features

13.6 How to avoid much typing in Linux

13.6.1 General

1. use environment variables, e.g.:
   NMR=/opt/topspin/data/usera/nmr
   export NMR
   these 2 lines can be entered in your file .bashrc
   Open a new shell and type cd $NMR to go to the corresponding directory.
2. use Linux functions, e.g.:
   data()
   {
   cd /opt/topspin/data/usera/nmr
   }
   this line can be defined in your file .bashrc

1. If you will have problems after the configuration, remove the new files XF86Config and XF86Config-4 and rename the backup copy of the original files to XF86Config resp. XF86Config-4

- cp XF86Config XF86Config.orig
- cp XF86Config-4 XF86Config-4.orig
- Type Xconfigurator
- Confirm a couple of questions and choose your monitor
- A window Probing finished occurs
- Choose the entry: Let Me Choose
- In the window Select Video Modes, you have to select all the different monitor settings that you want.
- Confirm the next questions and finish the Xconfigurator
- Back in the text mode type init 3
- Type init 5
   With Ctrl-Alt+ you can switch between the different monitor settings
Open a new shell and type `data` to execute the function.

3. use copy and paste
   - mark text by holding the left mouse button down
   - paste this text somewhere by clicking the middle mouse button

4. use the Linux shells `bash` or `tcsh`
   - use the arrow keys up/down to repeat and/or modify previously entered commands
   - use the Tab key to complete commands and paths

5. use a Linux shell script
   They are described in the next chapter 13.6.2.

13.6.2 Linux shell scripts
A shell script executes (a series of ) Linux commands:
   - is an executable text file
   - can contain a series of Linux commands
   - can contain control loops and variables

example
1. `scripta` displays the date, current directory and contents:
   edit a file `scripta` and enter:
   ```
   date
   pwd
   ls
   ```
   make scripta executable: `chmod a+x scripta`
   execute the script by typing `./scripta`
   When executing scripta a possible output is:
2. scriptb displays the contents of a pulse program:
   - edit the file scriptb and enter:
     
     ```bash
     dir=/opt/topspin/exp/stan/nmr/lists/pp
     cd $dir
     cat $1
     
     $dir = the value of a parameter which is set in the script
     $1 = an argument given to the script when it is executed
     ```
   - make the file executable: `chmod +x scriptb`
   - execute the script by typing its name and argument: `./scriptb zg30`

3. Example of a control and loop structure in a shell script: ¹
   ```bash
   for i in 'ls *.c'  # (for all files with the extension .c)
   do
     if grep strn $i  # (if the file contains the string strn)
       then
         rm $i          # (remove the file)
       fi
   done
   ```

¹ "./" means: the command resides in the current directory. You can skip the "/" if the current directory is part of the Linux search path. Type `echo $PATH` to see the Linux search path.

¹ For more information on control and loop structures type `man sh` or `man test`.  

Note: the first line of the script should be:

```bash
#!/bin/sh
```
13.6.3 cron - crontab

Any Linux command or program can be executed automatically on a regular basis.

check if crond is running: **ps -efw| grep crond**
if crond is not running: **service crond start**

create a crontab file using the following syntax:

`min hour daymo month daywk command`

- **min**: minute (0-59)
- **hour**: hour (0-23)
- **daymo**: day of the month (1-31)
- **month**: month of the year (1-12)
- **daywk**: day of the week (0-6 with 0=Sunday)
- **command**: the command or program to be executed

Suppose you want to:

- backup your data at 4.30 am on Tuesday to Friday
- delete all core files at 2 am on Sunday

Note that the second task needs root permissions.

a) type `cd` to go to your home directory
b) type `su` to become root
c) edit the file `fila` and enter the following lines:
   
   ```
   30 04 * * 2-5 tar cv /u/data/<user>/nmr
   00 02 * * 0 find / -name core -exec rm {} \;
   ```
d) type `crontab fila`

You can skip step b) if all tasks in your crontab file can be done as normal user.

Type **man crontab** for more information.
Chapter 14
File and directory handling

14.1 Permissions and Type of Access

14.1.1 Permissions of a file

The permissions of a file:
- determine what each user can do with the file
- are represented:
  - by a set of characters \(-, r, w\) and \(x\) or
  - by a set of numbers between \(0\) and \(7\)

\[1 = x = \text{file is executable}\]
\[2 = w = \text{file is writable}\]
\[4 = r = \text{file is readable}\]

The numbers \(3, 5, 6\) and \(7\) are combinations of \(1, 2\) and \(4\):
- e.g. \(7 = 4 + 2 + 1 = rwx\)
14.1.2 Permissions of a directory

The permissions of a directory are represented as follows:

1 = x = search
2 = w = write
4 = r = read

14.1.3 Types of Access

Each file has 3 sets of permissions for 3 categories of users:

- the actual owner (shortened 'u' like user)
- users who have the same group ID as the owner (shortened 'g' like group)
- users who have a different group ID than the owner (shortened 'o' like other)

14.1.4 Example

- Type `ls -l filename` to see the 3 sets of file permission
  
  e.g. `ls -l fila`
  
  `-rwxrw-r-- 1 jim sys 987 Sep 15 15:08 fila`

  The permissions of the file `fila` are 764:
  
  7 = rwx for the user `jim`
  
  6 = rw- for all users of the group `sys`
  
  4 = r- - for other users

- Use the command `ls -ld` to see the directory permissions.
  
  e.g. `ls -dl dira`
  
  `drwxr-xr-- 1 jim sys 987 Sep 15 15:08 dira`

---

1. the group attribute of a file can be changed with `chgrp`, the permissions of a file always refer to the group ID which is shown with `ls -l filename`
The permissions of the directory `dira` are 754:
- everybody can read ( = see) the directory `dira`, e.g. use `ls` on `dira`
- only the owner `jim` and members of the group `sys` can read and search e.g. use `cd`, `pwd`, `ls`, `cat`, `more`, `du`, `file` on or in `dira`
- only the owner `jim` can also write or remove files in `dira`, e.g. use `rm`, `cp`, `mv`, `touch` on files in `dira`

- In the following example the directories `dira`, `dirb` and `dirc` are assumed to be readable and searchable.
- creating files
  If the user `guest` wants to create the file `fila`, e.g. :
  ```bash
touch /dira/dirb/dirc/fila
  ```
  the directory `dirc` must be writable for `guest`, the parent directories `dirb` and `dira` do not have to be writable for `guest`
- removing files
  If the user `guest` wants to remove the file `fila`, e.g. :
  ```bash
rm /dira/dirb/dirc/fila
  ```
  the directory `dirc` must be writeable for `guest`, the parent directories `dirb` and `dira` do not have to be writable for `guest`. The file `fila` can have any permissions, even 000, and any owner or group, you can always remove it if its directory is writable!
Chapter 15
Useful tools for Red Hat Enterprise Linux WS 3

This chapter contains a description of some tools we found useful. We realize that many other tools are available for various purposes and we are very interested in your experiences. Just send your comments to:

nmr-software-support@bruker.de

15.1 How to use a memory stick under Linux

It is possible to use a USB-memory stick under Red Hat Enterprise Linux WS 3. In this chapter you can find a description how to activate this functionality.

All USB memory sticks are handled by the scsi disk driver, therefore you must detect which device is attached to the stick. The following steps should give you access to the USB memory:

15.1.1 PC with SCSI drives

1. Connect the USB stick.
2. Enter the command:
**dmesg**

You will get an answer like the following:

```
hub.c: new USB device 00:1f.4-2, assigned address 17
usb.c: USB device 17 (vend/prod 0xc76/0x5) is not claimed by any active driver.
Initializing USB Mass Storage driver...  
usb.c: registered new driver usb-storage
scsi2 : SCSI emulation for USB Mass Storage devices
Vendor:           Model:                   Rev:
   Type:   Direct-Access        ANSI SCSI revision: 02
Attached scsi removable disk sdc at scsi2, channel 0, id 0, lun 0
SCSI device sdc: 256000 512-byte hdwr sectors (131 MB)
sdc: Write Protect is off  
sdc: sdcl
WARNING: USB Mass Storage data integrity not assured
USB Mass Storage device found at 17
USB Mass Storage support registered.
```

The bold line give you a hint for the next step. This system has already two SCSI disks installed sda and sdb and your stick get the next: sdc.

3. Enter the line: `fdisk -l`

The answer is like the following:

```
Disk /dev/sda: 255 heads, 63 sectors, 2213 cylinders
Units cylinders of 16065 * 512 bytes

Device Boot Start End Blocks Id System
/dev/sda1  *  1 6 48163+  83 Linux
/dev/sda2  7 2083 16683522+  83 Linux
/dev/sda3  2084 2213 1044255  82 Linux swap

Disk /dev/sdb: 255 heads, 63 sectors, 4427 cylinders
Units cylinders of 16065 * 512 bytes

Device Boot Start End Blocks Id System
/dev/sdb1  *  1 523 4200966  83 Linux
/dev/sdb2  524 1046 4200997+  83 Linux
/dev/sdb3  1047 1569 4200997+  83 Linux
/dev/sdb4  1570 4427 22956885  83 Linux
```
Disk /dev/sdc: 50 heads, 32 sectors, 160 cylinders
Units cylinders of 160 * 512 bytes
Device Boot Start   End    Blocks   Id  System
/dev/sdc1  * 1  160  127952   6 FAT16
Partition 1 has different physical/logical endings:
phys=(26, 49, 32) logical=(159, 47, 32)

The /dev/sdc1 line is the needed info for the next step.

4. Create a corresponding entry in /etc/fstab:

/dev/sdc1     /mnt/memstick       auto    noauto,user     0 0

5. Don’t forget to create the mount point used in fstab (in the example from step 4 this is /mnt/memstick) and allow everybody to use that directory. This can be done with the following two commands:

mkdir /mnt/memstick
chmod a+rwx /mnt/memstick

6. For your convenience create a desktop icon.

a) Click right on the desktop and choose Create New → Hard Disc

b) a window Properties for HD.desktop will appear

c) in section General:

• choose a name for the new icon, e.g. memstick

• click on the icon symbol, in the upcoming window you can choose one that you enjoy

d) Select the Device tab and enter the correct path, in this example /dev/sdc1
15.1.2 PC with IDE drives

1. Connect the USB stick.
2. Enter the command:
   ```
   dmesg
   ```
   You will see something like this:

   USB Mass Storage device found at 2
   USB Mass Storage support registered.
   Attached scsi removable disk sda at scsi1, channel 0, id 0, lun 0
   **SCSI device sda: 1015808 512-byte hdwr sectors (520 MB)**
   sda: Write Protect is off
   sda: sda

   The bold line give you a hint for the next step. The stick on this system get: sda.

3. Enter the command:
   ```
   fdisk -l
   ```
   The answer is something like this:

   ```
   Disk /dev/sda: 16 heads, 62 sectors, 1024 cylinders
   Units = cylinders of 992 * 512 bytes
   Device Boot Start End Blocks Id System
   /dev/sda1 * 1 1024 507632 6 FAT16
   Partition 1 has different physical/logical beginnings (non-Linux?):
   phys=(0, 1, 1) logical=(0, 0, 33)
   Partition 1 has different physical/logical endings:
   phys=(958, 15, 32) logical=(1023, 7, 46)
   Partition 1 does not end on cylinder boundary:
   phys=(958, 15, 32) should be (958, 15, 62)
   ```

   ```
   Disk /dev/hda: 255 heads, 63 sectors, 9964 cylinders
   Units = cylinders of 16065 * 512 bytes
   Device Boot Start End Blocks Id System
   /dev/hda1 * 1 6 48163+ 83 Linux
   /dev/hda2 7 2046 16386300 83 Linux
   /dev/hda3 2047 2111 522112+ 82 Linux swap
   /dev/hda4 2112 9964 63079222+ 83 Linux
   ```

   The /dev/sda1 line is the needed info for the next step.
4. Create a corresponding entry in `/etc/fstab`:

```
/dev/sda1 /mnt/memstick auto noauto,user 0 0
```

5. Don't forget to create the mount point used in `fstab` (in the example from step 4 this is `/mnt/memstick`) and allow everybody to use that directory. This can be done with the following two commands:

```
mkdir /mnt/memstick
chmod a+rwx /mnt/memstick
```

6. For your convenience create a desktop icon.
   a) Click right on the desktop and choose *Create New → Hard Disc*
   
   ![Image of creating a desktop icon]
   
   b) A window *Properties for HD.desktop* will appear
   
   c) In section *General*:
   
   • choose a name for the new icon, e.g. *memstick*
   
   • click on the icon symbol, in the upcoming window you can choose one that you enjoy
   
   d) Select the Device tab and enter the correct path, in this example `/dev/sda1`

### 15.2 Firewall configuration

Red Hat Enterprise Linux WS 3 has a firewall package inside. You can activate and configure it during installation (see chapter 9.1) or in the running system.

Note that for acquisition the ethernet card for spectrometer control has not to be restricted by the firewall! For this it is strongly recommended to free the ethernet
card after activating the firewall (see below)!

The rules for the firewall, checked and executed during boot time, are stored in the file `/etc/sysconfig/iptables-config`

The rules in this file are:
- defined during installation (see chapter 9.1)
- added manually (see troubleshooting, chapter 12.3.2.1)
- added manually by using a graphical user interface (see the next chapter)

### 15.2.1 Firewall configuration

**Red Hat Enterprise Linux WS 3** offers a graphical user interface that allows you to define some firewall configurations. The following example describes a firewall configuration that allows **SSH** traffic on `eth0` and frees `eth1` completely.

1. Open a Linux shell
2. Become superuser
   - `su -`
   - enter superuser password
3. Type in
   - `redhat-config-securitylevel`
   - or click on
   - `SystemSettings → Security level`

---

1. In **Red Hat Enterprise Linux WS 3** there is also another possibility for the firewall settings: `/etc/sysconfig/iptables`
Useful tools for Red Hat Enterprise Linux WS 3

4. Select under **Security level** the entry **Enable firewall**
5. Select under **Trusted Services** the entry **SSH**
6. Select under **Trusted devices** the entry **eth1**
7. The window now looks like this, click on **OK**

8. The window **Warning** will appear

Click on **Yes**
Now the configuration of the Firewall is finished and your system is protected right now.

Note that this tool described here allows not a very specific configuration, but it is useful for a quick and secure setting. In case you like to free another service like smb you can use the start command

`redhat-config-securitylevel-tui`

(note that the securitylevel-tui is one word and contains no space)

A window appears wherein you can define the same rules as above described but you get an additional field called 'Other ports'.

Another useful tool is the freeware guarddog that can be downloaded from:

`http://www.simonzone.com/software/guarddog/`

All these three ways that were described in this chapter uses the firewall tool of `RED HAT ENTERPRISE LINUX WS 3 iptables`. With `iptables` it is possible to define a very complex firewall installation.

### 15.3 Tools for internal communication

If the Linux NMR workstation should be used as server, the following packages should be installed:

<table>
<thead>
<tr>
<th>Package</th>
<th>on CD</th>
<th>Necessary for</th>
</tr>
</thead>
<tbody>
<tr>
<td>xinetd</td>
<td>RED HAT ENTERPRISE LINUX WS 3 Operating System CD 2 of 4</td>
<td>&quot;superserver&quot; for several servers</td>
</tr>
<tr>
<td>telnet-server</td>
<td>RED HAT ENTERPRISE LINUX WS 3 Operating System CD 3 of 4</td>
<td>for telnet logins</td>
</tr>
<tr>
<td>vsftpd</td>
<td>on TopSpin 1.3 Linux CD in /linux/rpm</td>
<td>for ftp sessions</td>
</tr>
<tr>
<td>rsh-server</td>
<td>RED HAT ENTERPRISE LINUX WS 3 Operating System CD 3 of 4</td>
<td>for rlogin and rsh</td>
</tr>
<tr>
<td>samba</td>
<td>RED HAT ENTERPRISE LINUX WS 3 Operating System CD 2 of 4</td>
<td>to export directories to Windows</td>
</tr>
<tr>
<td>samba-swat</td>
<td>on TopSpin 1.3 Linux DVD in /linux/rpm</td>
<td>to configure samba</td>
</tr>
</tbody>
</table>
15.3.1 Installation description of an additional package: xinetd

Other packages are installed similarly

1. Check if xinetd is installed so far
   - `rpm -q xinetd`
   - is the output like this
     `xinetd-<version-number>`
   - Yes? You can skip this chapter
   - No? Go to step 2.

2. Insert Red Hat Enterprise Linux WS 3 Operating System CD 2 of 4

3. Click <red hat> → System Tools → More System Tools → File Manager - Super User Mode

4. A window run as root - KDE su will appear
   - enter root password

5. A window file:/root - Konqueror will appear
   - go to file:/mnt/cdrom/RedHat/RPMS

6. Search for the entry xinetd-<version-number>.i386.rpm

7. Double click xinetd<version-number>.i386.rpm

8. A window Completed System Preparation will appear
   - click Continue

9. Close the Konqueror window file:/mnt/cdrom/RedHat/RPMS

10. To eject the CD click right on the CD icon on the desktop and choose eject

15.3.2 Check if all necessary components are installed

To check if all necessary components are installed, please type

```
/sbin/chkconfig --list
```

on a shell and if these lines are exists

---

1. A detailed description of a software installation is described in chapter 9.2.1.1
2. If a process like this is not started, start it on a shell by typing `/sbin/chkconfig <process> on`
15.4 Setting up permissions for rsh, rlogin and rcp

The commands `rcp`, `rlogin` and `rsh` require special access permissions. There are two ways to set up these permissions.

1. The system administrator can setup up these permission for all users:
   a) Open a shell
   b) Type `su` to become superuser
   c) `cd /etc`
   d) Edit the file `hosts.allow`

   Make two entries for every remote host from which access is allowed, e.g.:
   ```
   sunflower
   sunflower.netx.lab.com
   ```

2. As a normal user, you can allow remote access from a remote host for yourself:
   a) Open a shell
   b) Go to your home directory; type `cd`
   c) Edit the file `.rhosts`

   Make two entries for every remote host from which access is allowed, e.g.:
   ```
   sunflower
   sunflower.netx.lab.com
   ```
   d) `chmod 644 .rhosts`

1. For installation please see chapter 15.3
In both examples sunflower is the hostname and netx.lab.com is the domainname of the remote host.

To allow rcp, rsh and rlogin network wide in all directions, you must setup the file /etc/hosts.allow or .rhosts on each host.

### 15.5 Creating a screenshot of the desktop

There are several programs that offer the possibility for creating a screenshot of the desktop or of individual windows.

- Click on <red hat> → Graphics → Screen Capture Program

or the program Gimp:

- Open a Linux shell and type in gimp

  Inside gimp you has to go to File → Acquire → Screen Shot ...

### 15.6 Creating an icon on the desktop

For a more convenient using of Red Hat, it is recommended to create icons of frequently used commands on the desktop

#### 15.6.1 Create an icon for opening a pdf file with Acrobat Reader

1. Click right mouse button on the desktop

   - a popup window appears
• choose Create New → Link To Application

• a window Properties for Program.desktop will appear

• in section General:
  • choose a name for the new icon, e.g. Installation Guide
  • click on the icon symbol, in the upcoming window you can choose one that you enjoy
  • in section execute:
    • type in the command for opening the manual in a shell:
      ```
      acroread /opt/topspin/prog/docu/english/xwinproc/pdf/install_guide_linux.pdf
      ```
      (if case you have installed TopSPIN in the default directory /opt/topspin)
15.7 Red Hat Network: Hotfixes to keep the system secure

The license agreement of RED HAT ENTERPRISE LINUX WS 3 demanded to register the PC to the Red Hat Network service. A description how to register and how to use the Red Hat Network can be found in the following chapters.

You have to do the activation of the license key first and the registration at Red Hat Network as a second step!

15.7.1 Activate your Linux license at Red Hat Network

1. Start mozilla
2. Enter the URL
   \[http://redhat.com/now\]
   you will see the following web side

3. If you are not registered so far or you want to use an additional account, click on
   * New Log In
4. The window changes to

Enter all required information (fields marked with a small red asterisk). At the bottom of the window click on

- **Create Login**

5. The window changes to

6. In the field Product ID Number enter your license key for **Red Hat Enterprise**
PRISE LINUX WS 3

7. The window changes to

8. you have successfully activated your license code, you can now go to next chapter and register the PC to the Red Hat Network

15.7.2 Register the PC to the Red Hat Network

1. Log in as root
2. Open a Linux shell and enter
   - Click `up2date`
3. If you are not registered to Red Hat Network so far, the window Red Hat Network Registration will appear
   - Click Register with RHN
4. The window *Red Hat Network Configuration* will appear

- Click on the tab pane *Retrieval / Installation*

5. The window changes to *Retrieval / Installation*
   - Disable the entry
     
     *Do not upgrade packages when local configuration file has been modified*

- Click on the tab pane *Package Exceptions*

6. The window changes to *Package Exceptions*
• Click on the entry kernel and click on Remove

![Remove kernel window](image)

• Click OK

7. The window Question will appear

![Question window](image)

• Click Yes

8. The window Welcome to Red Hat Update Agent will appear

![Welcome window](image)

• Click Forward
9. The window will change to Review the Red Hat Privacy Statement

   ![Review the Red Hat Privacy Statement]

   - Click **Forward**

10. The window will change to Login

   ![Login]

   Enable **Use Existing Account** and enter the username and password that you have specified in chapter 15.7.1

   - Click **Forward**
11. The window will change to **Register a System Profile - Hardware**

- Click **Forward**

12. The window will change to **Register a System Profile - Packages**

- Click **Forward**

13. The window will change to **Send Profile Information to Red Hat Network**

- Click **Forward**
If you have already activated your license code as it is described in chapter 15.7.1, the process will go on with updating your system. Just follow the instructions given. If you have not done the activation so far, the following information window would appear.

15.7.3 Activate the Red Hat Alert Notification Tool

RED HAT ENTERPRISE LINUX WS 3 offers a convenient tool that checks automatically the available security fixes that can be downloaded. If there are any of those packages available or if the connection to Red Hat Network not working, he shows a blinking, red exclamation mark at the lower right side of the desktop.

If the system is up-to-date and the connection to the Red Hat Network is fine, it shows a friendly white hook in a green circle

To activate this tool proceed as follows:
1. Log in as root
2. Click on the icon at the lower right side of the desktop

3. The window Red Hat Network Alert Notification Tool will appear

- Click **Forward**

4. The window Terms of Service will appear

- Click **Forward**
5. The window *Proxy Configuration* will appear

![Proxy Configuration window]

If you use a proxy server enter the required information, if not just leave the fields empty

- Click **Forward**

6. The window *Configuration Complete* will appear

![Configuration Complete window]

- Click **Apply**

### 15.8 The Emergency Recovery CD / Image CD

Each PC which is delivered from Bruker Germany has a license for the backup tool *Symantec Norton Ghost 2003*. With this software and the CD-Writer of the PC it is possible to create a one-to-one backup of the harddisk of the system. Because *Norton Ghost 2003* does not support GRUB boot loader, the PCs are still delivered with LILO.

It is recommended to periodically create a backup of the harddisk. In case of any problems (harddisk crash, virus, hacker attack ...) you are able to rebuild the situa-
tion of your last backup within a few minutes.
In order to create the Emergency Recovery DVD under Linux it is necessary to produce a bootable floppy disk, called Rescue Disk.

15.8.1 Creating a boot floppy
If you create an Emergency Recovery Disk, it is recommended to also create a boot floppy. For this follow the instructions given in chapter 13.1.1

15.8.2 Creating the Rescue Disk
1. Login as root (only root has the icon Ghost2003 on the desktop)
2. Preposit one empty floppy disk
3. Click on the icon Ghost2003 on the desktop
   This will activate the script that creates the Rescue Disk. You will be asked for inserting the floppy disk.

15.8.3 Creating the Emergency Recovery CD
1. Insert the Rescue Disk into the PC
2. Reboot the PC
3. Nowadays it is not the default that a PC is booting first from floppy. In this case you might have to perform two steps to activate this feature.
   • change the boot order to boot first from floppy (during the boot-time of the PC you can choose to switch into this configuration)
   • change the BIOS settings to allow to boot from floppy (during the boot-time you can choose to switch into BIOS setup)
   On the HPxw4100 currently delivered by Bruker Germany you can switch into the BIOS setup by pressing F10 (F9 would offer the boot sequence)
4. A window About Norton Ghost appears
   • click OK
5. The window Norton Ghost 2003 appears
6. Click on Local → Disk → To Image
7. The window Select local source … appears
   • Choose your harddisk (typically there is only one)
8. Insert a CD into the CD-Writer (number the CD's you use, starting with "1")
9. The window File name to copy image to appears
   - Click on the arrow down under Look in and choose your CD-Writer
   - Click Save
10. The window Compress Image appears
    - Choose High
11. The window Copy a bootable floppy to the CD/DVD disc? appears
    - Click Yes
12. You will be asked Is the floppy disk ready in drive a:? 
    - Check whether the boot floppy has been inserted and click on Yes
13. The window Proceed with Drive Backup to CD/DVD?
    - Click Yes
14. Norton Ghost is going to write the first CD. Wait for completion, insert the next
    (numbered) CD when you will get asked for it and click OK, this is to be
    repeated until all data is stored on CD
15. If the backup process is finished, a window Image Creation Completed Suc-
    cessfully appears
    - Click Continue
    - Click Quit
16. You will be asked Are you sure you want to quit?
    - Click Yes
17. Remove the CD and the Floppy, store them in a safe place (not too close to the
    PC!) and reboot the PC (by switching it off and on for example)

**15.8.4 Using the Emergency Recovery CD**

This should be done by experienced people only! All data currently on the disk
will be deleted!

1. Insert the first Image-CD into the CD-drive and reboot the PC
2. Ghost will automatically be started. If the PC doesn't boot from CD, you have
   to change the boot-order in the BIOS of the PC (see previous chapter)
3. Select Local → Disk → From Image
   - choose DVD
   - click Open → OK

4. The window Destination Drive Details appears. If you want to keep the original partition sizes, change the numbers under New Size to the same values as under Old Size.

5. If you want to change the partition sizes in order to use the whole disk (no unpartitioned space left), then you can change the values under New Size according to your needs.

6. To continue, follow the instructions.

15.9 Using the CD-Writer

In previous Linux versions there were the CD burning program 'XCDroast'. This is not part of a Red Hat Enterprise Linux WS 3. In this chapter you can find a description how to burn a CD under Red Hat Enterprise Linux WS 3 in a very easy and convenient way. A major difference to the behaviour of XCDroast is that you do not need the root password to burn a CD.

1. Open a LINUX shell and type in the command:
   
   nautilus

2. A browser window appears that shows the content of your home directory.
   Click on
   
   Go → CD Creator

3. The window changes to the Location
4. Click on
   File → New Window
5. An additional nautilus window appears, starting again in your home directory
6. Go inside the second window to the information you like to burn on CD
7. Transfer the information what do you want to burn on CD from the second window into the first one by drag-and-drop
8. When you have transferred all files you want to burn into the first nautilus window, click on
   Write to CD
9. A window Write files to a CD recorder will appear, click on
   Write files to CD
10. The window *Writing CD* appears

11. If successfully written to CD, the window *Writing CD* changes to

12. Click *Close*

13. The CD has been burned, close all windows

15.10 Add a new harddisk

*NOTE: Using the command fdisk is recommended only for seasoned persons, because formatting the old harddisk will destroy all data on this disk!*

- To buy a new harddisk on the Linux PC is quite easy because you can buy a usual harddisk in a PC store. After installing the new disk you have to do the following:
  1. Start the PC
  2. Open a shell and become root
  3. If the new harddisk is a scsi-disk, type in the command
     
     ```bash
     cat /proc/scsi/scsi
     ```
     
     If it is a ide-disk use the command
     
     ```bash
     cat /proc/ide/hdx/model
     ```
     (the *X* in *hdx* have to be replaced with the correct number of the disk, which is *a, b, c or d*)
4. Does the command show the harddisk which was built in?
   • Yes? Go to step 5
   • No? There was something wrong during build in, or the harddisk is damaged.

5. Type in the command `fdisk -l`
   the output looks like this:
   
<table>
<thead>
<tr>
<th>Device</th>
<th>Boot</th>
<th>Start</th>
<th>End</th>
<th>Blocks</th>
<th>Id</th>
<th>System</th>
</tr>
</thead>
<tbody>
<tr>
<td>/dev/sda1*</td>
<td>1</td>
<td>3</td>
<td>24066</td>
<td>4</td>
<td>FAT16</td>
<td>&lt;32M</td>
</tr>
</tbody>
</table>
   ...

   A second harddisk would show up as device 'sdbx', where x is a number. All Devices sdax are part of harddisk number 1, sdbx of number two and so on.

6. Does the output show the new disk?
   • Yes and the partitioning is OK? Go to step 9
   • Yes but the partitioning was not done so far? Go to step 7
   • No? Go to step 7

7. To partition the new disk, type in the command `fdisk /dev/sdb`
   In case you need help just type m and choose the possibility you want

8. After partitioning is done you have to create the filesystem on the new partitions. This can be done with the command
   `mkfs /dev/sdbx`
   where x is the partition you want to configure

9. Now you can add the new harddisk to the file `/etc/fstab`, open this file with a text editor and add a line like this
   `/dev/sdb1 /X ext2 defaults 1 2`
   where /X is an example for the mount point of the new harddisk. Be sure that the mount point you have chosen exists. If you want to use one that does not exists so far, you have to create this directory with the command
   `mkdir X`
   in case you want to use /X.

10. After reboot of the PC you can mount the new disk with the graphical tool
    `<red hat> → System → Disk Management`
Chapter 16
Appendix

16.1 Some notes for the helium handling

In the TopSpin home directory (default is /opt/topspin) in the directory prog/logfiles are two files named heliumlog and heliumlog.err. The heliumlog saves the current helium level in a new line every night at 3.00 am. The heliumlog.err documents possible errors during detection of the helium level.

16.1.1 Automatic notification for helium refill

TopSpin is able to send an email notification to a list of defined users if the helium level is equal or less than a predefined limit.

16.1.1.1 Set minimum limit of helium level

You can define the value of the helium level which should trigger the automatic notification (see next chapter)

1. Click <red hat> → Editors → Text Editor
2. A window New Document - Text Editor will appear
3. type in the percentage (without '%') of the helium level, that should activate the
notification, e. g. 25

4. Click File → Save as

5. Save the file as heliumlimit in the installation directory of TopSpin (default is /opt/topspin) in the subdirectory conf/instr/<SPECT>

16.1.1.2 Create shell script 'heliumwarn' for email notification

In this chapter you find an example for the shell script that will execute the email notification in case the helium level is less than the entry (in %) in the file heliumlimit

1. Click Red Hat → Editors → Text Editor

2. A window New Document - Text Editor will appear

3. Copy the following example in the file

```bash
#!/bin/sh

# send an email when the helium level is too low

#------------------------
# user defined variables:
#------------------------
ADDRESSES="person1@domain person2@domain person3@domain"
INSTRUMENT="spectrometer identification"
MAIL="/usr/bin/mutt"

# no more changes are needed below this point. You may tailor 
# the variable MSG for specific needs though. Be careful!

#---------------------------------------
# get the name of the spectrometer host:
#---------------------------------------
```
HOST=`hostname -f`
user=`whoami`

#---------------------------
# prepare the email message:
#---------------------------
MSG="
Caution:
The magnet of the spectrometer $INSTRUMENT
has an helium level of $LEVEL %
which is less than the limit of $LIMIT %:
Please order liquid helium and refill this magnet

This email is automatically send from $MYSELF (user $USER)
on $HOST to:
- $ADDRESSES
"

#-----------------
# mail the message:
#-----------------
echo -e $MSG|$MAIL -s "$INSTRUMENT : Helium refill" $ADDRESSES
exit 0

4. Modify the settings of "ADDRESSES" and "INSTRUMENT" and the text in the example as you like
5. Click File → Save as
6. Go in the installation directory of TopSpin (default is /opt/topspin) into the subdirectory prog/bin and save the file as heliumwarn
Now the defined email addresses will get a notification if the actual helium level is the same or below the entry (in %) in the file
<TOPSPIN_HOME>/conf/instr/<spect>/heliumlimit
The notifications are sent only once but the procedure will be activated again if the helium level is again higher than the limit.
Note that this script is only an example, if you would like to add more recipients to the notification list you had to add the respective addresses, if you like to have less addresses you have to delete the respective entries.
16.2 Script for saving important files

TopSPIN offers a script (xwinnmr.save) for saving important files that are not delivered by BRUKER. This script can save and extract user specific data from the TOPSPINHOME directory and puts them into a tar-file. Files that start with an "." are ignored. The script can be started as follows:

- Open a Linux shell and enter

  `<TOPSPIN_HOME>/prog/bin/scripts/xwinnmr.save`

Files and directories will be saved into the special tar-file xwin_backup.tar which is, by default, in the directory TOPSPINHOME/xwin_backup.

The xwinnmr.save script saves the same files and directories as the AU program nmr_save (see chapter 6.16.6). Nevertheless there are differences between xwinnmr.save and nmr_save. This is because of compatibility reasons with previous XWIN-NMR installations and corresponding individual scripts that calling the xwinnmr.save script. The differences between these two ways to create a backup are opposed in the following:

<table>
<thead>
<tr>
<th>Script name</th>
<th>default directory</th>
<th>name of tar-file</th>
</tr>
</thead>
<tbody>
<tr>
<td>xwinnmr.save</td>
<td>xwin_backup</td>
<td>xwin_backup.tar</td>
</tr>
<tr>
<td>nmr_save</td>
<td>nmr_backup</td>
<td>nmr_backup.tar</td>
</tr>
</tbody>
</table>

The options for xwinnmr.save starting from a command prompt are:

```
xwinnmr.save [-options]
```

- **-help**          additional information
- **-path <x>**      absolute path where backup tar-file xwin_backup.tar will be created
- **-restore <x> <y>** absolute path where backup tar-file xwin_backup.tar can be found (<x>) and absolute path where the restoring should take place (<y>) (installation directory of TopSPIN)
- **-replace**       overwrite the old backup.tar file
- **-silent**        do not display any messages
- **-source**        absolute path of TopSpin/XWIN-NMR installation that should be saved
Appendix

- **-spect <x>** spectrometer name (e.g. spect; default is the current name)
- **-verbose** print more information while backing up

For safety reasons the tar-file will not be replaced by executing the `xwin-nmr.save` script once again. So if you like to use the script several times, you have to move the `xwin_backup.tar` file from the directory `TOPSPIN-HOME/xwin_backup` on a backup medium (floppy, CD, DVD ...) and then start the script once again or you have to use the 'replace' option.

### 16.3 Where Do I Find What?

If you cannot find the required information in this manual, please check the manuals listed below.

Further useful information you can also find in the Release Letter for the respective TOPSPIN version.

- **TopSpin Users Guide**
  Window handling, displaying data, interactive data manipulation, user interface related items
- **Acquisition Reference**
  Description of all acquisition commands, parameters and files.
- **Processing Reference**
  Description of all processing commands, parameters and files.
- **AU Reference**
  How to write AU programs. Description of all AU macros, functions and variables. List of Bruker AU programs.

For further manuals please refer to:

- **TOPSPIN → Help**
- **NMR-GUIDE**
Chapter 17

Books and Web addresses on Linux

1. Books on SAMBA
   - Using Samba - Robert Eckstein, David Collier-Brown, Peter Kelly
     (this book is online available as part of the SWAT (samba configuration tool))

2. Web pages on Linux
   - http://www.tldp.org/
   - http://www.hp.com
   - http://www.redhat.com
Chapter 18

Bruker addresses

Germany
Bruker BioSpin GmbH
Silberstreifen
D-76287 Rheinstetten
Tel: (++49) (721) 51 61 0
Fax: (++49) (721) 51 71 01

Bruker BioSpin Software Department
Silberstreifen
D-76287 Rheinstetten
Tel: (++49) (721) 5161 455
Fax: (++49) (721) 5161 943
http://www.bruker-biospin.de
ftp server: ftp.bruker.de
Email: nmr@bruker-biospin.de (sales)
   mbu@bruker.de (service)
   applik@bruker.de (application)
   nmr-software-support@bruker.de (software)
   license@bruker.de (licenses)
USA
Bruker BioSpin Corporation
15 Fortune Drive
Manning Road
Billerica, MA. 01821-3991
Tel: (++1)(978) 667 9580 5195 (center)
       (++1)(978) 667 9580 5444 (application)
Fax: (++1)(978) 667 6168 (center)
       (++1)(978) 667 2955 (application)
http://www.bruker-biospin.com
ftp server: ftp.bruker.com
Email: applab@bruker.com
center@bruker.com
software@bruker.com

Switzerland
Bruker BioSpin AG
Industriestraße 26
CH-8117 Fällanden
Tel: (++41)(1) 8 25 91 11
Fax: (++41)(1) 8 25 96 96
web server: www.bruker.ch
E-Mail: epweb@bruker.ch
        all_ap@bruker.ch

France
Bruker BioSpin S.A.
34, rue de l’industrie
F-67166 Wissembourg/Cedex
Tel: (++33)(3) 88 73 68 00
Fax: (++33)(3) 88 73 68 79
web server: www.bruker.fr
E-Mail: support-rmn@bruker.fr (customer support)

England
Bruker BioSpin LTD.
Bruker addresses

Banner lane
Coventry CV4 9GH
Tel: (++44)(2476) 855200
Fax: (++44)(2476) 465317

web server: www.bruker.co.uk
Email: service@bruker.co.uk
    apps@bruker.co.uk

Our webpage

http://www.bruker-biospin.de/NMR/about/offices/index.html

provides contact addresses of our facilities and offices worldwide
Symbols

.bashrc 191
.cshrc 192
.profile 192, 197
.rhosts 214, 215
/etc/bootparams 162, 169
/etc/exports 161, 163
/etc/hosts 156, 158, 162, 168, 169
/etc/hosts.allow 215
/etc/init.d/bfsd 164
/etc/nsswitch.conf 158
/etc/rc2.d/S95bfsd 164
/etc/shadow 187
/etc/startd 156
/etc/sysconfig/network 159, 163
/etc/sysconfig/network-scripts/ifcfg-eth1 163
/etc/xinetd.conf/bootparamd 164
/sbin/arp 168
/sbin/chkconfig 169, 213
/sbin/reboot 165
/usr/diskless/bfsd 159
/var/log/messages 174

Numerics

2D 39
3D 39
4D 39

A

acquisition
  mode 27, 67, 74
Acquisition Reference Manual 19, 75
Acrobat Reader 17, 98
Adobe 17
Amix 51
Amix-Viewer 35
arp 122, 162, 168

ASP_ST2 162, 164
AURELIA 35, 39
Aurelia 35, 51
auto command 176
automatic
  configuration of a datastation 25, 75

B

BASH 79
bash 190, 191, 193, 194, 198
bfsd 159, 168
bfsd daemon 159, 164
bind nameserver 158
Boot Floppy 177
bootfile 166
boottmode 166, 170
bootparams 98
bootparams file 162, 169
Bruker addresses 241
BSMS 79

C

CCU 23, 35, 39, 42, 43, 125, 155, 165, 167, 168
cd 178
cf 22, 25, 42, 62, 155
cf makelist 76, 77
dchgrp 181
dchkconfig 159, 169
dchmod 179, 198, 199, 214
dchown 180
dclipboard 88
dcommand
  cf 25, 33, 75
    configuration 33
dexpinstall 33
dcompress 184
dconfiguration 59
datastation 25, 75
default 25, 75
<table>
<thead>
<tr>
<th>Term</th>
<th>Page Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>directory</td>
<td>71</td>
</tr>
<tr>
<td>name</td>
<td>27, 66, 73</td>
</tr>
<tr>
<td>confout</td>
<td>79</td>
</tr>
<tr>
<td>conventions</td>
<td>10</td>
</tr>
<tr>
<td>copy and paste</td>
<td>198</td>
</tr>
<tr>
<td>CPU</td>
<td>11</td>
</tr>
<tr>
<td>cron</td>
<td>200</td>
</tr>
<tr>
<td>crontab</td>
<td>200</td>
</tr>
<tr>
<td>csh</td>
<td>192, 194</td>
</tr>
<tr>
<td>cu</td>
<td>166</td>
</tr>
<tr>
<td>CUPS</td>
<td>127</td>
</tr>
<tr>
<td>current</td>
<td>156</td>
</tr>
<tr>
<td>DAEMON line</td>
<td>54, 55</td>
</tr>
<tr>
<td>datastation</td>
<td></td>
</tr>
<tr>
<td>- configuration</td>
<td>75</td>
</tr>
<tr>
<td>dl</td>
<td>164</td>
</tr>
<tr>
<td>default</td>
<td></td>
</tr>
<tr>
<td>- printer</td>
<td>27, 67, 74</td>
</tr>
<tr>
<td>- selection</td>
<td>27, 66, 73</td>
</tr>
<tr>
<td>Demo license</td>
<td>52, 54, 55, 56, 57</td>
</tr>
<tr>
<td>desktop manager</td>
<td>18</td>
</tr>
<tr>
<td>Developer license</td>
<td>52</td>
</tr>
<tr>
<td>DHCP</td>
<td>107, 108</td>
</tr>
<tr>
<td>Diskless</td>
<td>35, 118, 162</td>
</tr>
<tr>
<td>diskless directory</td>
<td>161, 162, 164</td>
</tr>
<tr>
<td>display resolution</td>
<td>11</td>
</tr>
<tr>
<td>dns</td>
<td>158</td>
</tr>
<tr>
<td>domainname</td>
<td>167, 215</td>
</tr>
<tr>
<td>dump file</td>
<td>163</td>
</tr>
<tr>
<td>echo</td>
<td>199</td>
</tr>
<tr>
<td>edhead</td>
<td>27, 69</td>
</tr>
<tr>
<td>edlock</td>
<td>28, 70</td>
</tr>
<tr>
<td>edprosol</td>
<td>28, 71</td>
</tr>
<tr>
<td>edscon</td>
<td>28, 71</td>
</tr>
<tr>
<td>edsolv</td>
<td>27, 69</td>
</tr>
<tr>
<td>emacs</td>
<td>192</td>
</tr>
<tr>
<td>environment variable</td>
<td>192, 193, 197</td>
</tr>
<tr>
<td>Esc</td>
<td>172</td>
</tr>
<tr>
<td>eth0</td>
<td>109, 112, 115, 162</td>
</tr>
<tr>
<td>eth1</td>
<td>163</td>
</tr>
<tr>
<td>ethernet cable</td>
<td>162</td>
</tr>
<tr>
<td>Ethernet card</td>
<td>11, 53, 54, 56</td>
</tr>
<tr>
<td>Ethernet interface</td>
<td>162</td>
</tr>
<tr>
<td>examld_1H</td>
<td>25, 62</td>
</tr>
<tr>
<td>executable</td>
<td>198, 199</td>
</tr>
<tr>
<td>expinstall</td>
<td>22, 27, 42, 64, 71, 75</td>
</tr>
<tr>
<td>expinstall command</td>
<td>25</td>
</tr>
<tr>
<td>export</td>
<td>87, 191, 197</td>
</tr>
<tr>
<td>export variable</td>
<td>194</td>
</tr>
<tr>
<td>exports</td>
<td>161</td>
</tr>
<tr>
<td>exports file</td>
<td>161, 163</td>
</tr>
<tr>
<td>FAQ</td>
<td>170</td>
</tr>
<tr>
<td>FCU</td>
<td>13</td>
</tr>
<tr>
<td>FEATURE line</td>
<td>54, 55, 56, 151, 152</td>
</tr>
<tr>
<td>find command</td>
<td>171</td>
</tr>
<tr>
<td>Firewall</td>
<td>96, 210</td>
</tr>
<tr>
<td>firmware</td>
<td>27, 64, 77</td>
</tr>
<tr>
<td>FLEXLM</td>
<td>35</td>
</tr>
<tr>
<td>Flexlm license manager</td>
<td>53, 55, 56, 57</td>
</tr>
<tr>
<td>Floating license</td>
<td>53, 54, 55</td>
</tr>
<tr>
<td>fsstab file</td>
<td>163</td>
</tr>
<tr>
<td>ftp</td>
<td>185, 212</td>
</tr>
<tr>
<td>ftp server</td>
<td>45</td>
</tr>
<tr>
<td>Full license</td>
<td>52, 56, 57</td>
</tr>
<tr>
<td>full name</td>
<td>190</td>
</tr>
<tr>
<td>Ghost</td>
<td>226</td>
</tr>
<tr>
<td>Gimp</td>
<td>215</td>
</tr>
<tr>
<td>glibc-devel</td>
<td>100</td>
</tr>
<tr>
<td>glibc-kernheaders</td>
<td>100</td>
</tr>
<tr>
<td>GLP</td>
<td>35, 39, 51</td>
</tr>
<tr>
<td>GNU TOOLS</td>
<td>35</td>
</tr>
<tr>
<td>Good Laboratory Practice</td>
<td>35, 39</td>
</tr>
<tr>
<td>graphics card</td>
<td>11</td>
</tr>
<tr>
<td>graphics file</td>
<td></td>
</tr>
<tr>
<td>- export</td>
<td>87</td>
</tr>
<tr>
<td>- import</td>
<td>88</td>
</tr>
<tr>
<td>- prg</td>
<td>87</td>
</tr>
<tr>
<td>- tif</td>
<td>87</td>
</tr>
<tr>
<td>- wmf</td>
<td>87</td>
</tr>
<tr>
<td>grep</td>
<td>182, 200</td>
</tr>
<tr>
<td>group</td>
<td>179, 189, 190, 191, 193, 202</td>
</tr>
<tr>
<td>group id</td>
<td>202</td>
</tr>
</tbody>
</table>
nmrsu 22, 33
Node address 56
Node Locked license 54
Norton Ghost 226
Notification Tool 224
nsswitch.conf file 158, 168

O
only-processing-PC 61
openmotif 100
order number 55
owner 179, 180, 193, 202

P
paper format 27, 67, 74
PARAVISION 51
passwd 188
password 188, 189, 190, 191
patchlevel 45
ddf 9
performance 11
PERL 35
permissions 192, 193, 201, 202, 203
physical address 54, 56
ping 122
Powerpoint 88
pp 199
pre-scan-delay 27, 67, 74
Presenter license 52
Processing-Only license 52
ps 183, 200
pulse program 199
pwd 198

R
rcp 185, 214, 215
RCU 13, 14
rcu 176
rcutest 176
RED HAT 17, 171
Red Hat Documentation 95
Red Hat Enterprise Linux WS 3.0 12, 95
Red Hat Network 217
redhat-config-nfs 100

Register 219
Release Letter 9, 21, 37
remote files 122
reset button 166, 167, 170
reviveccu 158, 159, 161, 162, 172, 173
rlogin 214, 215
rm 199
route 122
rs232 165
rsh 214
rsh-server 212

S
Samba 122, 212
samba-swat 212
scratch installation 10
screenshot 215
select
default printer 67, 74
spectrometer configuration name 27, 66, 73
the default printer 27
server line 55
service command 159, 169
setenv 166, 170, 194
sh 194, 199
shadow 187
shell script 198, 199
shmm 173
showconf 79
Software requirements 17
spect 156, 162
spectrometer 118
spectrometer-PC 25, 61
startd process 156
su - 164
swapfile 162, 164, 169
SWAT 122
swat 122
systest 176

T
tar 186, 187
TCP/IP 107, 111
tcsh 192, 194, 198
tCU 15
Teaching license 52
telnet spect 155, 156, 157, 176
telnet-server 212
tif 87
TOPSPIN
  CDROM 9, 53, 56
  commands 35
  configuration 24, 31
  Express Installation 19
  installation 23, 31, 36, 42, 43
  installation directory 25, 75
  license 31, 55
  Online Help 9
  owner of the program files 33
  programs 35
  Release letter 9
  start 24
topspin -client 152
TOPSPIN Plot Editor 35, 51, 55, 88, 127
touser 173
traceroute 122
transceiver 162
U
  umask 192
  UNIX host 125
  up2date 219
  User Manager 89, 91
  uscp 100, 101, 165
  uxproc 154
V
  Very Important Files 80
  VIF 80
W
  Web Browser 17
  who 171, 172, 173
  Windows 2000 123, 125
  wmf 87
  wobb 155
  Word 88
  WWW account 171
X
  XCDrost 229
  xconfigurator 197
  xinetd.d 164
Z
  zg 155